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1 Introduction

11 About this Document

Purpose

This Common Upgrade Guide provides you with information on the upgrade process of the following
applications, all of which are delivered with SAP Customer Activity Repository retail applications bundle 1.0
SPS7:

Applications SAP Help Portal with Product Documentation

e SAP Customer Activity Repository 2.0 SP6 https://help.sap.com/viewer/p/CARAB
e SAP Assortment Planning for Retail 1.0 SP6

® SAP Merchandise Planning for Retail 1.0 SP6

e SAP Promotion Management for Retail 8.1 SP6

For more information on these applications and their business scenarios, see the Common Master Guide, which

you can find under https:/help.sap.com/viewer/p/CARAB [» <Version> » Installation and Upgrade .

Technically, the application versions described in this guide are shipped in the following installable product
versions:

e Back-end product version: CAR RETAIL APPL BUNDLE 1.0 SPS7
e Front-end product version: SAP FIORI FOR SAP CARAB 2.0 SPS1 (same as for the previous release)
For more information on these product versions, see the corresponding release information notes (RINs):

e For the back-end product version: SAP Note 2088924 ¢t
e For the front-end product version: SAP Note 2319703 ¢t

New Installation Scenarios

A\ Caution

If you do not have an existing installation of these applications, you must perform a software installation
rather than a software upgrade. For more information, see the Common Installation Guide, which you can

find under http://help.sap.com/viewer/p/CARAB# |l <Version> j Installation and Upgrade 3.
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2 Before You Start

The following sections provide information about:

e Naming Conventions

e |nformation Available on SAP Service Marketplace
® |ntegration with SAP Fashion Management

e SAP Notes for the Upgrade

2.1 Naming Conventions

Throughout this document the following naming conventions apply.

Definitions

The following terms are used consistently in the processes and procedures described in this guide:

Term Definition

Common Master Guide Common Master Guide for SAP Customer Activity Repository 2.0 SP5, SAP Assortment
Planning for Retail 1.0 SP5, SAP Promotion Management for Retail 8.1 SP5, and SAP Mer-
chandise Planning for Retail 1.0 SP5.

You can find this guide on SAP Service Marketplace at http://service.sap.com/instguides
P‘hrl} Installation & Upgrade Guides > Industry Solutions > Industry Solution Guides > SAP
for Retail > SAP Customer Activity Repository > SAP Customer Activity Repository 2.0 SP4
> Master Guide }

consuming application An SAP product designed to consume and utilize data obtained from SAP Customer Activ-
ity Repository.

» Example
e SAP Assortment Planning for Retail

e SAP Merchandise Planning for Retail

e SAP Promotion Management for Retail
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Term

Definition

back-end system

The SAP NetWeaver-based back-end server on which SAP Customer Activity Repository
and its consuming applications are installed.

For a visual representation of the back-end system, see Figure 1 in the Overall System Plan-
ning section.

front-end server

The SAP NetWeaver-based front-end server on which the SAP Gateway, SAP Fiori launch-
pad, SAP Fiori central SAP Fiori Ul component, and the product-specific SAP Fiori compo-
nents are installed.

For a visual representation of the front-end system, see Figure 1 in the Overall System Plan-
ning section.

SAP ERP

Unless otherwise specified, references in this guide to SAP ERP are comprehensive; that is,
they apply to SAP ERP and the following two add-ons:

e SAP Retail: an add-on to SAP ERP
For more information, see SAP Help Portal for SAP Retail at https://help.sap.com/

viewer/p/SAP_ERP |} <your release> > Application Help > SAP Library > Industries

in SAP ERP ¥ SAP Retail 4.

e SAP Fashion Management: an add-on to SAP Retail
For more information, see SAP Help Portal for SAP Fashion Management at https://

help.sap.com/viewer/p/SAP_FASHION_MANAGEMENT |F <your release> ¥
Application Help ¥ SAP Library ¥ Industries in SAP ERP » SAP Retail ¥ Fashion
Management p |
For more information on how both add-ons relate to SAP ERP, see SAP Help Portal for SAP
ERP at https://help.sap.com/viewer/p/SAP_ER P|) <your release> > Application Help >
SAP Library > Industries in SAP ERP > SAP Retail } and subsection Fashion Management.

Naming Differences

Due to naming differences between the underlying technical objects of the components, the names of the
following business objects are used interchangeably in this document:

SAP Customer Activ-
ity Repository (all
modules except for

Unified Demand Fore- SAP Assortment SAP Promotion Man- SAP ERP
cast (UDF) and De- Planning for Retail /  agement for Retail
mand Data Founda- SAP Merchandise

UDF and DDF) tion (DDF) Planning for Retail

article product product product article
material

article variant product variant product variant product variant article variant
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SAP Customer Activ-
ity Repository (all
modules except for

Unified Demand Fore-
cast (UDF) and De-
mand Data Founda-

SAP Assortment
Planning for Retail /
SAP Merchandise

SAP Promotion Man- SAP ERP
agement for Retail

UDF and DDF) tion (DDF) Planning for Retail
store location location location store
site

Variables

Variables Description

<SAPSID> SAP system ID in uppercase letters

<sapsid> SAP system ID in lowercase letters

<DBSID> Database ID in uppercase letters

<dbsid> Database ID in lowercase letters

<INSTDIR> Installation directory for the SAP system

<DVD_ DIR> Directory on which a DVD is mounted

<0s> Operating system name within a path

2.2 Information Available on SAP Help Portal

Information on Prerequisite Platforms, Applications, and Other Components

Description

Path

Title

Information on installing SAP HANA

http://help.sap.com/viewer/p/

SAP HANA Server Installation and Up-

SAP_HANA_PLATFORM#r|p <your ~ date Guide

version> > Installation and Upgrade >
SAP HANA Server Installation and

Update Guide }
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Description

Path

Title

Information on installing SAP HANA da-
tabase clients

http://help.sap.com/viewer/p/
SAP_HANA_PLATFORM# |l <your

version> > Installation and Upgrade >
SAP HANA Client Installation and

Update Guide 3

SAP HANA Client Installation and Up-
date Guide

Information on installing SAP HANA
studio

http://help.sap.com/viewer/p/
SAP_HANA_PLATFORM |l <your

version> # Installation and Upgrade >
SAP HANA Studio Installation and

Update Guide 4

SAP HANA Studio Installation and Up-
date Guide

Information on installing the SAP LT
(Landscape Transformation) Replica-
tion Server for SAP HANA

http://help.sap.com/viewer/p/
SAP_HANA_REAL_TIME_REPLICATION

P‘hrl} <your version> > Installation and

Upgrade }

Installation Guide - Trigger-Based Data
Replication Using SAP Landscape Trans-
formation Replication Serve

Information on managing major opera-
tional aspects of the SAP LT Replica-
tion Server

http://help.sap.com/viewer/p/
SAP_HANA_REAL_TIME_REPLICATION

#r | <your version> ¥ Operations 3

Application Operations Guide - SAP
Landscape Transformation Replication
Server

Information on using SAP HANA

http://help.sap.com/viewer/p/
SAP_HANA_PLATFORM# |l <your
version> > Administration > SAP
HANA Administration Guide }

SAP HANA Administration Guide

Information for developers on how to
use the SAP HANA development tools
to create comprehensive analytical
models and to build applications with
SAP HANA's interfaces and integrated
development

http://help.sap.com/viewer/p/
SAP_HANA_PLATFORM (P <your

version> > Development > SAP HANA
Developer Guide (For SAP HANA

Studio) 4

SAP HANA Developer Guide

Information for modelers (or business
analysts) on how to define data models
that will be used in SAP HANA

http://help.sap.com/viewer/p/
SAP_HANA_PLATFORM# |l <your

version> > Development > SAP HANA
Modeling Guide (For SAP HANA

Studio) 4

SAP HANA Modeling Guide

Information on installing SAP NetWea-
ver

https://help.sap.com/viewer/p/
SAP_NETWEAVER_740|JF Installation
and Upgrade > Installation Guide ]

Installation Guide, SAP Systems Based
on the Application Server <Your Server>
of SAP NetWeaver on <Your Operating
System>: SAP HANA Database
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Description Path

Title

Information on installing SAP ERP 6.0

SAP_ERPl) <Version> > Installation
and Upgrade > Installation Guide }

http://help.sap.com/viewer/p/

Installation Guide, SAP ERP 6.0 Includ-
ing <your SAP Enhancement Package> -
Technical Usage "Central Applications”
<Your Server>on <Your Operating Sys-

tem>

Information on installing SAP Enhance-
ment Package 2 for SAP CRM 7.0 or
SAP Enhancement Package 2 for SAP
CRM 70, Version for SAP HANA or
higher

Installation Guide ¥ Install ¥
Installation Guides for SAP EHP 2 for

http://help.sap.com/viewer/p/
SAP_CUSTOMER_RELATION-

SHIP_MANAGEMENT#& |l Version 7.0
EHP2  Installation and Upgrade >

Installation Guide, SAP Customer Rela-
tionship Management 7.0 Including En-
hancement Package 2 Java and ABAP

Administrator's Guide, SAP Enhance-
ment Package 2 for SAP CRM 7.0, Ver-
sion for SAP HANA

SAP CRM 7.0 > Installation Guide - SAP
enhancement package 2 for CRM 7.0 -

ABAP and Java 4

https://help.sap.com/viewer/p/
SAP_CUSTOMER_RELATION-
SHIP_MANAGEMENT_FOR_HANA

|} Installation and Upgrade >

Administrator's Guide > Administrator's
Guide SAP CRM 7.0 EHP2, Version for

SAPHANA 4
General Quick Links
Description Path
SAP Help Portal http://help.sap.com e
SAP Notes http://support.sap.com/notes#r

SAP Software Download Center

http://support.sap.com/swdcP

Product Availability Matrix

http://support.sap.com/pam

Released platforms and operating systems

http://service.sap.com/pIatformsl‘hr

SAP Solution Manager

http://support.sap.com/solutionmanager

Security

http://service.sap.com/security #r

Security guides

http://service.sap.com/securityguides s

Support package stacks, latest versions, patch
level requirements

http://support.sap.com/patches
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Description Path

System sizing http://service.sap.com/sizing

2.3 Integration with SAP Fashion Management

Use

This document describes installation scenarios deployed in parallel with one of the following:
e SAP Retail, an add-on to SAP ERP
For more information, see SAP Help Portal for SAP Retail at https://help.sap.com/viewer/p/SAP_ERP.

e SAP Fashion Management, an add-on to SAP Retail
For more information, see SAP Help Portal for SAP Fashion Management at https://help.sap.com/

viewer/p/SAP_ERP |» <your release> » Application Help » SAP Library ¥ Industries in SAP ERP » SAP
Retail Fashion Management 3.

Unless otherwise specified, references in this guide to SAP ERP are comprehensive; that is, they apply to SAP
ERP, SAP Retail, and SAP Fashion Management.

More Information

For more information on how both add-ons relate to SAP ERP, see SAP Help Portal for SAP ERP at https://
help.sap.com/viewer/p/SAP_ERP| <your release> » Application Help » SAP Library ¥ Industries in SAP ERP »
SAP Retail Fashion Management 3.

2.4 SAP Notes for the Upgrade

This section lists SAP Notes that you must read (and, when appropriate, implement) before you start the
upgrade.

Make sure that you have the up-to-date version of each SAP Note, which you can find on SAP Support Portal at
http://support.sap.com/notes .
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SAP Notes for SAP Customer Activity Repository

SAP Note Number

Title

Description

2084900 Release and Information Note (RIN)  This note serves as an entry point for SAP Cus-
- SAP Customer Activity Repository  tomer Activity Repository 2.0.
2.0
2666170 M On-Shelf Availability (OSA) crashes  Correction for the On-Shelf Availability module
SAP HANA script server that must be implemented for specific SAP HANA
revisions.
2298340 ¥ SAP HANA DB: CDS views with ex- Relevant for installations on SAP NetWeaver 7.40
ternal views as base objects cannot  SPS 12, SPS 13, or SPS 14:
be created in the DB ) i
Important corrections that you must apply prior
to upgrading the CAR RETAIL APPL BUNDLE
1.0 back-end product version.
1605140 " SAP HANA 1.0: Central Note - SAP Collective note for all the relevant SAP Notes for
LT Replication Server LT Replication Server for SAP HANA.
1778607 P SAP HANA Live for SAP Business What to consider when implementing SAP HANA
Suite Live for SAP Business Suite.
1791342 P Time Zone Support in SAP HANA How to handle time zone functions UTCTOLOCAL
and LOCALTOUTC.
1952701 " DBSL supports new SAP HANA SP9  What to consider when establishing a connection
version number with the SAP LT Replication Server.
2244521 M Product Hierarchy Import - nodes Corrections to importing product hierarchy data.
are not getting process
2145356 % Activation of SAP HANA content for  Information on how you must manually activate

DDF and UDF when applying SAP
Notes

the SAP HANA content for DDF and UDF again af-
ter implementing a support package or correction
on an existing installation. For example, this is the
case when you apply an SAP Note for DDF or UDF
using transaction SNOTE.

SAP Notes for SAP Assortment Planning for Retail

SAP Note Number Title Description
SAP Notes for SAP ERP
2196351 M Pre-requisite for SAP Note #2196323 Corrections to SAP ERP data elements.
2196323 DRFOUT: Only valid current node as-  Article Hierarchy Transfer replication will transfer
signments and article assignments  all node and article assignments irrespective of
are transferred during Article Hierar-  the validity.
chy Replication
Common Upgrade Guide for SAP Customer Activity Repository retail applications bundle 1.0
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SAP Note Number Title Description

2209621 M Assortment Listing API: List by DC fix Functionality on the SAP ERP side to enable PIR
integration with SAP Assortment Planning for Re-
tail.

2286994 ¥ New Listing API for Retail Assort- Supports:

ment Planning

e Different listing periods for different prod-
ucts within an assortment.

e (Changes in the listing after a product has
been listed.

® |n-season listing changes.

e Multiple validity time periods for the same lo-

cation.

SAP Notes for Back-End System

2022080 Upgrade of PAL AFL and BFL AFL
from SAP HANA earlier release to
SPS08

Corrections to add privileges removed during up-
grade to SAP HANA Platform SPS 08.

If your back-end system is on a version of SAP NetWeaver that is lower than 7.40 SP15, then you must also implement the

following SAP Notes:

2298340k SAP HANA DB: CDS views with ex-
ternal views as base objects cannot
be created in the DB

Corrections to activating CDS views on an SAP
HANA database.

SAP Notes for Front-End Server

2077357 P RIN SAP Fiori for SAP Assortment
Planning for Retail 1.0

Common note containing correction instructions
that must be implemented following the installa-
tion of the SAP Fiori Ul Components on the front-
end server.

2296550 #r LPD_CUST system Alias is not recog- Corrections to central SAP Fiori component.

nized

SAP Notes for Planning Functionality Used by SAP Assortment Planning for Retail

1637199 ¥ Using the planning applications KIT  Important information for running the Planning
Application Kit (PAK).
2319395 MultiProvider, PAK, and use of char-  Corrections to PAK.

acteristics as key figures

1662968 Clarification on setting ResultSetSi-
zeLimit in Analysis Office

Information on changing the default
ResultSetSizelimit registry setting.
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SAP Note Number

Title

Description

2074801

Dumps and Issues with special In-
foObjects like OFISCYEAR, OCALM-
ONTH...

Corrections to in-memory planning.

If your back-end system is on a version of SAP NetWeaver that is lower than 740 SP15, then you may also need to imple-

ment the following SAP Notes. Verify the Solution section of each SAP Note to determine whether the note is applicable.

2211165 Short dump GETWA_NOT_AS- Corrections to SAP BW.
SIGNED in RRMS_MESSAGES_OUT-
PUT

2215242 P BW-IP: In-memory planning: Attempt Corrections to PAK.
to save physically deleted records in
attribute planning does not work

2212552 P Incorrect values in input help for vari- Corrections to planning.
able

2193251 /% BIT_OFFSET_NOT_POSITIVE in EN-  Corrections to SAP BW.
HANCE_FF_SFC

2207983 M Incorrect data when using current Corrections to SAP BW.
member variable

2215568 System error in program Corrections to SAP BW.
CL_RSR_RRKO_CURRENT_MEMBER
and form _CRE-
ATE_FEMSN_CHECK-4-

2178795 P query with FIX-operator: correction ~ Corrections to SAP BW.
for note 2172874 / Support Package
12 for SAP BW 740

2181672 Failed to find source column *_SID in  Corrections to SAP BW.
itab

2182912 M Incorrect value during materializa- Corrections to SAP BW.
tion (SID-CONVERT)

2185225 Processing of key figures and NULL ~ Corrections for CompositeProviders.
values from SAP HANA models

2185838 M ADSO: Layer-execution of query Corrections to SAP BW.

2213427 P CL_RSDRV_TREX_HCPR_QUERY Corrections to SAP BW.

does not return NameMapper in
layer context in GET_TREX_PARTS
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SAP Note Number Title

Description

2231729 Activation error for CompositePro- Corrections for CompositeProviders.
vider with SAP HANA model as Part-
Provider

2256850 M Missing values for current member  Corrections to SAP BW.

variable in intervals and "unposted"

2277561 M Individual execution for InfoCube
with navigation attributes from an In-
foObject based on SAP HANA model
not possible

Corrections for CompositeProviders.

2277650 BW-IP: RSPLS 142 for aggregation
level on CompositeProviders with
navigation attributes from InfoObject

Corrections for CompositeProviders.

based on SAP HANA model
2294872 Fiy Incorrect/missing data for CURRENT Corrections to SAP BW.
MEMBER
2281027 M CompositeProvider collects transient Corrections for CompositeProviders.

InfoObjects in namespace 1KYF_*
during transport

2263294 M BW-IP PAK in SQL script with IKYF_  Corrections to PAK.
key figures
2296460 f BW-IP PAK in SQL script with IKYF_  Corrections to PAK.
key figures
2209808 Attribute planning throws error in Corrections to planning.

case planning on not existing mem-
ber is allowed

2295762 Fr Reset (Back to saved state) does not
work for exception-aggregated data

For SAP NetWeaver 740 SP13 and SP14 only, is-
sue not present in SP12 and fixed in SP15.

SAP Notes for SAP Promotion Management for Retail

SAP Note Number Title

Description

2026580 Release strategy for the ABAP add-
on RTLPROMO

This SAP Note contains information about plan-
ning the installation and upgrades of the ABAP
add-on RTLPROMO.
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SAP Note Number

Title Description

2298340 SAP HANA DB: CDS views with ex- Relevant for installations on SAP NetWeaver 7.40
ternal views as base objects cannot ~ SPS 12, SPS 13, or SPS 14:
be created in the DB
I Important corrections that you must apply prior
to upgrading the CAR RETAIL APPL BUNDLE
1.0 back-end product version.
2163602 DRFOUT: Incorrect timestamp send  This SAP Note contains information on correct-

for Moving Average Price

ing the timestamp field when using DRFOUT to

replicate the Moving Average Price.

SAP Notes for SAP Merchandise Planning for Retail

SAP Note Number

Title

Description

2332831 Top down function correction for Single  Program error /RaP/

Store Workbook. CL_PF_CHNPLN_SNGL_TOPDWN.

2349940 P MPR Multi Store Query: Locking Issue in  When multiple planners work simultaneously

Copy Store Function. with the workbook 03 - Channel Plan -
Multi Store, unwanted locking behavior
can occur when executing the function Copy
Store.

2349948 MPR Multi Store Query: Wrong Calcula-  Some key figures face incorrect calculations
tions in Multi Store Workbook. in the Multi Store workbook.

2347606 M Store area aggregated incorrectly - man- When planning store area, it is not correctly
ual instructions for MPR query for FPO3  aggregated from weeks to months during save
release. in specific situations.

2347622 P <Sales at Retail Contribution> Thekeyfigure$ Contribution Sales at
in Multi Store - manual instructions for ~ Retail LY is calculated incorrectly for the
MPR query for FPO3 release. Channel Plan — Multi Store workbook.

2347623 Bottom Up Single Store worksheet ze-  Single store key figures for bottom up in any
ros out key figures - manual instructions  of the merchandise plan workbooks issues. All
for MPR query for FPO3 release. additional merchandise plan key figures not

maintained in the single store plan get zeroed
out.

2347624 P Bottom Up Single Store Function But- When changing to the WSSI sheet in the mer-

ton disappears in workbook. Manual in-
structions for MPR query for FPO3 re-
lease.

chandise plan workbooks, the button for
Bottom Up - Channel Plan -
Single Store function sometimes disap-

pears.
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SAP Note Number

Title

Description

2347625 M Aggregation of <calculated OTB>, Key figures <OTB>: &RAP VERSN TXT 01g,
<markdown budget>and< <Promo Budget>!&RAP VERSN TXT 01¢&,
promotion budget> areincorrect. and <Markdown Budget>:

Manual instructions for MPR query for &RAP_VERSN_ TXT 01 are calculated incor-
FPO3 release. rectly on aggregated level for the OTB Recon-
ciliation Report workbook.

2353793 Wrong variable type in single store work- The plan queries in Workbook 04 — Channel

book.

Plan — Single Store uses multi entry variables
for the info objects <sales Organization>
and <Distribution Channel>, whichis not
relevant in this workbook as you can only se-
lect one store at a time.

If your back-end system is on a version of SAP NetWeaver that is lower than 740 SP15, then you must also implement the

following SAP Notes:

2298340

SAP HANA DB: CDS views with external

Corrections to activating CDS views on an

views as base objects cannot be created SAP HANA database.

inthe DB
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3 Prerequisites

This section lists all the prerequisite platforms, applications, and components that must be installed and
configured during an upgrade from a previous release.

i Note

If you are performing a new installation of this release, you must not follow this Common Upgrade Guide
and rather proceed with the Common Installation Guide under https://help.sap.com/viewer/p/CARAB

|+ Version: 1.0 SPSx ¥ Installation and Upgrade 3.

For your convenience, the prerequisites are presented to you in two categories:

e Common Prerequisites, which must be installed regardless of the business scenario you are planning to
implement

e Application-Specific Prerequisites, which are only relevant for specific applications under specific
conditions

i Note

The prerequisites should be installed and configured by an experienced SAP Basis administrator.
Documentation and support for each prerequisite is available on the SAP Help Portal at https:/
help.sap.com.

Common Prerequisites

1. SAP HANA Platform
The minimum requirement for this release is SAP HANA Platform SPS 11 Revision 112.02 or higher,
regardless of the business scenario you are planning to implement.
For installation information, see https://help.sap.com/viewer/p/SAP_HANA_PLATFORM |» <Version>

Installation and Upgrade » SAP HANA Server Installation and Update Guide J, in particular section
Installing and Updating SAP HANA Components.

2. SAP Solution Manager
The minimum requirement for this release is the latest version of SAP Solution Manager, regardless of
the business scenario you are planning to implement. Failure to do so may cause problems when using the
Maintenance Optimizer (MOPZ) application.
For installation information, see https://help.sap.com/viewer/p/SAP_Solution_Manager | <Version> »
Installation and Upgrade » Master Guide 3 and Upgrade Guide.

3. SAP NetWeaver
The minimum requirement for this release is SAP NetWeaver 7.40 SPS 12, regardless of the business
scenario you are planning to implement.
With SAP NetWeaver 7.40 SPS 12, SPS 13, or SPS 14, you must additionally implement SAP Note
2298340#% to apply important corrections. You must implement this note prior to upgrading the cAR
RETAIL APPL BUNDLE 1.0 back-end product version.
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The highly recommended version for this release is SAP NetWeaver 7.40 SPS 15, regardless of the
business scenario you are planning to implement. In this case, you do not need to implement the SAP
Note.

For installation information, see https://help.sap.com/viewer/p/SAP_NETWEAVER_740 |» Installation and
Upgrade ¥ Installation Guide 3 and Implement SAP Note 2298340 [page 24].

SAP Landscape Transformation Replication Server

The minimum requirement for this release is SAP Landscape Transformation Replication Server for SAP
HANA 2.0, regardless of the business scenario you are planning to implement.

For installation information, see https://help.sap.com/viewer/p/
SAP_LANDSCAPE_TRANSFORMATION_REPLICATION_SERVER | <Version> ¥ Installation and Upgrade ¥

Installation Guide (Replicating Data to SAP HANA) 3. Additionally, see SAP Note 1605140 (SAP HANA
1.0 and 2.0: Central Note - SAP LT Replication Server). This is the central note for enabling trigger-based
data replication (information on download, installation, upgrade, corrections, implementation).

SAP Fiori

The minimum requirement for this release is SAP FIORI FRONT-END SERVER 2.0 SPS3, regardless of the
business scenario you are planning to implement.

For installation information, see SAP Notes 2219596#%, 2327935#% , and 2169917 %, as well as the app
implementation information under https://help.sap.com/viewer/p/FIORI_IMPLEMENTATION | <Version>
» Implementation 3.

UDF AFL

The minimum requirement for this release is UDF AFL Revision 112.20 or higher, regardless of the
business scenario you are planning to implement.

For installation information, see the Upgrade SAP Customer Activity Repository Retail Applications Bundle
[page 24] section of this guide, as well as SAP Note 2088924 #r .

i Note

While installation of the UDF AFL is mandatory, implementation depends on the consuming
application:
o Optional implementation for:
o SAP Assortment Planning for Retall
o SAP Merchandise Planning for Retail
o Mandatory implementation for:
o  SAP Promotion Management for Retail (only for what-if forecasts)

POS AFL

The minimum requirement for this release is POS AFL Revision 112.20 or higher, regardless of the
business scenario you are planning to implement.

For installation information, see the Upgrade SAP Customer Activity Repository Retail Applications Bundle
[page 24] section of this guide, as well as SAP Note 2088924 # .

i Note

While installation of the POS AFL is mandatory, implementation is optional for the following consuming
applications:

o SAP Assortment Planning for Retalil

o SAP Merchandise Planning for Retail

o SAP Promotion Management for Retalil
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Application-Specific Prerequisites

SAP Customer Activity Repository

Prerequisites for SAP Customer Activity Repository

Product

Prerequisite Version Mandatory/Optional

Installation Information

SAP ERP

The minimum requirement Mandatory
for this release is one of the
following:

e SAPERP 6.0 Enhance-
ment Package 4 is man-
datory at a bare mini-
mum if installing but not
implementing DDF and
UDF.

e SAPERP 6.0 Enhance-
ment Package 5 is man-
datory when implement-
ing SAP Customer Activ-
ity Repository with its
DDF and UDF modules.

e SAPERP 6.0 Enhance-
ment Package 7 or
higher is mandatory if
implementing the SAP
Customer Activity Repo-
sitory Co-Deployed with
SAP ERP or SAP Fashion
Management system
landscape.

The following prerequisites
apply if you want to imple-
ment the Omnichannel Arti-
cle Availability functionality
within SAP Customer Activity
Repository:

e Minimum: SAP ERP 6.0
Enhancement Package 7
SPS 11 or SAPERP 6.0
Enhancement Package 8
SPS1

e Recommended: SAP
ERP 6.0 Enhancement
Package 7 SPS 12 or
SAP ERP 6.0 Enhance-
ment Package 8 SPS 2

https://help.sap.com/
viewer/p/SAP_ERP

|} <Version> > Installation
and Upgrade > Installation
Guide 3
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Product Prerequisite Version Mandatory/Optional Installation Information
SAP HANA Live for SAP ERP  SAP HANA Live for SAP ERP  Mandatory http://help.sap.com/hba#
10 SPS 02 or higher |+ Version: 2.0 ¥ Installation
and Upgrade >
Administrator's Guide 4
SAP CRM The minimum requirement Optional, depending on https://help.sap.com/

for this release is one of the
following:

e SAP Enhancement
Package 2 for SAP CRM
7.0

e SAP Enhancement
Package 2 for SAP CRM
7.0, Version for SAP
HANA or higher

whether or not you choose to
implement customer deter-
mination with SAP CRM.

viewer/p/
SAP_CUSTOMER_RELA-
TIONSHIP_MANAGEMENT

|} <Version> > Installation
and Upgrade > Installation
Guide }

SAP Smart Business

SAP Smart Business founda-
tion component 1.0 SPS 03

Optional, depending on
whether or not you choose to
implement the SAP Smart
Business for Multichannel
Sales Analytics dashboard
within SAP Customer Activity
Repository.

SAP Note 2018360 7%

SAP Hybris Marketing SAP Hybris Marketing 1.10 or  Optional, depending on https://help.sap.com/
higher whether or not you choose to viewer/product/
implement customer deter-  SAP_HYBRIS_MARKETING/
mination with SAP Hybris 1702%20YMKT/en-US
Marketing. |} <Version> > Installation
and Upgrade > Installation
and Configuration Guide 3
SAP Hybris Commerce SAP Hybris Commerce 6.0 or Optional, depending on http://help.hybris.com

higher (in particular, the Ac-
celerator and the Data Hub)

whether or not you choose to
implement the Omnichannel
Article Availability functional-
ity within SAP Customer Ac-
tivity Repository.

|} <Version> > <Main
Menu> > Installing and
Upgrading Hybris 4

SAP Hybris Commerce, inte-
gration package for SAP for
Retail

SAP Hybris Commerce, inte-
gration package for SAP for
Retail 2.0 or higher

Optional, depending on
whether or not you choose to
implement the Omnichannel
Article Availability functional-
ity within SAP Customer Ac-
tivity Repository.

See the Administrator Guide
delivered with the software
package.
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Product Prerequisite Version Mandatory/Optional

Installation Information

SAPI1Q SAP 1Q 16.0, SP8 or higher Optional, depending on
whether or not you choose to
use the Table Content Aging
report within SAP Customer

https://help.sap.com/
viewer/p/SAP_IQ

|» <Version> ¥ Installation

and Upgrade > <various SAP

Activity Repository.
yrep Y 1Q Installation and
Configuration Guides> }
SAP Jam SAP Jam, initial release or Optional, depending on https://help.sap.com/
higher whether or not you choose to  viewer/p/

integrate social media collab-
oration functionality with

SAP_JAM_COLLABORATION
I» <version>

SAP Jam.
Administration >
Administrator Guide ]
SAP Assortment Planning for Retail
Prerequisites for SAP Assortment Planning for Retail
Product Prerequisite Version Mandatory/Optional Installation Information
SAP ERP The minimum requirement Mandatory http://help.sap.com/erp#

for this release is one of the
following:

e SAPERP 6.0 Enhance-
ment Package 5 is man-
datory.

e SAPERP 6.0 Enhance-
ment Package 7 or
higher is mandatory if
implementing the SAP
Assortment Planning for
Retail Co-Deployed with
SAP ERP system land-
scape.

|} <your release> >
Installation and Upgrade

Information > Installation

Guide }

SAP HANA Live for SAP ERP  SAP HANA Live for SAP ERP  Mandatory
1.0 SPS 02 or higher

http://help.sap.com/hbaf

| Instaliation, Security,
Configuration, and

Operations Information ¥

Administrator's Guide ]
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Product Prerequisite Version Mandatory/Optional Installation Information
SAP Jam SAP Jam, initial release or Optional, depending on http://help.sap.com/sapjam
higher whether or not you choose to #|p SAP Jam Collaboration
integrate social media collab- System Administration
oration functionality with
Information > Administrator
SAP Jam.
Guide 1
SAP BusinessObjects Analy-  SAP BusinessObjects Analy- Mandatory http://help.sap.com/boao
sis sis, edition for Microsoft Of- "h"lb <your release> >
fice 2.2 SP2 Installation, Configuration,
Security, and Administration
Information >
Administrator's Guide }
SAP Merchandise Planning for Retail
Prerequisites for SAP Merchandise Planning for Retail
Product Prerequisite Version Mandatory/Optional Installation Information
SAP ERP The minimum requirement Mandatory http://help.sap.com/erp P
for this release is one of the [P <your release> %
following: Installation and Upgrade
* SAPERP 6.0 Enhance- Information ¥ Installation
ment Package 5 is man- )
Guide }
datory.
e SAPERP 6.0 Enhance-
ment Package 7 or
higher is mandatory if
implementing the SAP
Assortment Planning for
Retail Co-Deployed with
SAP ERP system land-
scape.
SAP HANA Live for SAP ERP ~ SAP HANA Live for SAP ERP  Optional, depending on http://help.sap.com/hba s
1.0 SPS 02 or higher whether or not you choose to

integrate real-time analytics
with SAP HANA Live.

| instaliation, Security,
Configuration, and

Operations Information

Administrator's Guide 4
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Product Prerequisite Version Mandatory/Optional Installation Information
SAP Jam SAP Jam, initial release or Optional, depending on http://help.sap.com/sapjam
higher whether or not you choose to #|p SAP Jam Collaboration
integrate social media collab- System Administration
oration functionality with
Information > Administrator
SAP Jam.
Guide 1
SAP BusinessObjects Analy-  SAP BusinessObjects Analy- Mandatory http://help.sap.com/boao
sis sis, edition for Microsoft Of- "h"lb <your release> >
fice 2.2 SP2 Installation, Configuration,
Security, and Administration
Information >
Administrator's Guide }
SAP Promotion Management for Retail
Prerequisites for SAP Promotion Management for Retail
Product Prerequisite Version Mandatory/Optional Installation Information
SAP ERP SAP ERP 6.0 Enhancement ~ Mandatory http://help.sap.com/erp P
Package 5 |} <your release> >
Installation and Upgrade
Information ¥ Installation
Guide }
SAP HANA Live for SAP ERP ~ SAP HANA Live for SAP ERP  Mandatory. http;//he|p,gap,com/hbar}
1.0 SPS 02 or higher |} Installation, Security,
Configuration, and
Operations Information ¥
Administrator's Guide ]
SAP Jam SAP Jam, initial release or Optional, depending on http://help.sap.com/sapjam
higher whether or not you choose to "h"lb SAP Jam Collaboration
integrate social media collab- System Administration
oration functionality with ) o
Information > Administrator
SAP Jam.
Guide 3
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4 Upgrade Scenarios

4.1 SAP Customer Activity Repository

4.1.1 Quick Guide

This section includes a checklist with all actions that you have to perform. The actions are in chronological
order, so that you can work through them like a checklist.

Checklist

Prerequisites

Mandatory Steps

[ Ensure that your landscape meets the requirements outlined in the Prerequisites section.
Upgrade Process

Mandatory Steps

[0 Read and implement SAP Note 2298340 .
[J Upgrade your back-end system product version in SAP Solution Manager.

[ Upgrade the application function libraries (UDFAFL_INST 100, POSAFL INST 100).

Optional Steps

[0 Upgrade or install product-specific SAP Fiori Ul components on the front-end server. This is only required if
you plan on using the SAP Smart Business for Multichannel Sales Analytics cockpit or the Analyze Forecast

standalone SAP Fiori app.
[ Install alternate storage integration with SAP |Q or Hadoop.

Follow-Up Activities
Mandatory Steps

] Activate the SAP HANA content.
[J Replicate the new SAP ERP tables for SAP Customer Activity Repository.

[ Generate time data.
Optional Steps

[J Configure SAP Smart Business for Multichannel Sales Analytics.

[J Configure Demand Data Foundation.
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[J Configure Unified Demand Forecast.
[J Configure the Analyze Forecast standalone SAP Fiori app
[J Configure On-Shelf Availability.

4.1.2 Upgrade Process
4121 Implement SAP Note 2298340

Use

Prior to upgrading the CAR RETAIL APPL BUNDLE 1.0 back-end product version from an older support
package stack (SPS) to a newer one, you need to verify the SAP NetWeaver 740 SPS in your system landscape.
Important corrections, relevant for Core Data Services (CDS) views, and required by the latest SPS of cAR
RETAIL APPL BUNDLE 1.0, areonly available as of SAP NetWeaver 7.40 SPS 15.

Procedure

1. Verify your SAP NetWeaver 7.40 support package stack.
If your landscape contains SAP NetWeaver 740 SPS 12, SPS13, or SPS14, you will need to implement SAP
Note 2298340% to apply corrections relevant for CDS views.
If your landscape has been upgraded to SAP NetWeaver 740 SPS 15, you do not need to implement SAP
Note 2298340#% , and you can go to the next procedure.

2. Read and implement SAP Note 2298340 prior to upgrading the back-end system product version.

More Information

http://help.sap.com/hana_platform#|» Development and Modeling » SAP HANA Modeling Guide (For SAP
HANA Studio)

4122 Upgrade SAP Customer Activity Repository Retail
Applications Bundle

Use

This procedure describes how to upgrade the CAR RETAIL APPL BUNDLE 1.0 back-end product version
from an older support package stack to a newer one.
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Procedure

1. Check your upgrade scenario:
1. Navigate to the Product Availability Matrix (PAM) at http:/support.sap.com/pam#te .

2. Forinformation about the available support package stacks (SPS), search for the CAR RETAIL APPL
BUNDLE 1.0 product version, and choose Support Package Stacks.

3. Forinformation about the supported upgrade paths, choose Related Product Versions.

4. For information about the software components in the SPS, choose Technical Release Information and
consult the subsections, such as Database Systems.

5. To navigate directly to the download area for the SPS, choose [ SAP Software Download Center » CAR

RETAIL APPL BUNDLE 1.0 - Support Packages & Patches 3.
Alternatively, you can get there from the SAP Support Portal by choosing http://support.sap.com/

swdc# | Support Packages and Patches » Software Downloads j SUPPORT PACKAGES & PATCHES »
By Alphabetical Index (A-Z) » C » CAR RETAIL APPLICATIONS BUNDLE » CAR RETAIL APPL BUNDLE
103
2. Patch the support package stack using the Support Package Manager tool (transaction spaMm).
For more information about this tool, see SAP Help Portal at http://help.sap.com/spmanager

| Application Help 3, as well as SAP Note 18039867 .

To finalize the upgrade of the back-end product version, you must additionally do some manual steps. Continue
with the next section.

Download and Install the Application Function Libraries (AFLs)

There are two components that you cannot upgrade using Support Package Manager.

e Unified Demand Forecast application function library (UDF AFL, software component version
UDFAFL_INST 100, provides the demand modeling and forecasting services in SAP Customer Activity
Repository, runs directly in the SAP HANA database)

e On-Shelf Availability application function library (POS AFL, software component version POSAFL_INST
100, provides the On-Shelf Availability services in SAP Customer Activity Repository, runs directly in the
SAP HANA database)

You need to download one UDF AFL revision and one POS AFL revision manually and install them together in
your SAP HANA database.

Where to Download

Both AFLs are provided as part of the CAR RETAIL APPL BUNDLE 1.0 product version onthe SAP Support
Portal under http://support.sap.com/swdc#|» Support Packages and Patches j» Software Downloads »
SUPPORT PACKAGES & PATCHES ¥ By Alphabetical Index (A-Z) » C » CAR RETAIL APPLICATIONS BUNDLE ¥
CAR RETAIL APPL BUNDLE 1.0 }» Entry by Component » Analytics AFL 3.

For a successful upgrade, you need to be aware of the following dependencies.
Dependencies Between the AFLs and the SAP HANA Database

The AFLs are released independently of the releases of SAP Customer Activity Repository retail applications
bundle. This is because the AFLs follow the release cycle of the SAP HANA database. The releases are called
“revisions”. Whenever a new revision of the SAP HANA database is released, a new revision of each AFL is

released. As a result, multiple revisions of each AFL are available on the SAP Support Portal at any one time.
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A Caution

For each revision of an AFL, there is only one compatible revision of the SAP HANA database. For example,
you can only use revision 112.20 of the UDF AFL with revision 112.02 of the SAP HANA database. Whenever
you upgrade an AFL, you must also upgrade the database and any other AFLs to the compatible revisions.
Reversely, whenever you upgrade the database, you must upgrade the AFLs.

Note that this dependency applies not only to the UDF AFL and the POS AFL but also to the generic SAP
HANA AFL. Both the SAP HANA AFL and the SAP HANA database are components of the SAP HANA
Platform (see Prerequisites [page 16]).

When you download an AFL revision from the SAP Support Portal, the compatible revision of the SAP
HANA database is indicated.

Nomenclature

The following table explains how you can see the dependencies by looking at the release numbers:

Release of ... Released as ... Example Guideline

SAP HANA Platform <Support Package Stack> SAP HANA Platform SPS11 ~ The number of the support
package stack determines
the first digits of the revi-
sions.

SAP HANA Database <Revision>.<Patch> SAP HANA Database 112.02  All 11x.xx database revisions

belong to the SPS 11 plat-
form stack.

The patch number deter-
mines the first digit of the
AFL patch.

UDF AFL

POS AFL

SAP HANA AFL

<Revision>.<Patch>

UDF AFL112. 20

POS AFL112. 20

SAP HANA AFL 112. 20

- Recommendation

We recommend that you upgrade all the AFLs at the same time. This means:

e UDF AFL and POS AFL, which you must both install for a successful upgrade of SAP Customer Activity
Repository retail applications bundle

e SAP HANA AFL, which is one of the mandatory prerequisites

e ifapplicable, other AFLs provided with SAP HANA that might be relevant for your scenario

Focus on the AFL that provides the most important functionality for your scenario (for example, demand
forecasting with the UDF AFL). Select the best revision of that AFL for your scenario. This in turn will give
you the compatible revision of the SAP HANA database and the compatible revisions of the other AFLs.

Then install all the AFLs together.

Download and Install the UDF AFL (Focus: Demand Forecasting)
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1. Select an AFL revision.
Multiple revisions are available on the SAP Support Portal. For guidance on selecting the best revision for
your Unified Demand Forecast scenario, see the following:

o Prerequisites [page 16]: Indicates the minimum revision of the AFL and the SAP HANA Platform for
this release.

o SAP Note 2088924 : Release Information Note (RIN) for SAP Customer Activity Repository retail
applications bundle 1.0.

o SAP Note 2050229#% : Gives you an overview of all UDF AFL revisions as of revision 82 and provides
instructions for downloading, installing, and upgrading the UDF AFL.
o  SAP-HANA-related information:

o Release and maintenance strategy of the SAP HANA Platform at http://support.sap.com/swdc#
| Support Packages and Patches # Software Downloads » SUPPORT PACKAGES & PATCHES ¥ By
Alphabetical Index (A-Z) » H » SAP HANA Platform Edition ¥ Info J

o SAP Note 2021789#% : SAP HANA Revision and Maintenance Strategy

o SAP Note 2227464 : SAP HANA Platform SPS 11 Release Note

o SAP Note 1948334 #%: SAP HANA Database Update Paths for Maintenance Revisions

o SAP Note 1914052#: Dependencies between SAP NetWeaver and the SAP HANA Database

2. Download and install your AFL revision (together with the other AFLs) as described in SAP Note 2050229
.

i Note

To use the UDF functionality in your implementation scenario, you must additionally do some post-
installation steps. For more information, see Configure Unified Demand Forecast (Optional) [page 64].

Download and Install the POS AFL (Focus: On-Shelf Availability)

1. Select an AFL revision.
Multiple revisions are available on the SAP Support Portal. For guidance on selecting the best revision for
your On-Shelf Availability scenario, see the following:

o Prerequisites [page 16]: Indicates the minimum revision of the AFL and the SAP HANA Platform for
this release.

o SAP Note 2088924 #% : Release Information Note (RIN) for SAP Customer Activity Repository retail
applications bundle 1.0.

o SAP Note 2056102#% : Gives you an overview of all POS AFL revisions as of revision 82 and provides
instructions for downloading, installing, and upgrading the POS AFL.
o SAP-HANA-related information:

o Release and maintenance strategy of the SAP HANA Platform at http:/support.sap.com/swdc#
| Support Packages and Patches ¥ Software Downloads » SUPPORT PACKAGES & PATCHES ¥ By
Alphabetical Index (A-Z) » H » SAP HANA Platform Edition j Info 3

o SAP Note 2021789#% : SAP HANA Revision and Maintenance Strategy

o SAP Note 2227464#% : SAP HANA Platform SPS 11 Release Note

o SAP Note 1948334 #%: SAP HANA Database Update Paths for Maintenance Revisions

o SAP Note 1914052#% : Dependencies between SAP NetWeaver and the SAP HANA Database

2. Download and install your AFL revision (together with the other AFLs) as described in SAP Note 2056102
i
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i Note

To use the On-Shelf Availability functionality in your implementation scenario, you must additionally do
some post-installation steps. For more information, see Configure On-Shelf Availability (Optional) [page
53].

Result

You have successfully upgraded the CAR RETAIL APPL BUNDLE 1.0 back-end product version to the current
SPS. Continue with the next section.

4.1.2.3 Install ABAP Front-End Server (Optional)

The following section only requires implementation if you plan on using the SAP Smart Business for
Multichannel Sales Analytics cockpit or the Analyze Forecast standalone SAP Fiori app.

For more information about the cockpit or the app, see SAP Help Portal at http:/help.sap.com/car# | <your
release> ¥ Application Help » Additional Content » SAP Smart Business for SAP Customer Activity
Repository 3 as well as Standalone SAP Fiori Apps for SAP Customer Activity Repository.

41.2.31 Install SAP Gateway on the ABAP Front-End
Server

Use

The ABAP front-end server contains the complete Ul layer consisting of the central SAP Fiori Ul component,
the product-specific SAP Fiori Ul component, and the SAP Gateway. SAP Gateway handles the communication
between the client and the ABAP back-end server.

For a visualization of how these components interact, see the Overall System Planning section of the Common
Installation Guide.

When you are implementing the central hub deployment option, you use separate servers for the back-end
and the front-end components in your landscape.

Procedure

1. Ensure that the necessary SAP NetWeaver version is installed on your front-end server. For more
information, see https://help.sap.com/viewer/p/FIORI_IMPLEMENTATION | Version: SAP NW 7.40 »
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Installation and Upgrade j» Setup of SAP Fiori System Landscape ¥ Setup of SAP Fiori System Landscape
with SAP HANA Database ¥ Installation 3.

41.2.3.2 Install Central SAP Fiori Ul Components

Use

The complete Ul layer consisting of the central Ul component, the product-specific Ul components, and the
SAP Gateway is contained in the ABAP front-end server. The central Ul component contains the SAPUI5
control library and the SAP Fiori launchpad.

When you are implementing the central hub deployment option, you use separate servers for the back-end and
front-end components in your landscape. Your front-end server must have the required central Ul component
version.

Procedure

1. Ensurethat SAP FIORI FRONT-END SERVER 2.0 SPSO03isinstalled on your front-end server.
For more information about this component, see the Prerequisites section in this guide.

412.3.3 Install the SAP Smart Business Modeler Apps
Framework

The SAP Smart Business for Multichannel Sales Analytics apps included in this installation are based on the
SAP Smart Business Modeler Apps Framework. Installation and setup of this framework includes the following:

e |[nstallation of SAP Smart Business Modeler apps on the front-end server
e |nstallation of SAP Smart Business products on the SAP HANA Server

e |[nstallation of SAP Web Dispatcher

e Communication channels

® App implementation

For more information on these topics, see http:/help.sap.com/nw74 | Application Help #» Ul Technologies in
SAP NetWeaver ¥ Ul Development Toolkit for HTML5 (SAPUI5) ¥ SAPUI5 Application Frameworks ¥ SAP Smart
Business ¥ Setting up the SAP Smart Business Modeler Apps Framework .
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412.34 Upgrade Product-Specific SAP Fiori Ul
Component

Use

This procedure describes how to upgrade the SAP FIORI FOR SAP CARAB front-end product version from an
older support package stack to a newer one.

The ABAP front-end server contains the complete Ul layer, which consists of the SAP Gateway, the central SAP
Fiori Ul component, and the product-specific SAP Fiori Ul component. The product-specific SAP Fiori Ul
component contains all the SAP Fiori user interfaces for the applications provided for the SAP Customer
Activity Repository retail applications bundle.

Procedure

1. Identify the support package stack on the SAP Support Portal at http:/support.sap.com# | Software
Downloads # Support Packages and Patches # Software Downloads By Alphabetical Index (A-Z) ¥ F
SAP FIORI » SAP FIORI FOR SUITE » SAP FIORI FOR SAP CARAB » SAP FIORI FOR SAP CARAB 2.0

SPSO1 3.
For more information on support package stacks, see http:/support.sap.com/sp-stacks #r.
2. Patch the support package stack using the Support Package Manager tool (transaction spaM).

For more information, see SAP Help Portal at http://help.sap.com/spmanager# | Application Help 3, as
well as SAP Note 1803986 # .

A\ Caution

As of the FP3 release, software components UTISCARO1 and UIRAPOO1 have been merged into one,
UICAR001, software component.

3. If you are using SAP Assortment Planning for Retail, consult SAP Note 2077357, which lists the SAP
Notes relevant for your release.

4.1.2.4 Install Alternate Storage (Optional)

The following section only requires implementation if you plan on using the Table Content Aging report
delivered with SAP Customer Activity Repository. This report allows you to copy your transaction log (TLOG)
data and its extensions from your SAP HANA database to an alternate storage technology such as SAP IQ or
Hadoop, thereby reducing your total cost of hardware ownership.

For more information, see SAP Help Portal at http:/help.sap.com/car# |l <your release> » Application Help »
SAP Customer Activity Repository » POS Data Transfer and Audit » Implementing a POS Transaction Data
Storage Strategy ¥ Using the Table Content Aging Report 3.
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i Note

When modeling and forecasting demand using the Unified Demand Forecast (UDF) module, we
recommend retaining the historical sales data in memory.

Process Flow

In order to successfully install alternate storage, you must execute the following procedures:

1. Do one of the following:
o Install and set up integration with SAP 1Q, or
o Install and set up integration with Apache Hadoop.
2. Create the remote source in SAP HANA studio.
3. Create the virtual table.
4. Set the deploy mode in SAP HANA Transport for ABAP.

41241 Install and Set Up Integration with SAP 1Q

You use these procedures to install and set up SAP 1Q to support the Table Content Aging report
(transaction /CAR/TABLE AGING) delivered with SAP Customer Activity Repository.

The SAP HANA database points to your SAP 1Q database using SAP HANA smart data access (SDA), which

exposes data from SAP 1Q remote sources as virtual tables.

For more information, see SAP Help Portal at http:/help.sap.com/car# | <your release> » Application Help »

POS Data Transfer and Audit » Implementing a POS Transaction Data Storage Strategy » Using the Table
Content Aging Report 3.

Install SAP IQ

A detailed procedure is described in the SAP 1Q 16.0 SPO8 Installation and Configuration Guide.

For more information, see SAP Help Portal at http://help.sap.com/iql608#% |+ Installation and Upgrade

Information ¥ Installation and Configuration Guide for <your operating system> 4.

Configure SAP IQ

1. Allocate sufficient space into which your data will be loaded.
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i Note

The default DBSpaces provided during installation are intended to be used for SAP IQ system
management. You should create your own DBSpace under the Main store with a DB File that is large
enough to satisfy your sizing requirements.

For more information, see SAP Help Portal at http://help.sap.com/iql608#& | Reference
Administration » Operations Information ¥ Reference:Statements and Options » SQL Statements »
CREATE DBSPACE Statement 1.

Create an in-memory row-level versioning (RLV) store.

For more information, see SAP Help Portal at http://help.sap.com/iql608#% | System Administration and
Maintenance Information » Application Operations Guides » Administration: In-Memory Row-Level
Versioning #» About In-Memory Row-Level Versioning 3.

Create a database under the content created at the beginning of this procedure.

i Note

Ensure the following:

o The SAP IQ stores are configured with a large enough cache configuration, main memory, and
temporary memory.

o The page size should be set to 128KB.
o The concurrency aligns with the amount of processes that will be triggered during the data copy.

For more information, see SAP Help Portal at http:/help.sap.com/iql608#& | Configuration and
Deployment Information » Configuration Guide 3.

Create tables /POSDW/TLOGF, /POSDW/TLOGF_EXT and /POSDW/TLOGF_X tables in the DBSpace created
at the beginning of the procedure.

i Note

These tables should have the same structure as your SAP HANA system. One possible way is to export
the table structure via Export SQL on the SAP HANA side, and import it on the SAP 1Q side using the
SQL console. The SQL statement might require minor modifications, for example renaming NVARCHAR
to VARCHAR and removing references to cs_* (for example, CS_FIXED).

5. Enable the RLV for the tables you just created.
6. Set the snapshot versioning property of the transaction to row-level.

«* Example

set option Snapshot Versioning = 'Row-level';

7. Enable connection blocking and set the blocking timeout threshold.

32

«» Example
set option blocking = 'On';

set option blocking timeout = '0';
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Install SAP 1Q Drivers

Install and configure the ODBC database drivers required to connect to the remote source.

i Note

Each data source driver setup is described in its own section. The prerequisites are given as a simple guide;
you will need to consult the original driver documentation provided by the driver manufacturer for more
detailed information.

A detailed procedure is described in the SAP HANA Administration Guide.

For more information, see SAP Help Portal at http://help.sap.com/hana_platform# |l System Administration
» SAP HANA Administration Guide  SAP HANA Data Provisioning  SAP HANA Smart Data Access § Setting
Up Database Drivers » SAP IQ Driver Setup 4.

4124.2 Install and Set Up Integration with Apache
Hadoop

You use these procedures to install and set up Apache Hadoop to support the Table Content Aging report
(transaction /CAR/TABLE_AGING) delivered with SAP Customer Activity Repository.

The SAP HANA database points to your Hadoop cluster using SAP HANA smart data access (SDA), which
exposes data from Hadoop remote sources as virtual tables.

For more information, see SAP Help Portal at http://help.sap.com/car# |l <your release> ¥ Application Help
POS Data Transfer and Audit » Implementing a POS Transaction Data Storage Strategy » Using the Table
Content Aging Report 4.

Process Flow

To successfully install and set up integration with Apache Hadoop, you must execute the following procedures:

1. Install Apache Hadoop.
2. Do one of the following:
o Install and set up the Apache Hive ODBC driver, or
o Install and set up the SAP HANA Spark controller.
3. Create and partition tables in Apache Hive.
4. Create a NFS mount on SAP NetWeaver.
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Install Apache Hadoop

According to the SAP HANA Administration Guide, SAP HANA smart data access is supported by Hortonworks
Distribution for Apache Hadoop: version 2.3 (supported on Intel-based hardware platforms only).

For more information on integration between SAP HANA and Apache Hadoop, see SAP Help Portal at http://
help.sap.com/hana_platform#|l System Administration » SAP HANA Administration Guide  SAP HANA
Data Provisioning % SAP HANA Smart Data Access 3.

For more information on installing Apache Hadoop, see http://docs.hortonworks.com # | All » HDP » 2.3 »
HDP 2.3.0 (GA) 3.

Install and Set Up Apache Hive ODBC Driver

i Note

Integration between SAP HANA and Apache Hadoop requires either an Apache Hive ODBC driver or an
SAP HANA Spark controller.

Implement this procedure only if you wish to integrate SAP HANA with Apache Hadoop via the Apache Hive
ODBC driver.

1. According to the SAP HANA Administration Guide, SAP HANA smart data access is supported by
Hortonworks Distribution for Apache Hadoop: version 2.3 (This includes Apache Hadoop version 1.0.3 and
Apache Hive 0.9.0; supported on Intel-based hardware platforms only).

For more information on integration between SAP HANA and Apache Hadoop, see SAP Help Portal at

http://help.sap.com/hana_platform#|+ System Administration » SAP HANA Administration Guide » SAP
HANA Data Provisioning » SAP HANA Smart Data Access J.
For more information on installing the Apache Hive ODBC driver, see http://docs.hortonworks.com # |+ All
% HDP % 2.3% HDP2.3.0 (GA) 3

2. Set up the driver as described in the SAP HANA Administration Guide at http://help.sap.com/
hana_platforme|p System Administration » SAP HANA Administration Guide » SAP HANA Data
Provisioning % SAP HANA Hadoop Integration » Hive ODBC Driver .

Install and Set Up the SAP HANA Spark Controller

i Note

Integration between SAP HANA and Apache Hadoop requires either an Apache Hive ODBC driver or a SAP
HANA Spark controller.

Implement this procedure only if you wish to integrate SAP HANA with Apache Hadoop via the SAP HANA
Spark controller.
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1. Read SAP Note 2290350#% to confirm the right combination of versions required between SAP HANA,
Apache Spark, and the SAP HANA Spark controller.

2. Install and set up the SAP HANA Spark controller as described in SAP Note 2273047 .

For more information on installing and setting up the SAP HANA Spark controller, see SAP Help Portal at
http://help.sap.com/hana_platform#| System Administration » SAP HANA Administration Guide » SAP
HANA Data Provisioning » SAP HANA Hadoop Integration » SAP HANA Spark Controller 3.

Create and Partition Tables

Create the SAP schema, tables, and table partitions as described in SAP Note 2317597 #r .

Create a NFS Mount on SAP NetWeaver

The TLOG data and its extensions are copied from your SAP HANA database to Hadoop using the HDFS NFS
Gateway on your Hadoop system. To enable this you must create a mount point on your SAP NetWeaver
system for the data files to be created directly in the Hadoop File System (HDFS).

i Note

The following steps are only guidelines which provide an example of how to mount Network File System
(NFS) on an SAP NetWeaver Linux-based client.

1. Make sure the NFS client is installed based on the examples provided:

Operating System Command

Red Hat, CentOS sudo yum install nfs-utils
Ubuntu sudo apt-get install nfs-common
SUSE sudo zypper install nfs-client

2. List the NFS shares exported on the server.
Example
showmount -e <host>

3. Set up a mount point for an NFS share.
Example
sudo mkdir <folder>
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i Note

You must ensure that the folder paths share the same naming conventions, as follows:

Temporary data folder /tmp/tct csv_out/temp

Data folder /tmp/tct _csv_out/data

4. Mount the cluster using NFS.
Example
sudo mount -o hard, nolock <host> <folder>

On your HDFS, the different tables are stored under a folder using the following convention:

<data directory>/<schema>/<table>/<businessdaydate=partition value>/{files}

On the SAP NetWeaver file system, the Hadoop files are stored under a physical path and file name that is
derived from a customer-definable logical path or file name. The configuration is provided via the FILE
transaction. Inside the FILE transaction, you also need to make use of parameters PARAM 1 and PARAM 2.
PARAM 1 will be populated during runtime by the program (generated file name) and PARAM 2 will be
populated by the program during runtime <schema>/<table>/<businessdaydate=partition value>.

Example (Data Directory)

If the Hadoop data files are stored in Unix/Linux folder /tmp/tct csv_out/data/hdp/apps/hive/
warehouse/<schema>/<table>/businessdaydate=partition value/{files}, the datadirectory
should point to physical file PARAM 1.CsV and physical directory /tmp/tct csv_out/data/hdp/apps/
hive/warehouse/<PARAM 2><FILENAME>.

You create the following logical path in the FILE transaction as follows:

Logical path /CAR/HDFS_DATA

Name HDFS Data

Syntax group UNIX

Physical path /tmp/tct _csv_out/data/hdp/apps/hive/

warehouse/<PARAM 2><FILENAME>

You create the following logical file in the FILE transaction as follows:

Logical file /CAR/HDFS_DATA
Name HDFS Data
Physical file <PARAM 1>.CSV
Data format WK1

Application area IS
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Logical path /CAR/HDEFS_DATA

Example (Temporary Directory)

On top of the Hadoop data files, you also need to provide a temporary directory in which the program will
populate script files and also temporarily store data files to be compressed.

If the temporary files are stored in Unix/Linux folder /tmp/tct csv _out/temp/{files}, you create the
following logical path in the FILE transaction as follows:

Logical path /CAR/HDFS_TEMP

Name HDFS Temp

Syntax group UNIX

Physical path /tmp/tct _csv_out/temp/<FILENAME>

You create the following logical file in the FILE transaction as follows:

Logical file /CAR/HDFS_TEMP
Name HDFS Temp
Physical file <PARAM 1>.SH

Data format

Application area IS

Logical path /CAR/HDFS_ TEMP

41.2.4.3 Create the Remote Source in SAP HANA Studio

Create a remote source by selecting the appropriate adapter and configuring the connection properties and
user credentials.

A detailed procedure is described in the SAP HANA Administration Guide.

For more information, see SAP Help Portal at http://help.sap.com/hana_platform# |l System Administration
» SAP HANA Administration Guide » SAP HANA Data Provisioning » SAP HANA Smart Data Access » Creating

and Configuring Remote Data Sources » Create Remote Data Sources .

41.2.4.4 Create the Virtual Table

Create virtual tables to access the data stored in remote tables.
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A detailed procedure is described in the SAP HANA Administration Guide.

For more information, see SAP Help Portal at http://help.sap.com/hana_platform# | System Administration
» SAP HANA Administration Guide » SAP HANA Data Provisioning » SAP HANA Smart Data Access » Creating
Virtual Tables 3.

41245 Set the Deploy Mode in SAP HANA Transport for
ABAP

In your back-end system, start the SAP HANA Transport for ABAP ( SCTS_HTA) transaction.
Enter sap.is.retail.car.nls inthe SAP HANA Repository Package field and choose Execute.
Choose F6 to select all synchronizable packages and objects.

Choose | Utilities » Deploy Mode 3.

Choose Mode P.

os wN e

For more information, see SAP Help Portal at http:/help.sap.com/nw74#& |y Application Help » Function-
Oriented View @ Solution Lifecycle Management » Software Logistics # Transport Scenarios for SAP HANA
Content » SAP HANA Transport for ABAP » Deploy Mode in SAP HANA Transport for ABAP .

4.1.3 Follow-Up Activities

4.1.3.1 Create SAP ERP Tables

In this section you must create the new SAP ERP tables that are required for SAP Customer Activity Repository
2.0. Create these tables using the instructions provided in SAP Note 2263205#% .

i Note

You must create the tables before proceeding with the upgrade. Failure to do so will result in SAP HANA
content activation and deployment failures.
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413.2 \Verify Correct Schema Mapping

The applications delivered with SAP Customer Activity Repository retail applications bundle require different
authoring schemas for their respective SAP HANA content. In this procedure, you verify that all authoring
schemas are mapped to the correct physical schemas of your customer system.

Background

Schema mapping is required for several reasons:

® |tis necessary for the SAP HANA content objects (for example, the views) to work correctly.
e |t allows you to move SAP HANA content from one system to another system, such as:

o from the SAP delivery system to your test system

o from your test system to your production system

You must map the authoring schema of the SAP HANA content objects to the physical schema of the relevant
tables:

e The authoring schema (logical schema) is the database schema in the source system with which the SAP
HANA content objects were created. It is referred to in the object properties.

® |nthe target system, the tables are typically stored in a different physical schema.

Authoring Schemas

You have two sets of authoring schemas:

Authoring Schemas for SAP Customer Activity Repository Retail Applications Bundle

SAP CAR

SAP DDF

SAPOSA

SAP RAP

Authoring Schemas for the Source Master Data Systems

SAP _CRM SAP Customer Relationship Management
SAP_CUAN SAP Hybris Marketing

SAP _ECC SAP ERP

SAP S4H SAP S/4HANA Retail
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Procedure

A Caution

This procedure is required regardless of the business scenario you are planning to implement.

To verify the schema mappings or create new ones, follow these steps in SAP HANA studio:

Open the Modeler perspective and display the Quick View tab.
Choose Schema Mapping.
Select the system and choose Next.

N

Do the following for the two sets of schemas:

o Map all authoring schemas from Table 1 to the same physical schema in your customer system. If
necessary, add new mappings.

© Map each authoring schema from Table 2 to the physical schema for the respective source master
data system in your customer system. If necessary, add new mappings.

5. Choose Finish.

4.1.3.3 Activate SAP HANA Content

Use

In this procedure, you activate all SAP HANA content required by SAP Customer Activity Repository.

For more information about activating SAP HANA content, see SAP Help Portal at http:/help.sap.com/
hana_platform# |l <your SAP HANA Platform SPS> » Development and Modeling ¥ SAP HANA Developer
Guide (For SAP HANA Studio) ¥ Setting Up the Analytic Model » Creating Views » Activating Objects 3.

Prerequisites

e Asamandatory prerequisite for a successful activation of the SAP HANA content for SAP Customer
Activity Repository, you must have successfully completed all of the procedures listed in the previous
sections of this guide.

e You must also set up the roles and privileges for the Unified Demand Foreast module as described in the
Authorization Requirements for the UDF AFL section of the SAP Customer Activity Repository Security

Guide, available at http://help.sap.com/car]l <your release> ¥ Security Information 3.

You must do this regardless of whether you want to use UDF forecasting in your scenario or not. This
procedure not only enables UDF, but it is required so that the SAP HANA content for SAP Customer
Activity Repository can be activated correctly.
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Procedure

To activate the SAP HANA content, carefully follow the instructions provided in SAP Note 2330386t

M Caution

If you are applying a support package or correction on an existing installation and this support package or
correction involves SAP HANA content for the DDF module or the UDF module in SAP Customer Activity
Repository, then you must manually activate this content again. For example, this is the case when you
apply an SAP Note using transaction SNOTE.

Follow the instructions in SAP Note 2145356 #& .

More Information

If you encounter issues during the activation, see the Troubleshooting [page 75] section for possible solutions.

4.1.3.4 Replicate SAP ERP Tables

Use

In this procedure, you ensure that all SAP ERP tables that are relevant for SAP Customer Activity Repository
have not only been created but have also been filled with data. More specifically, you replicate the contents of
relevant tables from the source SAP ERP system to your back-end system.

The steps outlined in this procedure are required when you are implementing one of the SAP Customer Activity
Repository system landscape variants that require data to be replicated from a source SAP ERP system. If your
source SAP ERP system and the repository are co-deployed on the same SAP HANA database, proceed to the
next procedure. For more information, see System Landscape Variants in the Common Installation Guide.

Procedure

1. Define client transformation rules for all SAP ERP tables that you plan to replicate.
In most cases, you need to apply transformation rules to map the client of the source SAP ERP system to
the client on the target SAP Customer Activity Repository system.

A\ Caution

Transformation rules must be defined prior to replicating tables.

For more information, refer to one of the following:
o Set Up SAP Client section in the Common Installation Guide.
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o http:/help.sap.com/hanaf | SAP HANA » SAP HANA Options » SAP HANA Real-Time Replication »
SAP HANA Trigger-Based Data Replication Using SAP LT Replication Server ¥ System Administration
and Maintenance Information » Configuration Information and Replication Concepts j» Data

Transformation Capabilities within SAP Landscape Transformation Replication Server 4
o SAP Note 1733714 #
2. Specify which SAP ERP tables to replicate.
We recommend that you only replicate data for SAP ERP tables that are relevant to SAP Customer Activity
Repository. Read SAP Note 2263205, replicating only the tables listed in the attached files.
However, if you are planning to use all of SAP HANA Live for SAP ERP views, then replicate all the tables
listed in the file attached to SAP Note 1781992 #r .
For more information, see:

o http:/help.sap.com/hbaf |} Installation, Security, Configuration, and Operations Information
Administrator's Guide » Configuration Steps * Replicate Data (Side-by-Side Only) 3

o http:/help.sap.com/hanaf | SAP HANA » SAP HANA Options » SAP HANA Real-Time Replication »
SAP HANA Trigger-Based Data Replication Using SAP LT Replication Server ¥ System Administration

and Maintenance Information ¥ Configuration Information and Replication Concepts # ( <Managing
the Replication Process Using the SAP HANA Studio>and <Important Transactions

and Control Tables>) 4

A\ Caution

This procedure includes the replication of tables from your source SAP ERP system. Trigger-based
replication includes deletion in source tables by archiving activities (since on the database level it is
impossible to distinguish between delete actions caused by archiving and regular deletion of data
records). As a result, SAP LT (Landscape Transformation) Replication Server replicates archiving
activities as delete actions in the SAP HANA database.

More specifically, when data is archived in your source SAP ERP system, records are deleted from their
respective database tables. Therefore, when these tables are replicated to another SAP HANA
database, the records that were archived in the source tables are deleted in the target database tables.

For example, sales document data is set up to be replicated from your source SAP ERP system to your
target SAP HANA database. You may have set up your SAP ERP system to archive sales documents
that are more than a year old. Given the SAP ERP archiving settings, in the SAP Customer Activity
Repository system, you will not be able to run analytic reports on multichannel transaction data (which
includes replicated SAP ERP sales documents) that is more than a year old.

When deciding on the frequency at which to archive data in the source SAP ERP system, you must
consider and balance the performance requirements of your SAP ERP system and the amount of
historical data that must be available in the SAP Customer Activity Repository system for analysis. The
general recommendation is that 18 to 24 months of historical sales data is available in the repository.
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4.1.3.5 Replicate Optional Tables
4.1.3.5.1 Replicate SAP CRM Tables (Optional)

Use

In this optional procedure, you set up the replication of tables from your SAP CRM source system. You only
need to perform this procedure if you have an SAP CRM system in your SAP Customer Activity Repository
landscape and you are planning to use the standard SAP implementation of customer identification delivered
with the SAP Customer Activity Repository.

Procedure

1. Ensure that the SAP LT Replication Server is installed and that a user with the appropriate authorizations is
set up in the target SAP HANA database.
If you have already ensured proper installation of the SAP LT Replication Server during previous
procedures, skip to the next step. Otherwise, refer to one of the following for more information:
o http:/help.sap.com/hanafir| SAP HANA » SAP HANA Options » SAP HANA Real-Time Replication »
SAP HANA Trigger-Based Data Replication Using SAP LT Replication Server ¥ Installation Information 3
o http:/help.sap.com/hanaf|r SAP HANA » SAP HANA Options » SAP HANA Real-Time Replication
SAP HANA Trigger-Based Data Replication Using SAP LT Replication Server ¥ System Administration
and Maintenance Information » Technical Prerequisites and Authorization Aspects 3
2. Setupauserinthe source SAP CRM system and grant relevant authorizations to this user.
For more information, see http://help.sap.com/hanaf | SAP HANA » SAP HANA Options » SAP HANA
Real-Time Replication » SAP HANA Trigger-Based Data Replication Using SAP LT Replication Server
System Administration and Maintenance Information » Configuration Information and Replication Concepts
» System Connections and Authorizations 3.
3. Specify a configuration in SAP LT Replication Server, which contains the definition of the connections
between:
o The source SAP CRM system and the SAP LT Replication Server
o The SAP LT Replication Server and the target SAP HANA database

For more information, see http://help.sap.com/hanat | SAP HANA » SAP HANA Options » SAP HANA
Real-Time Replication » SAP HANA Trigger-Based Data Replication Using SAP LT Replication Server »
System Administration and Maintenance Information » Accessing the Configuration and Monitoring

Dashboard 3.

The name that you assign to your configuration will be also be used as the name of the database catalog
schema that is automatically created on the target SAP HANA database. This is the schema to which you
will replicate the tables from the source SAP CRM system.

Once you save the configuration, a schema GUID and a mass transfer ID are automatically created and
assigned to the configuration. Furthermore, several dictionary tables are automatically replicated from
your source system to your target SAP HANA database.
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For more information, see http://help.sap.com/hanaf | SAP HANA » SAP HANA Options » SAP HANA
Real-Time Replication » SAP HANA Trigger-Based Data Replication Using SAP LT Replication Server
System Administration and Maintenance Information ¥ Important Transactions and Control Tables 3.

Define client transformation rules for all the SAP CRM tables that you plan to replicate.
In most cases, you need to apply transformation rules to map the client of the source SAP CRM system to
the client on the target SAP Customer Activity Repository system.

A\ Caution

Transformation rules must be defined prior to replicating tables.

For more information, refer to one of the following:

o Set Up SAP Client section in the Common Installation Guide.

o http:/help.sap.com/hanaf | SAP HANA » SAP HANA Options ¥ SAP HANA Real-Time Replication
SAP HANA Trigger-Based Data Replication Using SAP LT Replication Server » System Administration
and Maintenance Information ¥ Important Transactions and Control Tables » Data Transformation
Capabilities within SAP Landscape Transformation Replication Server 3

o SAP Note 1733714 #%

Read SAP Note 2263205 and replicate the tables listed in the attached file.

For more information, see http://help.sap.com/hanati | SAP HANA » SAP HANA Options » SAP HANA
Real-Time Replication » SAP HANA Trigger-Based Data Replication Using SAP LT Replication Server »
System Administration and Maintenance Information .

Map the authoring schema sap_CRM to your particular physical database schema which contains the SAP
CRM tables. If the physical database schema is already named sap_CcRM,this schema mapping is not
required.

Authoring Schema Physical Schema
SAP_CRM <Name of Your Schema for Storing SAP_CRM
Data>

For more information, see http://help.sap.com/hana_platform#&|» Development and Modeling » SAP
HANA Modeling Guide ¥ Importing Table Definitions and Data » Map Authoring Schema to the Physical
Schema 1.

i Note
Every time you make changes to the schema mapping, the SAP HANA content must be redeployed.

You can do this using one of two methods:
o Execute the /CAR/ACTIVATE HANA CONTENT report as described in SAP Note 2330386#% .

o Manually redeploy only those SAP HANA objects which are impacted by your schema mapping
change.
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4.1.35.2 Replicate SAP Hybris Marketing Tables (Optional)

Use

In this optional procedure, you set up the replication of tables from your SAP Hybris Marketing source system.
You only need to perform this procedure if you have a SAP Hybris Marketing system in your SAP Customer
Activity Repository landscape and you are planning to use the standard SAP implementation of customer
identification delivered with the SAP Customer Activity Repository.

Procedure

1. If you plan to implement SAP Hybris Marketing co-deployed with SAP Customer Activity Repository, the
SAP Hybris Marketing tables will not be replicated because they already exist in the same SAP HANA
database and the same database schema.

i Note

Client transformation is not possible without table replication, therefore a co-deployed scenario is only
possible if the client numbers in the two back-end systems are identical.

For more information, see Set Up SAP Client section in the Common Installation Guide.

2. If you plan to implement SAP Hybris Marketing side-by-side with SAP Customer Activity Repository, do the
following:
1. Define client transformation rules for all the SAP Hybris Marketing tables that you plan to replicate.
In most cases, you need to apply transformation rules to map the client of the source SAP Hybris
Marketing system to the client on the target SAP Customer Activity Repository system.

O\ Caution

Transformation rules must be defined prior to replicating tables.

For more information, refer to one of the following:

o Set Up SAP Client section in the Common Installation Guide.

o http:/help.sap.com/hanafir | SAP HANA » SAP HANA Options » SAP HANA Real-Time
Replication ¥ SAP HANA Trigger-Based Data Replication Using SAP LT Replication Server j System
Administration and Maintenance Information j Important Transactions and Control Tables  Data
Transformation Capabilities within SAP Landscape Transformation Replication Server J

o SAP Note 1733714 ¢

2. Read SAP Note 2263205#% and replicate the tables listed in the attached file.
For more information, see http://help.sap.com/hanaf | SAP HANA » SAP HANA Options # SAP
HANA Real-Time Replication » SAP HANA Trigger-Based Data Replication Using SAP LT Replication
Server » System Administration and Maintenance Information 3.

3. Regardless of whether you implement SAP Hybris Marketing co-deployed or side-by-side with SAP
Customer Activity Repository, map the authoring schema sap_CUAN to your particular physical database
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schema that contains the SAP CRM tables. If the physical database schema is already named SAP CUAN,
this schema mapping is not required.

Authoring Schema Physical Schema

SAP CUAN <Name of Your Schema for Storing SAP Hybris
Marketing Data>

For more information, see http://help.sap.com/hana_platform# | Development and Modeling » SAP
HANA Modeling Guide ¥ Importing Table Definitions and Data » Map Authoring Schema to the Physical
Schema 1.

i Note
Every time you make changes to the schema mapping, the SAP HANA content must be redeployed.

You can do this using one of two methods:

o Executethe /CAR/ACTIVATE HANA CONTENT report as described in SAP Note 2330386t .

o Manually redeploy only those SAP HANA objects that are impacted by your schema mapping
change.

Side-by-Side Scenario (SLT)

1. Define client transformation rules for all the SAP Hybris Marketing tables that you plan to replicate.
In most cases, you need to apply transformation rules to map the client of the source SAP Hybris
Marketing system to the client on the target SAP Customer Activity Repository system.

O\ Caution

Transformation rules must be defined prior to replicating tables.

For more information, refer to one of the following:

o Set Up SAP Client section in the Common Installation Guide.

o http:/help.sap.com/hanaft|r SAP HANA » SAP HANA Options » SAP HANA Real-Time Replication »
SAP HANA Trigger-Based Data Replication Using SAP LT Replication Server ¥ System Administration
and Maintenance Information ¥ Important Transactions and Control Tables ¥ Data Transformation
Capabilities within SAP Landscape Transformation Replication Server 3

o SAP Note 1733714 ¢

2. Read SAP Note 1897025 and replicate the tables listed in the . txt file attached to this SAP Note.
For more information, see http://help.sap.com/hanaf | SAP HANA » SAP HANA Options » SAP HANA
Real-Time Replication » SAP HANA Trigger-Based Data Replication Using SAP LT Replication Server

System Administration and Maintenance Information 3.
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4.1.3.6 Configure SAP Smart Business for Multichannel
Sales Analytics (Optional)

413.6.1 Activate SAP HANA Content for SAP Smart
Business for Multichannel Sales Analytics
(Optional)

Use

In this procedure, you activate all SAP HANA content required by the SAP Smart Business for Multichannel
Sales Analytics dashboards.

Prerequisites

You have completed activating all SAP HANA content (SAP HANA views and SQLScript procedures) required
by SAP Customer Activity Repository.

For more information, see Activate SAP HANA Content for SAP Customer Activity Repository [page 40].

Procedure

1. Logontothe ABAP instance of the SAP Customer Activity Repository system.

2. Execute transaction SE38.

3. Specify SNHI NHDU POST PROCESS in the Program field and choose Execute.

4. If you are running SAP NetWeaver 7.4 SPS 05 or higher, make the following entries:
Parameter Instruction
Transport Container Name /CAR/HCO_RTLCAR_MCSA
Activate Delivery Unit Content Select the checkbox.
Activate HTC Do not select the checkbox.

5. Choose Execute.

All objects belonging to the delivery unit will be activated in the SAP HANA repository. This process can take
several minutes. Once the activation process is complete, you are notified whether or not the import and
activation of the SAP HANA delivery unit was successful.
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413.6.2 Configure SAP NetWeaver Gateway
4.1.3.6.2.1 Perform General SAP Gateway Configuration

Use

Prior to connecting the SAP Gateway on your front-end server to your back-end system, you need to perform a
series of general SAP Gateway configuration steps. These configuration steps include the setting of profile
parameters, ICF (Internet Communication Framework) services, language settings, and so on.

These steps are not specific to this guide and are described in the SAP NetWeaver product documentation
referenced below.

Procedure

1. Determine the SAP NetWeaver version on your front-end server.
2. Carry out the instructions specific to your SAP NetWeaver version:
o SAP Gateway for SAP NetWeaver 7.31
See http://help.sap.com/nwgateway20#% |+ Application Help » SAP NetWeaver Gateway Configuration
Guide » Basic Configuration Settings
o  SAP Gateway for SAP NetWeaver 740
See http://help.sap.com/nw74f|» Application Help » Function-Oriented View » SAP NetWeaver
Gateway Foundation (SAP_GWFND) » SAP NetWeaver Gateway Foundation Configuration Guide
General Configuration Settings

4.1.3.6.2.2 Connect SAP Gateway to Your Back-End System

Use

In this procedure, you configure the OData Channel, that is, set up a connection between SAP Gateway on your
front-end server and your back-end system.

These steps are not specific to this guide and are described in the SAP NetWeaver product documentation
referenced below.

Procedure

1. Setup the required roles on the front-end server and assign your user to these roles.
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For more information, see http://help.sap.com/nw74#& | Application Help » Function-Oriented View
SAP NetWeaver Gateway Foundation (SAP_GWFND) » SAP NetWeaver Gateway Foundation Configuration
Guide » SAP Gateway Configuration » User, Developer and Administrator Roles .
2. Specify the connection settings on the SAP Gateway hub system, which include:
o Connection from the SAP Gateway to consumer systems

These settings allow the connection between the SAP Gateway host and the consumer systems
(clients from which you access the SAP Fiori user interfaces).

o Connection from the SAP Gateway to SAP back-end system

These settings allow the connection between SAP Gateway to your back-end system.

These settings include:
o Creating a type 3 connection from the SAP Gateway host to your back-end system.
o Defining a trust relationship between your back-end system and the SAP Gateway host.
o Configuring your back-end system to accept SAP assertion tickets from the SAP Gateway host.
o Configuring your SAP Gateway host to accept SAP assertion tickets from your back-end system.
o Configuring the necessary system aliases.

More Information

For SAP NetWeaver 7.31, see SAP Library for SAP NetWeaver Gateway on SAP Help Portal at http://
help.sap.com/nwgateway20# | Application Help » Support Package Stack » SAP NetWeaver Gateway
Configuration Guide j» OData Channel Configuration j Connection Settings on the SAP NetWeaver Gateway Hub
System 3.

For SAP NetWeaver 74, see SAP Library for SAP NetWeaver on SAP Help Portal at http://help.sap.com/nw74

| Application Help ¥ Function-Oriented View » SAP NetWeaver Gateway Foundation (SAP_GWFND) » SAP
NetWeaver Gateway Foundation Configuration Guide ¥ SAP Gateway Configuration » Connection Settings for

the SAP Gateway Hub System 3.

4.1.3.6.2.3 Activate SAP Gateway

Use

Before you can use SAP Gateway functionality, you have to activate it globally on your front-end server.

These steps are not specific to this guide and are described in the SAP NetWeaver product documentation
referenced below.

Procedure

1. Determine the SAP NetWeaver version of your front-end server.
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2. Carry out the instructions specific to your SAP NetWeaver version:

o

SAP Gateway for SAP NetWeaver 7.31

See http:/help.sap.com/nwgateway20¢& |+ Application Help » SAP NetWeaver Gateway Configuration
Guide » OData Channel Configuration ¥ Activating SAP NetWeaver Gateway 1.

SAP Gateway for SAP NetWeaver 7.4

See http:/help.sap.com/nw74#&|p Application Help » Function-Oriented View » SAP NetWeaver
Gateway Foundation (SAP_GWFND) » SAP Gateway Foundation Configuration Guide » SAP Gateway
Configuration » Activating SAP Gateway .

4.1.3.6.2.4 Activate Common OData Services

Use

A number of OData services are required to run the SAP Fiori launchpad. These OData services are delivered as
part of the SAP Fiori front-end server. For more information, see the Prerequisites section in this guide.

For security reasons, all OData services are delivered in an inactive state. To use the SAP Fiori launchpad, you
must activate the common SAP Fiori OData services.

Procedure

1. Log on to your front-end system (your SAP Gateway system).

2. Go to Customizing (transaction SPRO).

3. Navigate to |[» SAP NetWeaver » Gateway » OData Channel » Administration » General Settings » Activate

and Maintain Services .
You are presented with the service catalog. This is a list of all the services that are currently active on your
SAP Gateway.

4. Get common SAP Fiori OData services:

1.

50

Choose Add Service.

The Add Service screen is displayed.

Enter the system alias of your local front-end system.

This is the alias created in the Connect SAP NetWeaver Gateway to your Back-End System [page 48]
procedure. For example, LOCAL.

Enter /uz2* in the Technical Service Name field.

Choose Get Services.

The Add Selected Services screen is displayed.

Select the common SAP Fiori OData services that you would like to activate, and choose Add Selected
Services.
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Service Name

/UI2/PAGE BUILDER CONF

/UI2/PAGE BUILDER CUST

/UI2/PAGE BUILDER PERS

/UI2/TRANSPORT

/UI2/INTEROP

The selected OData services are now active in your SAP Gateway.

More Information

® For SAP NetWeaver 7.31, see SAP Library for User Interface Add-On 1.0 on SAP Help Portal at http://
help.sap.com/nw-uiaddon20# |+ Application Help » SAP Fiori Launchpad # Setting Up the Launchpad »
Activating SAP Gateway OData Services 3.

e For SAP NetWeaver 7.4, see the documentation on SAP Help Portal at http:/help.sap.com/nw74#
| Application Help i Ul Technologies in SAP NetWeaver with SAP_UI 740 » SAP Fiori Launchpad » Setting
Up the Launchpad ¥ Activating SAP Gateway OData Services .

413.6.3 Configure the SAP Web Dispatcher

To configure the SAP Web Dispatcher, see SAP Help Portal at http:/help.sap.com/nw_platform | <your
release> ¥ Application Help » Function-Oriented View » Application Server » Application Server Infrastructure
» Components of SAP NetWeaver Application Server » SAP Web Dispatcher » Administration of the SAP Web
Dispatcher 3.

If you use any other reverse proxy, see the manufacturer's documentation for more information.

41.3.6.4 Configure Central SAP Fiori Ul Component

Use

The central SAP Fiori Ul component (delivered as part of the SAP Fiori front-end server) contains the SAPUI5
control library and the SAP Fiori launchpad. Prior to being able to use the SAP Fiori apps that constitute the
user interface of the retail applications described in this guide, you may need to configure the SAP Fiori
launchpad.
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These steps are not specific to this guide and are described in the SAP NetWeaver product documentation
referenced below.

For more information, see the Prerequisites section in this guide.

Procedure

1. Determine the SAP NetWeaver version on your front-end server.
2. Carry out the instructions specific to your SAP NetWeaver version:
o SAP Gateway for SAP NetWeaver 7.31
o http:/help.sap.com/nw-uiaddon20# | Application Help » SAP Fiori Launchpad 3, and
o http:/help.sap.com/nw-uiaddon20 |l System Administration and Maintenance Information
Administrator's Guide ¥ Configuration and Operations ¥ Content Administration  SAP Fiori
Launch Page ¥ Setting Up the SAP Fiori Launch Page 3
o  SAP Gateway for SAP NetWeaver 740
o http://help.sap.com/nw74# | Application Help » Ul Technologies in SAP NetWeaver with SAP_UI
740 » SAP Fiori Launchpad 3, and
o http:/help.sap.com/nw74# | Application Help ¥ Ul Technologies in SAP NetWeaver with SAP_UI
740 » SAP NetWeaver User Interface Services j» Configuration and Operations » Content
Administration » SAP Fiori Launchpage » Setting Up the SAP Fiori Launch Page 3
o SAP Gateway for SAP NetWeaver 7.50
o http:/help.sap.com/nw75| Application Help » Ul Technologies in SAP NetWeaver with SAP_UI
750 ¥ SAP Fiori Launchpad 7, and
o http://help.sap.com/nw75|¢ Application Help j» Ul Technologies in SAP NetWeaver with SAP_UI
750 » SAP NetWeaver User Interface Services » Configuration and Operations » Content
Administration » SAP Fiori Launch Page # Setting Up the SAP Fiori Launch Page 3

4.13.6.5 Configure SAP Jam (Optional)

Use

Your retail application uses collaboration SAP UI5 components to define key ABAP-based SAP business object
data that can be consumed by the SAP Jam social collaboration platform.

If you are using SAP Jam, you can configure the integration between your retail application and SAP Jam. The
integration, enabled by Social Media Integration, allows you to share, or expose, the pre-defined ABAP-based
SAP business object data directly from your retail application with members of your organization, through SAP
Jam.

The steps to enable the integration between your retail application and SAP Jam are not specific to this guide
and are described in the User Interface Add-On 1.0 for SAP NetWeaver product documentation referenced
below.
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Prerequisites

To enable the integration of your retail application with SAP Jam, you must have a license for SAP Jam
Collaboration, enterprise edition, and your SAP Jam instance must be configured for productive use.

Procedure

1. Read the documentation for the user interface add-on available on SAP Help Portal at http:/
help.sap.com/netweaver# |} User interface add-on 1.0 for SAP NetWeaver » Application Help ¥ Social

Media Integration 3.
This documentation provides important information on configuring the integration of your retail
application with SAP Jam, including the following sections:

o About SAP Jam Integration
Sections under Information for Administrators:
o Understanding the Overall Process for Integrating Collaboration for a Business Object
o Implementation of ABAP Social Media Integration (ABAP SMI)
o Implementation of Collaboration Components
o Connecting to SAP Jam with ABAP SMI
o Configuring ABAP SMI for SAP Fiori Apps

More Information

e For the latest updates on SAP Jam, see SAP Help Portal at http://help.sap.com/sapjam# .

e For configuration and maintenance information for SAP Jam, see http://help.sap.com/sapjam#| SAP
Jam Collaboration System Administration Information » Administrator Guide 3.

4.1.3.7 Configure On-Shelf Availability (Optional)

i Note

The steps in this section and all subsections are entirely optional and depend on your specific
implementation requirements.

Note that configuration of the On-Shelf Availability module is mandatory if you want to generate intraday
forecasts. For more information about this feature, see http://help.sap.com/car# | <your release> »
Application Help » SAP Customer Activity Repository ¥ Unified Demand Forecast » General Services

Generate Intraday Forecasts 3.

On-Shelf Availability (OSA) has its own database schema on the SAP HANA Platform (SAPOSA). To use the
OSA functionality in SAP Customer Activity Repository, perform the following post-installation steps.
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41.3.71 Generate Run IDs for OSA Processing Steps

Use

Each scheduled run of an OSA processing step has a generated run ID. This is the unique identification for a
job. The run ID is used to distinguish several runs within one period. Each processing step has its own ID
generator:

Processing step Transaction for the Generator
Intraweek Pattern /OSA/NR_IWP
Estimation /OSA/NR_EST
Monitoring /OSA/NR_MON
Analysis /OSA/NR_ANA

For each of the four transactions, you must define the range of run IDs.

Procedure

Do the following steps for each transaction:

1. Execute the transaction by specifying either /n<transaction>or /o<transaction>.
Example for the first transaction: /n/OSA/NR_IWP

2. Inthe first row of the table, enter the following values for the fields No, From No., and To Number:
o No: 01
o From No.: 0000000000000001
o To Number: 9999999999999999

3. Save your changes.

41.3.7.2 Check Field Contents in SAP HANA Content for
On-Shelf Availability

Use

There are two OSA-specific SAP HANA views that can be customized:
® AN TRANSACTION

® PROMOTION TRANS
You have to check if the fields in these views contain the mappings or formulas you need.
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A Caution

If you need to modify any of the views, be aware, that new installation will rewrite the modifications. It is
therefore recommended to back up the modified views.

Procedure

If you want to change the mapping or a formula of a field, perform the following steps:

Define the data foundation that is the source for the view, that is, the table /POSDW/TLOGEF.
Define filters for the view.
Map the fields from source to target.

A w oo

Create measures and calculation fields.

For detailed information, see http://help.sap.com/hana_appliance | Development and Modeling 3.
Definitions for a view taking the example of the AN_TRANSACTION view
The following definitions are set by default for the AN TRANSACTION view:

e Source of the view is the table /POSDW/TLOGF
e Examples of filters for the views:
© RECORDQUALIFIER = '5':Only salesrecords are used
© DATASTATUS in ('2' , '3'"):Onlythose records are used which passed the SAP Customer
Activity Repository validation
O RETAILQUANTITY > 0.0:Negative quantities are not used by On-Shelf Availability
© VOIDEDLINE = '':Cancelledtransactions are not used by On-Shelf Availability
e Examples of the fields mappings:
o MANDT: Clientid. This field is mapped to the MANDT column of the /POSDW/TLOGF table.
© STORE_1ID: Storeid. This field is mapped to the RETAILSTOREID column of the /POSDW/TLOGF table.
O BUSINESSDAYDATE: Business day. This field is mapped to the BUSINESSDAYDATE column of the /
POSDW/TLOGF table.
® [Examples of measures:
© RETAILQUANTITY: Amount of sold units. Refers to the SALESUOM (Sales Unit of Measure) field that is
also defined in the /POSDW/TLOGF table. Contains the value of the RETATLQUANTITY field.
© PRICE: Price specified in the store currency. Contains the value of the ACTUALUNITPRICE field.
e Examples of calculated fields:
© TRANS TIME DBL: Value of the TRANS TIME output field of type DOUBLE. The format of the
transaction time that is stored in BEGINTIMESTAMP and ENDTIMESTAMP is “YYYYMMDDhhmmss".
© DISCOUNT: Total relative discount applied on the item.
Calculated as (ITEMDISC + DISTDISC) / (RETAILQUANTITY * ACTUALUNITPRICE). If the price is not

positive number, O is returned.
Definitions:

o DISTDISC: global discount on the whole purchase; currently not used.
o |ITEMDISC: item-specific discount; currently used.
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4.1.3.7.3 Activate SAP HANA Content for On-Shelf
Availability

Use

In this procedure, you activate all SAP HANA content required by the On-Shelf Availability (OSA) module in SAP
Customer Activity Repository.

Prerequisites

You have verified that the authoring schemas are mapped to the correct physical schema. Note that On-Shelf
Availability has its own authoring schema (saposa). For more information, see Verify Correct Schema Mapping
[page 39].

Procedure
1. Log on to your back-end system.
2. Execute transaction SE38.
3. Specify SNHI NHDU POST_ PROCESS in the Program field and choose Execute.
4. If you are running SAP NetWeaver 7.4 SPS 05 or higher, make the following entries:
Parameter Instruction
Transport Container Name /OSA/HCO_POSDMEXT
Activate Delivery Unit Content Select the check-box.
Activate HTC Do not select the check-box.

5. Choose Execute.

All objects belonging to the delivery unit will be activated in the SAP HANA repository. This process can take
several minutes. Once the activation process is complete, you are notified whether or not the import and
activation of the SAP HANA delivery unity was successful.

41.3.74 \Verify that SAP HANA Content for On-Shelf
Availability has been activated

1. Logonto SAP HANA studio.
2. Open the Modeler perspective.
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In the Navigator window, expand the database system for which you have activated the views.
Expand the Content folder.

Expand the package hierarchy by choosing | sap ¥ is # retail » posdmext » osa 4.

o gk~ w

Verify that the following views have been activated:
© sap.is.retail.posdmext.osa.tlog.an transaction
© sap.is.retail.posdmext.osa.tlog.promotion trans
O sap.is.retail.posdmext.osa.status log view
© sap.is.retail.posdmext.osa.reporting.MON ANA VIEW
© sap.is.retail.posdmext.osa.reporting.STATUS LOG VIEW
7. Verify that the following procedures have been activated:
1. Procedures inthe package sap.is.retail.posdmext.osa.common:
© CREATE LOG ENTRY
© PARSE HOLIDAY STRING
© PARSE TYPE CODE_STRING
2. Proceduresinthe package sap.is.retail.posdmext.osa.tlog.dao:
© GET TRX FOR_TWP_SUBDEP
© GET TRX FOR_PRODUCT
© GET TRX_ FOR_STORE
© GET TRX FOR SUBDEP
© GET TRX FOR_SUBDEP WITH MIN
© GET TRX INFO FOR PRODUCT
© GET TRX FOR SUBDEP CURRENCY
3. Proceduresinthe package sap.is.retail.posdmext.osa.pattern.dao:
O PERSIST
© GET_INTRA WEEK PATTERN RUNS
© GET INTRA WEEK PATTERN LATEST
© GET INTRA WEEK PATTERN
© GET INTRA WEEK PATTERN FOR PRODUCT
4. Proceduresinthe package sap.is.retail.posdmext.osa.pattern.runner.internal:
© CALL FUNCTION
© CALL ALGO FOR STORE
© CALL ALGO FOR SUBDEP
© CALL ALGO PRODUCT IN SUBDEP
5. Procedures in the package sap.is.retail.posdmext.osa.pattern.runner.public:
© RUN FOR PRODUCT IN SUBDEP
© RUN FOR_STORE
© RUN FOR_SUBDEP
6. Procedure in the package sap.is.retail.posdmext.osa.estimation.config:
© GET CONFIG
7. Procedures in the package sap.is.retail.posdmext.osa.estimation.dao:
O PERSIST
© GET_ PARAMETER
© GET PARAMETERS
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8. Proceduresinthe package sap.is.retail.posdmext.osa.estimation.runner.internal:
© CALL FUNCTION
© CALL_ALGO_PRODUCT IN SUBDEP
9. Procedure inthe package sap.is.retail.posdmext.osa.estimation.runner.public:
© RUN_FOR PRODUCT IN SUBDEP
10. Procedures in the package sap.is.retail .posdmext.osa.monitor.dao:
O PERSIST
© CREATE STATUS LOG ENTRIES
© UPDATE STATUS TABLE
© CREATE STATUS LOG ENTRIES FOR EXCL PRODUCTS
© UPDATE STATUS TABLE FOR EXCL_ PRODUCTS
11. Procedures in the package sap.is.retail.posdmext.osa.monitor.runner.internal:
© CALL FUNCTION
© CALL ALGO PRODUCT IN SUBDEP
© RUN_FOR PRODUCT IN SUBDEP
12. Procedures in the package sap.is.retail.posdmext.osa.monitor.runner.public:
© GET QUALIFIED PRODUCT FOR RUNNER
© RUN_MONITOR
13. Procedure in the package sap.is.retail.posdmext.osa.analysis.calc:
© COMPUTE LOST SALES
14. Procedure in the package sap.is.retail.posdmext.osa.analysis.dao:
O PERSIST
15. Procedures in the package sap.is.retail.posdmext.osa.analysis.runner.internal:
© CALL FUNCTION
© CALL_ALGO_PRODUCT IN SUBDEP
16. Procedure in the package sap.is.retail.posdmext.osa.analysis.runner.public:

© RUN_FOR PRODUCT IN SUBDEP

41375 Configure SAP NetWeaver Gateway and Activate
OData Service

Use

This configuration step is only required if you use separate products or developments on top of SAP Customer
Activity Repository that communicate via OData service. After you have installed SAP NetWeaver Gateway,
configure the Gateway system and configure the settings for OData service.
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Procedure

The main steps to do this are as follows:

Activate SAP NetWeaver Gateway.

Define RFC connections from SAP NetWeaver Gateway to your back-end system.
Define settings for OData service for the SAP NetWeaver Gateway.

Define settings for Push Functionality (optional).

Set up users and Authorizations for SAP NetWeaver Gateway.

R N

Activate the OData Service in the SAP NetWeaver Gateway system (transaction / IWEND/
maint service) for the requested URI (for example: /sap/opu/sdata/0SA/
ON_SHELF AVAILABILITY/).

For detailed information, see SAP Library for SAP NetWeaver Gateway on SAP Help Portal at http://
help.sap.com/nwgateway#||» Application Help ¥ Support Package # SAP NetWeaver Gateway Developer
Guide » OData Channel 7.

4.1.3.8 Configure Demand Data Foundation (Optional)

A Caution
Required Configuration

The implementation and configuration of the DDF module in SAP Customer Activity Repository is
mandatory for the following scenarios:

® You want to model and forecast demand using the UDF module in SAP Customer Activity Repository.
For more information, see Configure Unified Demand Forecast (Optional) [page 64].

® You want to use the Omnichannel Promotion Pricing module in SAP Customer Activity Repository. For
more information, see Configure Omnichannel Promotion Pricing for Use with SAP Customer Activity
Repository [page 74].

® You want to use SAP Allocation Management for Retail.

® You want to use SAP Assortment Planning for Retail.

® You want to use SAP Merchandise Planning for Retail.

® You want to use SAP Promotion Management for Retail.

In addition to the configuration steps described in the following sections, see the Common Master Guide for
additional configurations and integration information. You can find this guide on SAP Help Portal at http://

help.sap.com/carf |l <your release> » Installation and Upgrade Information » Master Guide .

i Note

Integration Scenarios

e With the standard integration with an SAP ECC (SAP ERP Central Component) system, outbound data
replication using the data replication framework (DRF, transaction DRFOUT) is required for the following
scenarios:

o Modeling and forecasting with UDF
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o SAP Allocation Management for Retail
o SAP Assortment Planning for Retail
o SAP Merchandise Planning for Retail
o SAP Promotion Management for Retail
e |ntegration with non-SAP ECC systems and multiple SAP ECC systems is possible for certain scenarios.

For more information, see SAP Help Portal for SAP Customer Activity Repository at http://
help.sap.com/car® || <your release> » Application Help » Demand Data Foundation  Integration
Information j Master Data Replication from SAP ERP to Demand Data Foundation 3.

4.1.3.8.1 Activate Business Functions for DDF and UDF

In this procedure, you activate the business functions for DDF and UDF that are relevant for your scenario.

Use

i Note

As of SAP Customer Activity Repository 2.0 FP3, most of the existing business functions have been set to
obsolete. You no longer need to activate them to be able to use the Demand Data Foundation (DDF) and
Unified Demand Forecast (UDF) modules in SAP Customer Activity Repository. There is now only 1
recommended business function for DDF, and 2 required business functions for UDF. Nothing will happen if
you activate any of the obsolete business functions by accident. The new, simpler activation procedure is
described in the following.

You must implement DDF in the following scenarios:

® You want to model and forecast demand using UDF.

e You want to use applications residing in the ABAP back-end server that use data acquired and maintained
in DDF.

Procedure

1. Check which business functions are relevant for your scenario:

o For DDF (optional): We recommend that you activate the optional business function Decompression of
Lane Price and Time Dependent Data (/DMF/DDF _IMDB LANE TD) to benefit from optimized memory
usage.

o For UDF (required): If you want to model and forecast demand with UDF, you must activate the
following business functions:

o Activation of Forecast Engine (/DMF/FORECAST)
o Activation of Unified Demand Forecast (/DMF/DDF_UDF)
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2. Read the following documentation for each business function that you want to activate:

o Business function description under https://help.sap.com/viewer/p/CARAB | <Version>
Application Help » SAP Customer Activity Repository » Demand Data Foundation » Business
Functions J

o Execute transaction SFW5, select the business function, and follow the instructions under Release
Information.

3. Execute transaction SFW5 and activate the business functions that are relevant for your scenario.

- Recommendation

o Business functions should be activated by a system administrator.
o Once a business function is active, we recommend that you do not deactivate it.

i Note

For more information on business functions, see SAP Note 337623 Customizing after installation or
upgrade .

413.8.2 Configure Automatic Flattening of Hierarchies

Configure the system so it automatically creates and updates flat structures for the product and location
hierarchies in Demand Data Foundation (DDF). The flat structures are required so that the consuming
applications can correctly recognize the hierarchies.

Context

Flat structures describe the parent-child relationships of hierarchies in a flattened format. A hierarchy can be
vertically or horizontally flattened. Each row of the resulting flat structure contains one parent-child
relationship.

When you create (or update) a product hierarchy, product group, location hierarchy, or location group in DDF,
the system should create (or update) the corresponding flat structure. Without this, you get hierarchy errors in
the consuming applications.

To configure the automatic flattening of hierarchies, follow these steps:

Procedure

1. Carefully read SAP Note 1425876#% and follow the instructions.

2. Execute transaction SWETYPV and ensure that you have activated all required event type linkages and have
enabled the specified event queues. In particular, check that the Linkage Activated and Enable Event Queue
options are for each of the following events: LOCATION CREATED, LOCATION UPDATED,
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CREATE LOC_HIER, CREATE PROD HIER. If you need to change a setting, you can do so in the Details
screen of each event.

For more information about event handling, see SAP Note 1098805, in particular sections Events and
Transactions for troubleshooting.

Results

You have set up the automatic flattening of the hierarchies. Whenever you now create (or update) a hierarchy,
the system will automatically run the /DMF/TREE _FLATTENER PROD INS report (for product hierarchies) or
the /DMF/TREE _FLATTENER LOC_INS report (for location hierarchies) and create (or update) the
corresponding flat structure.

41.3.8.3 Import SAP NetWeaver Portal Roles for DDF

Use

To set up user authorizations for Demand Data Foundation (DDF), you can use the PFCG roles from the SAP
NetWeaver Business Client (NWBC) and from the SAP NetWeaver Portal. Both sets of roles operate in the
same manner. Using the SAP NetWeaver Portal is optional.

The roles have been created for use in SAP NetWeaver Business Client. To use the functions of these roles in
SAP NetWeaver Portal, you must upload the roles from the SAP back-end system to the portal. The uploaded
objects are converted into portal objects.

Procedure

1. Use the Role Upload tool to generate the SAP NetWeaver Portal roles automatically. For more information
about this tool, see SAP Note 1685257 .
You can also enhance the SAP NetWeaver Portal roles; for example, you can create your own iViews.
You can upload the following roles for DDF:
O SAP ISR DDF MASTER

© SAP ISR _DDF_READONLY MASTER

More Information

For descriptions of these roles and more information about maintaining roles in SAP Customer Activity
Repository, see http:/help.sap.com/carf|lp <your release> » Security Information j» Security Guide ¥

Authorizations 3.
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41.3.8.4 Enable Time-Dependent Article Hierarchies

Use

You can create SAP ERP article hierarchies with different statuses (Active, Disabled, Planned). Time-dependent
article hierarchies have status Planned. They only become active during a defined validity period in the future.

If you want to use time-dependent article hierarchies, you must first create them as such in your SAP ERP
system. Then in order for the Demand Data Foundation (DDF) module in your SAP Customer Activity
Repository system to recognize a time-dependent hierarchy, you must enable it as described in the following.

Procedure

To enable time-dependent article hierarchies, follow these steps:
1. Make sure that you have implemented the following SAP Notes:
0 2244521k
o 2245133
0 2245134 ¢
2. In Customizing, activate the time-dependent article hierarchy under | Cross-Application Components »
Demand Data Foundation j» Data Maintenance » Product Hierarchy » Control Parameters for Product
Hierarchies 3. For more information, see the Customizing activity documentation (transaction SPRO).

More Information

For more information about replicating data to DDF, see the following:

® https://help.sap.com/viewer/p/
SAP_CUSTOMER_ACTIVITY_REPOSITORY_RETAIL_APPLICATIONS_BUNDLE | <Version> ¥ Application
Help » SAP Customer Activity Repository » Demand Data Foundation ¥ Integration Information » Master
Data Replication from SAP ERP to Demand Data Foundation 3

e https:/help.sap.com/viewer/p/
SAP_CUSTOMER_ACTIVITY_REPOSITORY_RETAIL_APPLICATIONS_BUNDLE | <Version> ¥ Installation
and Upgrade » Common Master Guide ¥ Business Overview ¥ SAP Customer Activity Repository
Introduction to SAP Customer Activity Repository 3

For more information about Customizing for article hierarchies in SAP ERP, see the Customizing activities

under | Logistics - General ¥ Article Hierarchy 3.
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41.3.8.5 Check Performance-Related Configuration
Options

Use

Depending on your implementation scenario, you have additional configuration options for DDF that allow you
to optimize performance.

Procedure

Check the following options and implement those that are relevant for your scenario:

Use Case Configuration Option
You have an installation on a multiple-host SAP HANA sys- Consider table partitioning. For more information, see Parti-
tem. tion Tables for UDF and DDF (Optional) [page 67].

You want to use the Sales Projection function in SAP Assort-  The function relies heavily on the DDF module. You can opti-
ment Planning for Retail and have large data volumes to mize performance by implementing SAP Note 2080423 fr .
process.

More Information

If you encounter issues during the setup, see the Troubleshooting [page 75] section for possible solutions.

4.1.3.9 Configure Unified Demand Forecast (Optional)

i Note

The steps in this section and all subsections are optional and depend on your specific implementation
scenario.

To use the functionality of the Unified Demand Forecast (UDF) module in SAP Customer Activity Repository,
perform the following post-installation steps.
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41391 Complete UDF Setup

In this procedure, you complete the setup of the Unified Demand Forecast (UDF) module to enable demand
modeling and forecasting in SAP Customer Activity Repository.

Prerequisites

You have installed the UDF AFL as described in Download and Install the Application Function Libraries
(AFLs) in this guide.

You have configured DDF as described in Configure Demand Data Foundation (Optional) [page 59].

You have consulted the Common Master Guide for additional integration and configuration information for
DDF and UDF. You can find this guide on SAP Help Portal at https://help.sap.com/viewer/p/CARAB

|» <Version: 1.0 SPSx> ¥ Installation and Upgrade » Common Master Guide 3.
In particular, you are aware that different business processes related to DDF and UDF are available for
different business scenarios:

Business Scenario Business Process Uses DDF  Uses UDF

SAP Customer Activity Repository Enabling Demand Data Foundation and X X
Creating Demand Forecast

SAP Assortment Planning for Retail Enabling Demand Data Foundation and X
Creating Demand Forecast

SAP Merchandise Planning for Retail Enabling Demand Data Foundation X
SAP Promotion Management for Retail Enabling Demand Data Foundation and X x (only for
Creating Demand Forecast what-if

forecasts)

For more information about each scenario, see the Business Overview section in the Common Master
Guide.

Procedure

Perform Mandatory Configuration Steps

The following steps are mandatory if you want to model and forecast demand with UDF:

1.

Set up the users, roles, and privileges for UDF as described in the Authorization Requirements for the UDF
AFL section of the SAP Customer Activity Repository Security Guide. You can find this guide under https://

help.sap.com/viewer/p/CARAB | <Version: 1.0 SPSx> » Security 4.

. Activate all SAP HANA content for SAP Customer Activity Repository as described in Activate SAP HANA

Content [page 40].
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3. Analyze and implement the following SAP Notes:
o 1911141#% : Setting UDF-specific performance optimization parameters in the SAP HANA database

o 1898341#% : Configuration changes for demand modeling and forecasting to prevent decomposition
errors

Perform Optional Configuration Steps
You have the following additional options:

1. Implement the following optional SAP Notes if they are relevant for your scenario:

o 2176058#: Performance-related note that you must implement if you want to forecast complex offers
(such as Buy X Get Y) in production mode

o 2161484¢% : Information about an ABAP report that you can use to validate the input data for demand
modeling and forecasting and identify potential issues.
2. Set up table partitioning for your scenario.
For more information, see Partition Tables for UDF and DDF (Optional) [page 67].
3. Set up the generation of intraday forecasts.

If you want to generate intraday forecasts, you must configure both the UDF module and the OSA module
in SAP Customer Activity Repository:

1. See the Implementation Considerations section under https://help.sap.com/viewer/p/CARAB
| <Version: 1.0 SPSx> ¥ Application Help » SAP Customer Activity Repository # Unified Demand
Forecast » General Services » Generate Intraday Forecasts 3.

2. Configure UDF as described in this guide. At a minimum, you must perform the mandatory
configuration steps listed above.

3. Configure OSA as described in Configure On-Shelf Availability (Optional) [page 53].
4. Intransaction SPRO, perform the Customizing as required for your scenario:
o For UDF, see the activities and their documentation under |+ Cross-Application Components
Demand Data Foundation » Modeling and Forecasting .
o For OSA, see the activities and their documentation under |- SAP Customer Activity Repository
On-Shelf Availability 3.
4. Set up forecast visualization with the Analyze Forecast SAP Fiori app:
This analytical app is provided as part of the SAP FIORI FOR SAP CARAB front-end product version,

which you have already installed. To set up forecast visualization with this app, proceed as described in
Configure the Analyze Forecast App [page 68].

For more information about the app, see https://help.sap.com/viewer/p/CARAB |¢ <Version: 1.0 SPSx>
Application Help » SAP Customer Activity Repository » Additional Content » Standalone SAP Fiori Apps for
SAP Customer Activity Repository » Analyze Forecast 3, including all subsections.

More Information

If you encounter issues during the setup, see the Troubleshooting [page 75] section for possible solutions.
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4.1.3.10 Partition Tables for UDF and DDF (Optional)

Use

i Note

This section is only relevant for installations on multiple-host SAP HANA systems.

If you have an installation on a single-host SAP HANA system, you can skip this section.

To forecast consumer demand, you use the Unified Demand Forecast (UDF) and Demand Data Foundation
(DDF) modules in SAP Customer Activity Repository. UDF provides the actual modeling and forecasting
services. DDF provides the required data layer (for the import, export, and maintenance processes, for
example).

If your forecasting scenario involves large numbers of products and locations, the relevant UDF and DDF tables
can become very large. To improve standard database operations (such as inserting, updating, deleting, and
reading) and mass operations (such as archiving or index merging), we therefore recommend that you set up
partitioning for those tables.

As the Unified Demand Forecast application function library (UDF AFL) runs directly in the SAP HANA
database, much of the partitioning guidance for SAP HANA systems also applies to forecasting scenarios with
UDF and DDF. Your main reference, therefore, is the SAP HANA Administration Guide, which you can find under

http://help.sap.com/hana_platform# |+ System Administration 3. Make sure to select the guide for your
specific SAP HANA Platform SPS (if necessary, choose Earlier releases in the navigation tree on the left).

Prerequisites

® You have installed and configured UDF and DDF as described in this guide.

® You have the system privileges and object privileges required to perform table partitioning operations. For
more information, see the Authorization for Basic Administration Tasks in the SAP HANA Database section
of the SAP HANA Administration Guide.

® You are aware of the limitations for table partitioning. For more information, see the Partitioning Limits
section of the SAP HANA Administration Guide.

Procedure

1. Read the Table Partitioning section of the SAP HANA Administration Guide to learn about partitioning of
SAP HANA systems.

2. Read SAP Note 2190377 to learn which UDF and DDF tables are relevant for partitioning and what
partitioning aspects to consider.

3. Partition the tables as described in the note.
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- Recommendation

To help you with the partitioning decisions, consult the sizing information for your system landscape. For
example, check the number of records estimated for the large tables to decide which tables to partition and
how many partitions you need.

For more information on system sizing and a sizing questionnaire for SAP Customer Activity Repository,
see http://help.sap.com/car® | <your release> ¥ Additional Information ¥ Sizing 3.

4.1.3.11 Configure Standalone SAP Fiori Apps for SAP
Customer Activity Repository (Optional)

i Note

The steps in this section and all subsections are optional and depend on your specific implementation
requirements.

4.1.3.11.1 Configure the Analyze Forecast App

You can use the Analyze Forecast SAP Fiori app in SAP Customer Activity Repository to visualize detailed
demand modeling and forecasting information for performing in-depth analyses. In this procedure, you
perform several front-end and back-end implementation tasks to configure the app.

Prerequisites

i Note

Depending on your implementation scenario, several of the following prerequisites might already be fulfilled
in your system landscape.

General Prerequisites

® Front-end server: To determine which version of SAP FIORI FRONT-END SERVER you need for this
release, see the Prerequisites section in the Common Installation Guide (for new installations) or the
Common Upgrade Guide (for upgrade scenarios). You can find both guides under https://help.sap.com/
viewer/p/CARAB | <Version> ¥ Installation and Upgrade 3.

e SAP Fiori system landscape: You have set up the landscape as described under https://help.sap.com/
viewer/p/FIORI_IMPLEMENTATION | Version: SAP NW 740 ¥ Installation and Upgrade » Setup of SAP
Fiori System Landscape ¥ Setup of SAP Fiori System Landscape with SAP HANA XS 3.
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For system landscape diagrams of supported scenarios, see https://help.sap.com/viewer/p/SAP_FIORI
| SAP Fiori for SAP Business Suite: Implementation Information ¥ Setup of SAP Fiori System Landscape for

SAP Business Suite with SAP HANA XS 3.

e SAP Fiorilaunchpad: You have set up the launchpad as described under https://help.sap.com/viewer/p/
FIORI_IMPLEMENTATION [B Version: SAP NW 7.40 ¥ Configuration j» Configuration of SAP Fiori
Infrastructure » Setup of SAP Fiori Launchpad 7.

The SAP Fiori launchpad is the access point to apps on desktop or mobile devices. Users can access an
app via its corresponding tile on the launchpad. For more information, see https://help.sap.com/viewer/p/
FIORI_IMPLEMENTATION [ Version: SAP NW 7.40 » Additional Information » SAP Fiori Launchpad 3.

e SAP Fiori launchpad designer: You have set up this administrator tool as described under https://
help.sap.com/viewer/p/SAP_NETWEAVER |+ SAP NetWeaver Platform » <Version> » Application Help »
Ul Technologies in SAP NetWeaver » SAP Fiori Launchpad » Setting up the Launchpad 3 and Using the
Launchpad Designer. In the procedure below, you will later do app-specific configuration settings in the
designer.

e SAP NetWeaver Gateway: You have installed and configured the gateway. In particular, make sure that you
have done the following:

o Performed the general SAP Gateway configuration and activated the central Internet Communication
Framework (ICF) services (SAP Note 1560585%% and Perform General SAP Gateway Configuration
[page 48]).

o Activated SAP Gateway on your front-end server (Activate SAP Gateway [page 49]).

o Activated the common OData services so you can use the SAP Fiori launchpad (Activate Common
OData Services [page 50]).

You can skip the Connect SAP Gateway to Your Back-End System [page 48] step because Analyze Forecast
uses SAP HANA extended application services (SAP HANA XS), classic model.

e SAP Web Dispatcher: You have configured the dispatcher and set up the routing rules for browser requests
as described in section Configure the SAP Web Dispatcher [page 51] here in this guide, and in section
Configuring SAP Web Dispatcher of the Central Implementation Information at http://help.sap.com/
saphelp_hba/helpdata/en/5e/9d0c52bcc19b33e10000000a44538d/content. htm .

For a configuration example, see https://help.sap.com/viewer/p/FIORI_IMPLEMENTATION | Version: SAP
NW 740 » Additional Information  SAP Fiori Launchpad » SAP Fiori Launchpad ¥ Setting Up the
Launchpad ¥ Configuring SAP Web Dispatcher 3.

e Central SAP Fiori Ul component: This component contains the SAPUI5 control library and the SAP Fiori
launchpad. You have configured it as described in Configure Central Ul Component [page 51].

e SAP Jam (optional): You have integrated the SAP Jam collaborative environment as described in the
following:

o Configure SAP Jam (Optional) [page 52]
o https://help.sap.com/viewer/p/FIORI_IMPLEMENTATION | Version: SAP NW 7.40 ¥ Configuration ¥
Configuration of SAP Fiori Infrastructure ¥ Integrating SAP Jam (Optional) 3

Prerequisites Specific to SAP Customer Activity Repository Retail Applications Bundle

e DDF: You have configured the DDF module as described in Configure Demand Data Foundation (Optional)
[page 59].

e UDF: You have configured the UDF module as described in Configure Unified Demand Forecast (Optional)
[page 641].

e SAP HANA content: You have activated all SAP HANA content for SAP Customer Activity Repository, as
described in Activate SAP HANA Content [page 40].
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Note that with this step, you have also activated the SAP HANA content for Analyze Forecast. In SAP HANA

studio, you can find this content under |+ Content j» sap.hba.t.rtl.udf.afc 3.

e ABAP front-end server: You have installed the front-end server as described in the Install ABAP Front-End
Server (Optional) section of this guide.
This installation must include the SAP Gateway, the central SAP Fiori Ul component, and the product-
specific SAP Fiori Ul component.

Procedure

To configure Analyze Forecast, follow these steps:

1. Read the app-specific information on SAP Help Portal for SAP Customer Activity Repository at https:/
help.sap.com/viewer/p/CARAB | Version: 1.0 SPSx » Application Help » SAP Customer Activity
Repository # Additional Content » Standalone SAP Fiori Apps for SAP Customer Activity Repository
Analyze Forecast 3, including all subsections.

2. Configure user access to the SAP HANA data for the app.

i Note

You can find the general SAP Fiori Help section for this step at https://help.sap.com/viewer/p/
FIORI_IMPLEMENTATION [} Version: SAP NW 740 ¥ Implementation » App Implementation ¥ App
Implementation for Analytical Apps # Configuring Access to SAP HANA Data .

Use this section as your starting point. However, to configure Analyze Forecast, you will only need to
perform some of the steps described there. Proceed as follows:

1. Synchronize the SAP HANA database users. Each user requires both a user in the ABAP front-end
server (to enable navigation in the SAP Fiori launchpad) and a database user in SAP HANA (to enable
access to the relevant views).

Follow the steps in [# Configuring Access to SAP HANA Data » Synchronizing SAP HANA Database
Users 3.

2. Assign the app-specific SAP HANA role
sap.hba.t.rtl.udf.afc.roles::AnalyzeForecast.hdbrole to the users of the app. The role
enables them to access the app-specific SAP HANA data to be able to analyze sales and forecast
values.

Follow the steps in | Configuring Access to SAP HANA Data  Assigning Roles for Accessing SAP
HANA Data 3.

3. Create the analytic privileges to give the users read-only access to the SAP HANA views for the app.
You can find these views inthe sap.hba.t.rtl.udf.afc.v folderin SAP HANA studio. Without the
correct analytic privileges, the users only see empty views.

Follow the steps in | Configuring Access to SAP HANA Data @ Creating Analytic Privileges .
For more information about analytic privileges, see https://help.sap.com/viewer/p/
SAP_HANA_PLATFORM | <Version> # Development » SAP HANA Modeling Guide (SAP HANA
Studio) ¥ Defining Data Access Privileges #» Create Classical XML-based Analytic Privileges 3.

3. Customize the navigation target for the app in the SAP Fiori launchpad.
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In Launchpad Customizing (transaction LPD_CUST), choose | UICAROOI TRANSACTIONAL »

AnalyzeForecast 3 and make the following app-specific settings:
Link Text: AnalyzeForecast

e}

[¢]

[¢]

[0}

@]

o

e}

e}

Application Type: URL

URL: /sap/bc/ui5_ui5/sap/analyzfcst v2

Application Alias: AnalyzeForecast

Additional Information: SAPUI5.Component=retail.udf.analyzeforecastv2

Portal Parameters: Leave the default settings.

Switch Support: Leave the default settings.

For more information about navigation targets, see the following:

For SAP NetWeaver 7.31: https://help.sap.com/viewer/p/Ul_ADD-ON_FOR_SAP_NETWEAVER_20

|» <Version> » Application Help » SAP Library » SAP Fiori Launchpad » Configuring Navigation
Configuring Target Mappings ¥ Customizing Navigation Targets in LPD_CUST 1

For SAP NetWeaver 7.4: https://help.sap.com/viewer/p/SAP_NETWEAVER_740 | Application Help
Ul Technologies in SAP NetWeaver with SAP_UI 740 » SAP Fiori Launchpad ¥ Configuring Navigation »
Customizing Navigation Targets J

4. Configure the SAP Fiorilaunchpad designer for Analyze Forecast.

1. Launch the SAP Fiori launchpad designer with one of the following URLSs:

o

In cusT mode:
https://<server>:<port>/sap/bc/ui5_ui5/sap/arsrvc_upb_admn/main.html#/
Catalog/X-SAP-UI2-CATALOGPAGE: SAP_ISR CAR TC A

Use this mode for client-specific configurations, specifying the respective client.

In CONF mode:

https://<server>:<port>/sap/bc/ui5 ui5/sap/arsrvc_upb_admn/main.html ?sap-
client=<client>&scope=<CONF/CUST>#/Catalog/X-SAP-UI2-

CATALOGPAGE:SAP_ISR CAR TC A

Use this mode for global configurations across all clients. In this URL, you additionally specify the
scope parameter.

2. Configure the application tile.
If the tile for Analyze Forecast has not yet been created, create it as a static tile using the following
settings:

o

o

o

o}

o

o

o

Title: Analyze Forecast

Icon: sap-icon://Fiori5/F0812

Use semantic object navigation: Select this option.
Semantic Object: ForecastDemand

Action: showUDFAnalyzeForecast

Parameters: bk-client= <backend client>

Leave the other options empty.

For more information about configuring tiles, see https://help.sap.com/viewer/p/
SAP_NETWEAVER_740 | Application Help j Ul Technologies in SAP NetWeaver  SAP Fiori
Launchpad ¥ Using the Launchpad Designer ¥ Setting Up Catalogs, Tiles and Groups ¥ Catalogs and

Tiles » Configuring Tiles 3.

3. Configure the target mapping.
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If the target mapping has not yet been created, create it using the following settings:
o Semantic Object: ForecastDemand
o Action: showUDFAnalyzeForecast
o Application Type: SAP Fiori App using LPD_CUST
o Launchpad Role: UICAR001
o Launchpad Instance: TRANSACTIONAL
o Application Alias: AnalyzeForecast
o Device Types: Select Desktop and Tablet.
o Allow additional parameters: Select this option.
For more information about configuring target mappings, see https://help.sap.com/viewer/p/
SAP_NETWEAVER_740 |p Application Help j Ul Technologies in SAP NetWeaver » SAP Fiori
Launchpad ¥ Configuring Navigation » Configuring Target Mappings 3.
5. Perform the required implementation tasks on the front-end server.

i Note

You can find the general SAP Fiori Help section for this step at https://help.sap.com/viewer/p/
FIORI_IMPLEMENTATION [ Version: SAP NW 7.40 ¥ Implementation * App Implementation » App
Implementation for Analytical Apps ¥ Implementation Tasks on Front-End Server 3.

Use this section as your starting point. However, to configure Analyze Forecast, you only need to
perform some of the steps described there. Proceed as follows:

1. Check that the app-specific ICF service (/sap/bc/ui5 ui5/sap/analyzfcst v2)is active. Ifitis
not, activate it.

Follow the steps in | Implementation Tasks on Front-End Server ¥ Front-End Server: Activate ICF
Services of SAPUI5 Application .

2. Add the start authorizations for the app-specific OData service
(sap.hba.t.rtl.udf.afc.odata::AnalyzeForecast.xsodata) to therole on the front-end.
The users need the start authorizations for the activated OData service to be able to launch the app.
Follow the steps in | Implementation Tasks on Front-End Server » Add Start Authorizations for OData
Services to Role on Front-End 3.

3. Createthe sap CcAR TCR A PFCG role on the front-end and assign the required launchpad catalogs
and groups. SAP_CAR TCR_As the back-end server authorization role delivered for analytical apps in
SAP Customer Activity Repository.

Follow the steps in | Implementation Tasks on Front-End Server » Create PFCG Role on Front-End and
Assign Launchpad Catalogs and Groups 3.

4. Set up the catalogs, groups, and roles in the SAP Fiori launchpad.

Follow the steps in | Implementation Tasks on Front-End Server ¥ Setup of Catalogs, Groups, and Roles
in the SAP Fiori Launchpad 3.

5. Take the front-end PFCG role that you have created before and assign it to the users of the app. The
role contains the catalogs, groups, and start authorizations for the OData service that the users need.
Follow the steps in | Implementation Tasks on Front-End Server  Front-End Server: Assign Roles to
Users 1.
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Result

You have successfully configured the Analyze Forecast app.

More Information

You can extend the app with custom content. For more information, see https://help.sap.com/viewer/p/
CARAB |» <Version> » Application Help » SAP Customer Activity Repository » Additional Content
Standalone SAP Fiori Apps for SAP Customer Activity Repository » Analyze Forecast ¥ App Extensibility:

Analyze Forecast

4.1.3.12 Configure Omnichannel Article Availability for Use
with SAP Customer Activity Repository (Optional)

You need to integrate SAP Retail, SAP Customer Activity Repository, SAP Hybris Commerce, and SAP Hybris
Commerce, integration package for SAP for Retail, as well as set up asynchronous order management and the
data replication between SAP Retail and SAP Customer Activity Repository.

4.1.3.12.1 Set up Data Replication Between SAP Retail and
SAP Hybris Commerce

In SAP Retail and SAP Hybris Commerce, set up the asynchronous order management scenario as follows:

1. Set up asynchronous replication of articles via the Data Hub from SAP Retail to SAP Hybris Commerce.
For more information, see the documentation for SAP Hybris Commerce at https:/help.hybris.com/
6.0.0/hcd/8bcbh884866910148532f2e1e500f95f.html Getting Started with SAP ERP Integration. Follow
the steps for the asynchronous order management scenario.

2. Set up asynchronous replication of orders via the Data Hub from SAP Hybris Commerce to SAP Retail
(see link above).

3. Configure asynchronous order management.

For more information, see the documentation for SAP Hybris Commerce at https://help.hybris.com/
6.0.0/hcd/8b8ac51b866910148e68c3be8963eb96.html Configuring Asynchronous Order Management.

4.1.3.12.2 Set up Data Replication Between SAP Retail and
SAP Customer Activity Repository

1. In SAP Retail, create an RFC connection between SAP Retail and SAP Customer Activity Repository
(transaction sM59).
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2. In SAP Customer Activity Repository, set up SLT replication from SAP Retail to SAP Customer Activity
Repository (see SAP Note 22632057k ).
For Omnichannel Article Availability, the following tables must be replicated via SLT:

© VBAK

O MARA

© MARM

© TOOLW

© OAA ATP PROFILE

o Tables required for Inventory Visibility view sap.is.retail.car/
InventoryVisibilityWithSalesOrderReservedQuantity

4.1.3.12.3 Set Up Data Replication Between SAP Hybris
Commerce and SAP Customer Activity Repository

1. In SAP Hybris Commerce, in the Backoffice application under |» SAP Integration » HTTP Destination
create the HTTP destination of SAP Customer Activity Repository that is used for ATP calculation and
sourcing.

2. In SAP Hybris Commerce, in the Backoffice application under |» SAP Integration » SAP Global

Configuration » Backend Connectivity ., enter the HTTP destination of SAP Customer Activity Repository
created before.

i Note

In the standard Solr configuration for products in SAP Hybris Commerce, ProductStoreStockValueProvider
is used to replicate the store availability situation from the Hybris database into the Solr index.

If you use omnichannel article availability, availability information is provided through synchronous calls
into SAP Customer Activity Repository for every article/store combination instead. If your product catalog
is rather large, this is why indexing the complete product catalog can take very long. In this case, we
recommend to either deactivate the value provider or to create a custom one. If you deactivate the value
provider, faceted search according to store availability is not possible in the product catalog. OAA
functionality is not affected.

4.1.3.13 Configure Omnichannel Promotion Pricing for Use
with SAP Customer Activity Repository

1. In Customizing for SAP Customer Activity Repository, under |» Omnichannel Promotion Pricing

Configuring Omnichannel Promotion Pricing 4, activate and configure Omnichannel Promotion Pricing.
2. Intransaction SFW5, activate business function MDG_ FOUNDATION.

This activates Data Replication Framework (DRF) functionality. You need DRF to be able to send regular

prices and OPP promotions to an external system via IDocs.

Common Upgrade Guide for SAP Customer Activity Repository retail applications bundle 1.0
SPS7
74 PUBLIC Upgrade Scenarios


http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/2263205

4.1.4 Troubleshooting

Use

This section proposes possible solutions to issues that may occur when you install and implement your SAP
Customer Activity Repository solution. It also provides guidance on how to improve the system configuration

for specific use cases. If you need to report a customer incident, see the information in the final section.

Areas

Issues

Explanations

Possible Solutions

Installation

You want to download a revi-
sion of the UDF AFL to install
or upgrade Unified Demand
Forecast functionality.

® You need the exact download
path on the SAP Support
Portal.

® You want to know what's new
in arevision.

e SAP Note 2050229
e SAP Note 2331410#%

You get an error indicating
that the UDF AFL is not com-
patible.

You are trying to install incompat-
ible releases (“revisions™) of the
UDF AFL and the SAP HANA da-
tabase.

SAP Note 2050229 Fr

You want to download a revi-
sion of the POS AFL to install
or upgrade On-Shelf Availa-
bility functionality.

® You need the exact download
path on the SAP Support
Portal.

® You want to know what's new
in arevision.

SAP Note 2056102#

You get an error indicating
that the POS AFL is not com-
patible.

You are trying to install incompat-
ible releases (“revisions™) of the
POS AFL and the SAP HANA da-
tabase.

SAP Note 2056102

You want to install or upgrade
application function libraries
(AFLs) and are experiencing
issues with the SAP HANA
Lifecycle Management tool
(hdblcmor hdblcmgui).

You need information on possible
causes and solutions.

e SAP Note 2078425
e SAP Note 2082466 #

You get syntax errors when
installing the CAR RETAIL
APPL BUNDLE back-end

product version.

You need guidance on whether to
take action. The answer depends
on your implementation scenario.

SAP Note 2089829 ¢k
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Areas Issues

Explanations

Possible Solutions

You get the error SAP DBTech  You are using SAP HANA AFL 1.0 SAP Note 2022080
JDBC: [258]: insufficient and have performed an upgrade
privilege: Not authorized. of your SAP HANA Platform. Pre-
viously assigned privileges might
have been lost during the up-
grade.
In an upgrade or when imple- Anissue in the SAP HANA con- SAP Note 2298340#%
menting a transport, you get  tent must be fixed.
one of the following errors:
e Retcode 512: SQL-error
"259-invalid table name:
Could not find table/view
e Retcode 512: SQL-error
"328-invalid name of
function or procedure
SAP HANA content ® Youcannotrun Different causes are possible. SAP Note 2330386
the /car/
ACTIVATE HANA CONT
ENT activation report.
e Oryoucanrunthere-
port but the SAP HANA
content is not activated
correctly.
You get an error that a You might have a circular de- SAP Note 2404872 %

SQLScript procedure (such
as
SP_SR_GET PROD HR XR B
Y DATE) cannot be activated.

pendency issue.

You want to check the de-
pendencies of a specific view.

You might need this information
to solve a dependency or activa-
tion issue.

e |n SAP HANA studio: Select
the view and choose Auto
Documentation from the
context menu. This gener-
ates a file with detailed infor-
mation on the view. Consult
the Cross References sec-
tion.

e |fyou are using the SAP
HANA Live View Browser
app: Select the view and
choose Cross References.
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Areas Issues Explanations Possible Solutions

You get an error indicating You have not installed the UDF Follow the steps under Download
that you are attempting to AFL. and Install the Application Func-
access inactive or invalid SAP tion Libraries (AFLs) in this guide.
HANA content.
You have not installed the POS Follow the steps under Download
AFL. and Install the Application Func-

tion Libraries (AFLs) in this guide.

You are trying to activate the SAP  Follow the steps under Activate
HANA content using the wrong SAP HANA Content [page 40].

SAP Note.
You get the error Table A program error must be fixed. e SAP Note 2218875
ABAP:/DMF_ORG_ASSIGN e SAP Note 2224582
not found.
You get the error Object A program error must be fixed. SAP Note 2224582 i

DDF_ORG_ASSIGN
(Calculation View), package
sap.is.ddf.udf.data_validation,
was processed with errors.

You get the error SQLScript: A program error must be fixed. SAP Note 2125672 i
Could not derive table type for
variable "UDF_FC_HORIZON".

When you run the SAP HANA A program error must be fixed. SAP Note 2120372
content activation re-

port /CAR/

ACTIVATE HANA CONTENT,

the activation of delivery unit

HCO DDF UDF fails on SAP

HANA Platform SPS 09.

SAP HANA view A program error must be fixed. SAP Note 2203930 #&
sap.is.ddf. fms does not

activate properly.
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Areas Issues

Explanations

Possible Solutions

Customizing (trans-  You cannot see the Customiz-

action SPRO) ing activities for Unified De-
mand Forecast (UDF) in the
SAP Customizing

Implementation Guide.

Either the activities are not
displayed at all or you see dif-
ferent activities. When you
try to display the correct ac-
tivities by activating business
functions in the Switch
Framework (transaction
SFW5), you get an error.

You might not have activated all
required business functions for
UDF.

Activate Business Functions for
DDF and UDF [page 60]

You cannot see the Define
Historical Inventory
Information Customizing ac-

tivity under|} Cross-
application Components >
Demand Data Foundation >
Data Maintenance >

Inventory }

A program error must be fixed.

SAP Note 2399733 #te

Hierarchies You are getting errors when
creating location hierarchies

and/or product hierarchies.

The system does not generate
the flat structures for the hierar-
chies. You need to do some con-
figuration steps so that the hier-
archies get flattened automati-
cally.

e Follow the steps under Con-
figure Automatic Flattening
of Hierarchies in this guide.

e See the configuration infor-
mation for DDF in SAP Solu-
tion Manager under
|} Solutions/Applications >
SAP for Retail ¥ Scenarios

Customer Activity Repository

% Business Processes #
Enabling Demand Data
Foundation and Creating

Demand Forecast > Tab:
Configuration ¥ Configuring
Demand Data Foundation 3.

You get errors when import-
ing article hierarchies from
your master data system
(such as SAP ERP).

A program error must be fixed.

e SAP Note 2244521 #
e SAP Note 2245134/
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Areas

Issues

Explanations

Possible Solutions

You want to know which loca-
tions are included in each
version of an offer.

You can implement an easy en-
hancement for table /DMF/
OFR_LG_LOC.

SAP Note 2208619¢

An SQL error must be fixed. Use the system log (transaction
SM21) to find the underlying SQL

exception:

Modeling and fore-
casting

You get the error 905
Structured Query Language
(SQL) exception detected:

41828384, e To help find the correct log

entries, specify the user and
the approximate time frame.

® |ook for entries with the
same error as in this mes-
sage.

e Note that the log may span
several lines. This is indi-
cated by a red priority icon
and an initial “>".

e Attempt to determine the
root cause and a corrective
action based on the mes-
sage texts of the applicable
log entries.

® Seethe message long texts
(transaction SE91).

e SAP Note 18983417t

You get the errors 901 Failed
execution for &1 and 926

You most likely have a data issue,
such as:

Failed decomposition. ® The load balancing settings

are not correct.
® Orthere are no active prod-
uct locations.

You get the errors 901 Failed
execution for &1 and 905

You most likely have an SQL error. See the message long texts
(transaction SE91).

Structured Query Language

(SQL) exception: &1&2&3&4

and 926 Failed

decomposition.

You get the error Could not The privileges for calling applica-  SAP Note 1846194 #r
execute 'call _SYS_AFL... or tion function libraries (such as
the error Repository: Internal  the UDF AFL) are not assigned
error during statement correctly or are incomplete.
execution....
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Areas

Issues Explanations

Possible Solutions

An SAP HANA version check
might be out of sync.

You get one of the following
errors during modeling or
forecasting:

® 1341 Procedure versions
validation failed:
Procedure version is not
matched with given
version number #

® 134] Procedure versions
validation failed: Version
validation is not enabled
for this procedure

® Try running the failed model-
ing or forecasting process
again several times. This al-
lows the SAP HANA version
management to synchronize
the versions. If the error oc-
curred during modeling, also
run forecasting again.

e SAP Note 1972414 #% (for
development experts)

You want to forecast complex You must set up a specific task SAP Note 2176058 P
offers (such as Buy X Get Y).  decomposition for the production
forecast in Unified Demand Fore-
cast (UDF).
You are using the Update You can enhance the perform- SAP Note 2080423 P
Sales Projection function in ance by implementing an SAP
SAP Assortment Planning for Note.
Retail (workbooks Product
Planning and Size Planning).
You are experiencing per-
formance issues when using
the function with large data
volumes.
You are running demand A program error must be fixed. SAP Note 2106332 %%

modeling and get the follow-
ing errors:

® nternal errors in demand
modeling and forecasting
or the database (/DMF /
UDF_TECHNICAL 000)

® |nternal error for product
&1 in modeling and
forecasting: (observation
>=0.0) is false (/DMF/
UDF_TECHNICAL 001)
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Areas Issues

Explanations

Possible Solutions

You are experiencing issues
during inbound processing; in
particular, you cannot trans-

fer import data from the stag-

ing tables to the production
tables.

A program error must be fixed.

SAP Note 2356844

You have deleted a vendor
from the /DMF/D_VENDOR ta-

DRF data replication
framework (transac-
tion DRFOUT) ble but this deletion is not re-
plicated to the master data

system.

A program error must be fixed.

SAP Note 18721364

You get an error when using
the DRF with the pMPL SAP
ERP outbound implementa-
tion.

A program error must be fixed.

e SAP Note 1904782

e SAP Note 2167629#%

e Application help for SAP
Customer Activity Reposi-
tory at http://
help.sap.com/car P
|} <your release> >
Application Help ¥ Demand
Data Foundation >

Integration Information >
Master Data Replication from
SAP ERP to Demand Data

Foundation 4.

You get the error Product &1,
location &2: The Valid From
time for &3 must be
00:00:00 (message 364 in
message class /DMF/
MSG_HL).

A program error must be fixed.

SAP Note 2163602 #r

You have changed the listing
information in your master
data system and replicated

the changes to your SAP Cus-

tomer Activity Repository
system. However, the listing
information there is not up-
dated correctly.

A program error must be fixed.

SAP Note 1932525 #
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Areas

Issues

Explanations

Possible Solutions

Performance

You are experiencing per-
formance issues in your SAP
HANA database.

You need information on how to
troubleshoot and resolve those
issues and how to enhance per-
formance in general.

See the SAP HANA Troubleshoot-
ing and Performance Analysis
Guide under http://
help.sap.com/hana_platform

| <your SAP HANA SPS>
System Administration ]

You get a runtime error or exit
message and need informa-
tion about possible causes
and solutions.

Different causes are possible.

Use the ABAP dump analysis
(transaction ST22) to search for
short dumps and call up detailed
error information.

Remote Function
Calls (RFCs), func-
tion modules

You are experiencing work-
flow issues when executing
an RFC function module.

Different causes are possible.

SAP Note 1098805 (detailed
troubleshooting information for
different causes, tips & tricks)

SAP Fiori

You cannot open the Analyze
Forecast app in your SAP Fiori
launchpad.

The back-end reuse library might

not be loading correctly.

You can do the following in the
back-end system:

1. Intransaction SICF, search
for the /sap/bc/
ui5 uib5/sap/
ddfreuse v2 service and
check that it is active.

2. Ifthe service is active, you
can try to reset the SAP Fiori
cache:

In transaction SE38, exe-
cute the following re-

ports: /UI5/

APP_INDEX CALCULATE
and /uI2/

INVALIDATE GLOBAL_ CACH
Esand /UI2/

INVALIDATE CLIENT CACH
ES.

3. Clear your browser cache
and check whether you can
now open the app.

SAP HANA Platform You are using a revision under The error is caused by more se-

SAP HANA Platform SPS 10
and get an error relating to
the SAP HANA planning en-
gine or exception
CX_RSR_PE_ERROR.

vere checks that were introduced
with SAP HANA Platform SPS 10.

SAP Note 2285769
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Areas Issues Explanations Possible Solutions

You get errors in row store ta- A program error must be fixed. SAP Note 2370160#k
bles with SAP HANA data-
base revision 122.02.

Report a Customer Incident

e |f you encounter an issue with your system, we recommend that you first search the SAP Knowledge Base
and SAP Notes for existing solutions. For more information, see http://support.sap.com/#& [ My Support
» Knowledge Base 3.

e To view or report an incident, see http:/support.sap.com/#& |+ My Support ¥ Incidents 3.
When reporting a new incident, you must specify an application component. You can find the list of
components on the SAP Support Portal at http:/support.sap.com/ # | Download Software » By
Alphabetical Index (A-Z)  C » CAR RETAIL APPLICATIONS BUNDLE » CAR RETAIL APPL BUNDLE 1.0 »

Info .
For more information on reporting incidents for SAP Customer Activity Repository, see the Support Desk
Management section of the SAP Customer Activity Repository Operations Guide under https://

help.sap.com/viewer/p/CARAB | <Version> » Operations 3.

4.2 SAP Assortment Planning for Retail
4.2.1 Preparation

i Note

Some of the activities in this section may have already been performed in the corresponding section under
SAP Customer Activity Repository. Such activities do not need to be repeated during the setup and
installation of consuming applications.

4211 Verify SAP HANA Users and Privileges

Use

The SAP Assortment Planning for Retail application requires a layered system landscape. As an assortment
planner or planning administrator, you must assign the necessary users, roles and authorizations in all of the
levels of the SAP Assortment Planning for Retail application.
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SAP NetWeaver Gateway (Front-End Server)

IUser, roles, groups, and catalogs required to use the collection of SAP Fiori apps that form
the SAP Assortment Planning for Retail application userinterface.

ABAP Back-End Server

User and roles to access the relevant Customizing activities and use core SAP Assortment
Planning for Retail application functionality.

— T
— I

SAP HANA Database

IUsers and privileges allowing the SAP Assortment Planning for Retail application to access
SAP HAMA views and procedures, which provide access to data and functionality directly
on the database level,

\ //

Authorization Levels

This procedure lists the required database users and privileges shown as level 1 in the diagram above. These
are roles and privileges that you can set up in the database before installing SAP Assortment for Retail on the
back-end or front-end systems.

Back-end, level 2 authorizations, are described in the Verify Users, Privileges, and Roles section of the Common
Installation Guide. Front-end, level 3 authorizations, are described in the Assign Roles, Catalogs, and Groups in
SAP Fiori Launchpad section of the Common Installation Guide.

Procedure

1. Ensure that the SAP HANA database users listed below exist and that they have the required roles/
privileges.
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User Role/Privilege

SAP<SID> o System privilege REPO. IMPORT

o ) o System privilege ROLE ADMIN
This is the generic database user

specified for the connection from the o System privilege STRUCTUREDPRIVILEGE ADMIN
SAP NetWeaver back-end serverto ~ ©  Role CONTENT_ADMIN

the SAP HANA database. © Role AFLPM CREATOR ERASER EXECUTE. For more information, see Ena-
ble Usage of PAL Functions [page 86] and SAP Note 2046767 Fr .

© RoleAFL SYS AFL OFL AREA EXECUTE

SYS REPO o Privilege SELECT, with option "Grantable to others", on the following physi-
- cal DB schemas:
o Physical database schema of your back-end system, typically this is
called sApP<SID>
o Physical database schema that contains the SAP ERP tables
o Physical database schema that contains the SAP CRM tables
You can use the following example SQL statement to grant the required
privilege:
GRANT SELECT ON SCHEMA <Your schema name> TO
_SYS REPO WITH GRANT OPTION;

o Privileges described in http://help.sap.com/carl'hrlb <your release> >
Security Information » Security Guide # Authorization Requirements for

the UDF AFL 4.

<Your User Name>* o Privilege SELECT on schema SYs BI

o Privilege SELECT on schema SAP<SID>

o Privilege EXECUTE on procedure REPOSITORY REST

*Your user on SAP HANA database level, back-end system, and on the front-end server (SAP NetWeaver Gateway)
must be identical on these three levels.

4.2.1.2 Configure AFL Usage
42121 Activate SAP HANA Script Server

Use

Once all the required AFLs are installed, as listed in the Prerequisites section, ensure that you have activated
the script server for the SAP HANA database.
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Procedure

Read and implement SAP Note 1650957 #r.

42122 Enable Usage of PAL Functions

Use

The installation of SAP HANA Platform includes the installation of SAP HANA AFL 1.0, which contains the
PAL algorithm, a prerequisite to the installation of SAP Assortment Planning for Retail.

To enable the usage of the PAL algorithm as required by SAP Assortment Planning for Retail, perform the
following procedure.

Procedure

1. Ensure that the SAP<SID> user has the role AFLPM CREATOR ERASER EXECUTE as described in Verify
SAP HANA User and Privileges [page 83] and SAP Note 2046767 #r.
This role must be assigned to execute functions of the PAL library. In the case of SAP Assortment Planning
for Retail, this role is necessary for the assortment planner to use smart clustering in the Manage Location

Clusters SAP Fiori app.
You do not need to create the AFL._WRAPPER GENERATOR Or AFL_WRAPPER ERASER procedures, nor do

you need to generate any special PAL procedures. This is automatically done by SAP Assortment Planning
for Retail.
2. To confirm that the PAL functions were installed successfully, you can run SELECT statements in the three
relevant public views as follows:
© SELECT * FROM SYS.AFL AREAS WHERE AREA NAME = 'AFLPAL'
© SELECT * FROM SYS.AFL PACKAGES WHERE AREA NAME = 'AFLPAL'
© SELECT * FROM SYS.AFL FUNCTIONS WHERE AREA NAME = 'AFLPAL'

More Information

® Prerequisites section
e http:/help.sap.com/hana_platformete| References » SAP HANA Predictive Analysis Library (PAL)

Reference J
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4.21.2.3 Check the OFL Installation

Use

The installation of SAP HANA Platform includes the installation of SAP HANA AFL 1.0, which contains the OFL
algorithm, a prerequisite to the installation of SAP Assortment Planning for Retail.

Procedure

1. To confirm that the OFL was installed successfully, you can run SELECT statements in the three relevant
public views as follows:
O SELECT * FROM SYS.AFL AREAS WHERE AREA NAME = 'OFL_AREA'
O SELECT * FROM SYS.AFL PACKAGES WHERE AREA NAME = 'OFL_AREA'
© SELECT * FROM SYS.AFL FUNCTIONS WHERE AREA NAME = 'OFL _AREA'
In the case of a successful installation, each of statements should return 1 row.

More Information

Prerequisites section

4.2.2 1.0 SP4 to 1.0 SP5

Upgrade information.

This section is intended for existing SAP Assortment Planning for Retail customers who have installed and
configured SAP Assortment Planning for Retail 1.0 SP4 and would like to upgrade to SAP Assortment Planning
for Retail 1.0 SP5.

4221 Quick Guide

SAP Assortment Planning for Retail 1.0 SP4 to 1.0 SP5 upgrade checklist.

Checklist

Prerequisites
Mandatory Steps
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[ Ensure that you have implemented the necessary SAP Notes listed in the SAP Notes for the Upgrade
section.

[J Ensure that your landscape meets the requirements outlined in the Prerequisites section.
Preparation
Mandatory Steps

[ Verify that you have all of the required SAP HANA users and privileges. See Verify SAP HANA Users and
Privileges [page 83].

[J Configure AFL and OFL usage. See Enable Usage of PAL Functions [page 86] and Check the OFL
Installation [page 87].

Upgrade Process

Mandatory Steps

1 Upgrade your back-end system product version in SAP Solution Manager.

L1 Upgrade the application function libraries (UDFAFL INST 100, POSAFL INST 100).
Follow-Up Activities
Mandatory Steps

O Create SAP ERP tables.

] Verify SAP HANA and back-end system roles. See the Verify Users, Privileges, and Roles section in the
Common Installation Guide.

Reactivate SAP Assortment Planning for Retail planning framework content.
Maintain Customizing table /RAP/RS_VARCUST.

Update fiscal year entries.

Optionally, restore language settings in workbooks.

Verify that data replication is running following the upgrade.

Oo0oo0oogoao

Run the validation report.

4.2.2.2 Upgrade Process

42.2.21 Upgrade SAP Customer Activity Repository Retail
Applications Bundle

Use

This procedure describes how to upgrade the CAR RETAIL APPL BUNDLE 1.0 back-end product version
from an older support package stack to a newer one.
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Procedure

1. Check your upgrade scenario:
1. Navigate to the Product Availability Matrix (PAM) at http:/support.sap.com/pam#te .

2. Forinformation about the available support package stacks (SPS), search for the CAR RETAIL APPL
BUNDLE 1.0 product version, and choose Support Package Stacks.

3. Forinformation about the supported upgrade paths, choose Related Product Versions.

4. For information about the software components in the SPS, choose Technical Release Information and
consult the subsections, such as Database Systems.

5. To navigate directly to the download area for the SPS, choose [ SAP Software Download Center » CAR

RETAIL APPL BUNDLE 1.0 - Support Packages & Patches 3.
Alternatively, you can get there from the SAP Support Portal by choosing http://support.sap.com/

swdc# | Support Packages and Patches » Software Downloads j SUPPORT PACKAGES & PATCHES »
By Alphabetical Index (A-Z) » C » CAR RETAIL APPLICATIONS BUNDLE » CAR RETAIL APPL BUNDLE
103
2. Patch the support package stack using the Support Package Manager tool (transaction spaMm).
For more information about this tool, see SAP Help Portal at http://help.sap.com/spmanager

| Application Help 3, as well as SAP Note 18039867 .

To finalize the upgrade of the back-end product version, you must additionally do some manual steps. Continue
with the next section.

Download and Install the Application Function Libraries (AFLs)

There are two components that you cannot upgrade using Support Package Manager.

e Unified Demand Forecast application function library (UDF AFL, software component version
UDFAFL_INST 100, provides the demand modeling and forecasting services in SAP Customer Activity
Repository, runs directly in the SAP HANA database)

e On-Shelf Availability application function library (POS AFL, software component version POSAFL_INST
100, provides the On-Shelf Availability services in SAP Customer Activity Repository, runs directly in the
SAP HANA database)

You need to download one UDF AFL revision and one POS AFL revision manually and install them together in
your SAP HANA database.

Where to Download

Both AFLs are provided as part of the CAR RETAIL APPL BUNDLE 1.0 product version onthe SAP Support
Portal under http://support.sap.com/swdc#|» Support Packages and Patches j» Software Downloads »
SUPPORT PACKAGES & PATCHES ¥ By Alphabetical Index (A-Z) » C » CAR RETAIL APPLICATIONS BUNDLE ¥
CAR RETAIL APPL BUNDLE 1.0 }» Entry by Component » Analytics AFL 3.

For a successful upgrade, you need to be aware of the following dependencies.
Dependencies Between the AFLs and the SAP HANA Database

The AFLs are released independently of the releases of SAP Customer Activity Repository retail applications
bundle. This is because the AFLs follow the release cycle of the SAP HANA database. The releases are called
“revisions”. Whenever a new revision of the SAP HANA database is released, a new revision of each AFL is

released. As a result, multiple revisions of each AFL are available on the SAP Support Portal at any one time.
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A Caution

For each revision of an AFL, there is only one compatible revision of the SAP HANA database. For example,
you can only use revision 112.20 of the UDF AFL with revision 112.02 of the SAP HANA database. Whenever
you upgrade an AFL, you must also upgrade the database and any other AFLs to the compatible revisions.
Reversely, whenever you upgrade the database, you must upgrade the AFLs.

Note that this dependency applies not only to the UDF AFL and the POS AFL but also to the generic SAP
HANA AFL. Both the SAP HANA AFL and the SAP HANA database are components of the SAP HANA
Platform (see Prerequisites [page 16]).

When you download an AFL revision from the SAP Support Portal, the compatible revision of the SAP
HANA database is indicated.

Nomenclature

The following table explains how you can see the dependencies by looking at the release numbers:

Release of ... Released as ... Example Guideline

SAP HANA Platform <Support Package Stack> SAP HANA Platform SPS11 ~ The number of the support
package stack determines
the first digits of the revi-
sions.

SAP HANA Database <Revision>.<Patch> SAP HANA Database 112.02  All 11x.xx database revisions

belong to the SPS 11 plat-
form stack.

The patch number deter-
mines the first digit of the
AFL patch.

UDF AFL

POS AFL

SAP HANA AFL

<Revision>.<Patch>

UDF AFL112. 20

POS AFL112. 20

SAP HANA AFL 112. 20

- Recommendation

We recommend that you upgrade all the AFLs at the same time. This means:

e UDF AFL and POS AFL, which you must both install for a successful upgrade of SAP Customer Activity
Repository retail applications bundle

e SAP HANA AFL, which is one of the mandatory prerequisites

e ifapplicable, other AFLs provided with SAP HANA that might be relevant for your scenario

Focus on the AFL that provides the most important functionality for your scenario (for example, demand
forecasting with the UDF AFL). Select the best revision of that AFL for your scenario. This in turn will give
you the compatible revision of the SAP HANA database and the compatible revisions of the other AFLs.

Then install all the AFLs together.

Download and Install the UDF AFL (Focus: Demand Forecasting)

920 PUBLIC
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1. Select an AFL revision.
Multiple revisions are available on the SAP Support Portal. For guidance on selecting the best revision for
your Unified Demand Forecast scenario, see the following:

o Prerequisites [page 16]: Indicates the minimum revision of the AFL and the SAP HANA Platform for
this release.

o SAP Note 2088924 : Release Information Note (RIN) for SAP Customer Activity Repository retail
applications bundle 1.0.

o SAP Note 2050229#% : Gives you an overview of all UDF AFL revisions as of revision 82 and provides
instructions for downloading, installing, and upgrading the UDF AFL.
o  SAP-HANA-related information:

o Release and maintenance strategy of the SAP HANA Platform at http://support.sap.com/swdc#
| Support Packages and Patches # Software Downloads » SUPPORT PACKAGES & PATCHES ¥ By
Alphabetical Index (A-Z) » H » SAP HANA Platform Edition ¥ Info J

o SAP Note 2021789#% : SAP HANA Revision and Maintenance Strategy

o SAP Note 2227464 : SAP HANA Platform SPS 11 Release Note

o SAP Note 1948334 #%: SAP HANA Database Update Paths for Maintenance Revisions

o SAP Note 1914052#: Dependencies between SAP NetWeaver and the SAP HANA Database

2. Download and install your AFL revision (together with the other AFLs) as described in SAP Note 2050229
.

i Note

To use the UDF functionality in your implementation scenario, you must additionally do some post-
installation steps. For more information, see Configure Unified Demand Forecast (Optional) [page 64].

Download and Install the POS AFL (Focus: On-Shelf Availability)

1. Select an AFL revision.
Multiple revisions are available on the SAP Support Portal. For guidance on selecting the best revision for
your On-Shelf Availability scenario, see the following:

o Prerequisites [page 16]: Indicates the minimum revision of the AFL and the SAP HANA Platform for
this release.

o SAP Note 2088924 #% : Release Information Note (RIN) for SAP Customer Activity Repository retail
applications bundle 1.0.

o SAP Note 2056102#% : Gives you an overview of all POS AFL revisions as of revision 82 and provides
instructions for downloading, installing, and upgrading the POS AFL.
o SAP-HANA-related information:

o Release and maintenance strategy of the SAP HANA Platform at http:/support.sap.com/swdc#
| Support Packages and Patches ¥ Software Downloads » SUPPORT PACKAGES & PATCHES ¥ By
Alphabetical Index (A-Z) » H » SAP HANA Platform Edition j Info 3

o SAP Note 2021789#% : SAP HANA Revision and Maintenance Strategy

o SAP Note 2227464#% : SAP HANA Platform SPS 11 Release Note

o SAP Note 1948334 #%: SAP HANA Database Update Paths for Maintenance Revisions

o SAP Note 1914052#% : Dependencies between SAP NetWeaver and the SAP HANA Database

2. Download and install your AFL revision (together with the other AFLs) as described in SAP Note 2056102
i
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i Note

To use the On-Shelf Availability functionality in your implementation scenario, you must additionally do
some post-installation steps. For more information, see Configure On-Shelf Availability (Optional) [page
53].

Result

You have successfully upgraded the CAR RETAIL APPL BUNDLE 1.0 back-end product version to the current
SPS. Continue with the next section.

4.2.2.3 Follow-Up Activities
4.2.2.31 Create SAP ERP Tables

A Caution

Following an upgrade, it is important to remember to create any additional tables required by the new
release.

Tables required to be created as of the SAP Assortment Planning for Retail are listed in SAP Note 2263205#% .
Ensure that all tables listed in this note have been created.

42232 Reactivate SAP Assortment Planning for Retail
Planning Framework Content

4.2.2.3.2.1 Activate SAP HANA Content

Use

In this procedure, you activate all SAP HANA content required by SAP Customer Activity Repository.

For more information about activating SAP HANA content, see SAP Help Portal at http://help.sap.com/
hana_platform# |- <your SAP HANA Platform SPS> ¥ Development and Modeling » SAP HANA Developer
Guide (For SAP HANA Studio) » Setting Up the Analytic Model » Creating Views # Activating Objects
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Prerequisites

e Asamandatory prerequisite for a successful activation of the SAP HANA content for SAP Customer
Activity Repository, you must have successfully completed all of the procedures listed in the previous
sections of this guide.

e You must also set up the roles and privileges for the Unified Demand Foreast module as described in the
Authorization Requirements for the UDF AFL section of the SAP Customer Activity Repository Security

Guide, available at http:/help.sap.com/car]l <your release> ¥ Security Information 3.

You must do this regardless of whether you want to use UDF forecasting in your scenario or not. This
procedure not only enables UDF, but it is required so that the SAP HANA content for SAP Customer
Activity Repository can be activated correctly.

Procedure

To activate the SAP HANA content, carefully follow the instructions provided in SAP Note 2330386 .

A\ Caution

If you are applying a support package or correction on an existing installation and this support package or
correction involves SAP HANA content for the DDF module or the UDF module in SAP Customer Activity
Repository, then you must manually activate this content again. For example, this is the case when you
apply an SAP Note using transaction SNOTE.

Follow the instructions in SAP Note 2145356 #% .

More Information

If you encounter issues during the activation, see the Troubleshooting [page 75] section for possible solutions.

4.2.2.3.2.2 Activate SAP HANA Content for SAP Assortment
Planning for Retail - Part 1

Use

In this procedure, you perform the initial activation of SAP HANA content (views and stored procedures)
required by the SAP Assortment Planning for Retail application.

A\ Caution

This initial activation results in a partial activation of the SAP HANA content for SAP Assortment Planning
for Retail. Several SAP HANA views depend on local Bl Content objects, and as such, have to be activated
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following the activation of these Bl Content objects. For more information, see Activate SAP HANA Content
for SAP Assortment Planning for Retail - Part 2 [page 102].

Prerequisites

As a mandatory prerequisite for a successful activation of SAP HANA content for SAP Assortment Planning for
Retail, you must have successfully completed all of the procedures listed in the previous sections of this guide.
In particular, you must have activated SAP HANA content for SAP Customer Activity Repository.

Procedure

1. Ensurethatthe sys REPO user has the authorizations required to successfully activate SAP HANA
content.

1. Provideuser sys REPO with object privilege SELECT, with option "Grantable to others”, on the
following physical DB schemas:
o Physical database schema of your back-end system, typically this is called SAP<SID>.
o Physical database schema that contains the SAP ERP tables
You can use the following example SQL statement to grant the required privilege:
GRANT SELECT ON <Your schema name> TO _SYS REPO WITH GRANT OPTION;
2. Assign the required privileges described in section Authorization Requirements for the UDF AFL, of the
SAP Customer Activity Repository Security Guide.
2. Use transaction SE38 to run program /RAP/ACTIVATE HANA CONTENT.

The program activates a majority of the SAP HANA content (views and stored procedures) required by SAP
Assortment Planning for Retail.

Log on to SAP HANA studio.

Open the Modeler and use the Navigator to access your back-end system.
Expand the Content folder located under your system name in the Navigator.
Expand the package listed below:

o ook~ w

O sap.is.retail.rap

You will notice that some of the content in the underlying folders is not deployed. The figure below provides
an example of content that has not been deployed.
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“ g rap
a & ap
a4 B plan
a i Calculabion Migve (3]

«1d BW_DS02.calculationview
si@ BW_DS03_OPT_PLN_PRD_COUNT calculationview
;:? BW_RC0L.calculationview
.ig BW_RC0S_OPT_PLN_SALES_KPLcaleulationview
+'@ RETAIL_PURCHASE_PLAN_INTERFACE.calculationview
4 [ Atribute Wiews (1)

T AP_PLN_HDR.attribubeview
4 = Calculation Views (50
L3 ANMUAL_SEASONS. calculationview
1 ASSORTMEMT_LIST_LOCATIONS HIER. calculationview
:':] ASSORTMENT_LIST_PRODUCTS_HIER.calculationview
'J ASSORTMENT_LIST_PRODUCTS_NO_COLOR.calculationview
/2] ASSORTMENT_LIST_PROD_LOC calculationview
I3 ASSORTMENT_LIST_PROD_LOCS_NOKPLcalculationview
7| ASSORTMENT LIST_SALES_HISTORY.calculationview
{1 ASSORTMENT_PLAN_HDR.calculstiomview
'J ASSORTMENT_PLAN_MERCH_TC_OTB.calculationview
{2} ASSORTMENT PLAN MODE.calculationview
< ASSORTMENT_PLAN_SALES_HISTORY_BW.calculationview
L ASSORTMEMT_PLAN_SALES HISTORY VERSIONS. calculationview
s ASSORTMENT PLAM WEDGE VARIANTS. calculationview
.3 CLUSTER.calculationview

il CLUSTERSET.calculationview

13 CLUSTER_LOCATIOM.calculationview

.'J DISTRIBUTIOM_CHAMMEL.calculationview

<2 MASTER_ASSORTMENTS_TO_BE_DELETED.calculationview
4 = Procedures (&)

kA TE PA AMLA I re

f GET_AP_PLAN_HEADER.procedure |

L& GET_MERCH_PLAN_DATA.procedure

(€ GET_PROD_LIST_KPLBY_NODE_ID.procedure
[ k= PROJECT Chbjects (1)

Example of SAP HANA content not deployed

A small number of views not deploying is an expected result of this procedure, and the remaining content
will be deployed in the Activate SAP HANA Content for SAP Assortment Planning for Retail - Part 2 [page
102] procedure.

O\ Caution

If you see that none of the views/procedures inthe sap.is.retail.rap package are deployed, you
can resolve this by manually selecting, right-clicking, and choosing to Redeploy each of the sub-folders.
This manual redeployment should leave only the views/procedures highlighted above as not deployed.

More Information

Section Activating Objects, of the SAP HANA Developer Guide SAP
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4.2.2.3.2.3 Activate Application Bl Content

Use

In this procedures, you perform a sequential, step-by-step activation of the local Bl Content objects following
the upgrade to SAP Assortment Planning for Retail 1.0 FP3.

i Note

To ensure correct activation of the local Bl Content objects, carry out the activation sequentially, as
specified in the following procedures.

Also, the default Bl setting to collect and activate all dependencies must not be disabled by the user. The
instructions below activate a minimum subset of objects, and it assumed that all their dependencies will be
collected and activated.

Procedure

1. Onyour back-end SAP Assortment Planning for Retail system, open the Data Warehousing Workbench
(transaction RSA1).
2. Verify transport connections.
1. Select Transport Connection in the left-hand frame.
2. Select Object Types.
3. Expand Source System.
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Data Warehousing Workbench: Transport Connection

Switch (Business Functions)

O T2 Tacollected O Doeete &£ Lcro [E Econverson | Gaeex  Ehobject Changeabilty
[tiodaig ]
[ Adminstration || a1 objects Accordng to Type
| Transport Connection ]l » 4% InfoArea -
L » @ Appication -
- €3 54P Transport : g :ioﬁm Catalog

- @ InfoProviders by InfoAreas
. & InfoObjects by InfoAreas

* 95 BEx Web Template
» [1# BEx Web Irem
v [E) crystal Report
» @3 Xcelsius Dashboard

- @mnf es by Application C:
« @ Roles
- [ Object Types
1] ransport Heque
- (@ Packages
* B ML
=~ [ Export

+ @ InfoProviders by InfoAreas

» & InfoObjects by InfoAreas

« & InfoSources by Appication Component
- @ Roles

+ (1 Object Typas

+ B Transport Request

* @ Packages

» [ Enterprise Report

v E Workbook

+ [ Query view

v [H Query Elements

* & Broadeast Setting

» % CompositeProvider

+ [ Open 0DS View

* 2 SAP HAMA Analysis Process

v G MuttiProvider

+ B8 Infoset

v & HybridProvider

» [ semantically Partitioned Object
» €9 InfoCube

» @ Datastore Object (Advanced)
+ [ infoobject

v P Transformation

* "% Open Hub Destination

+ BB Data Flow

» [8) infopackage

» &) Data Transfer Process

v @3 process Chain

» [ Processes -

» 3 Panning -

Selecting Source Systems

(@ (s Grouping .|| ][2 Package [ Collection Mode [

Displat *

Collected objects

Use Select Objects to ensure that the back-end system is selected as the source system.

Choose Transfer Selections.

| 7| Technical name | Blevated... | Last... |1

At the top of the right-hand frame, above the list of Collected objects, choose Grouping and select Only

Necessary Objects.

At the top of the right-hand frame, choose Collection Mode and select Collect Automatically.
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Data Warehousing Workbench: Transport Connection

P

O s Tacolected WE S Doekte & Lct0 [Elconverson  BbBEx B Object Changeabiity  Switch (Business Functions)

[todeing | [ETEEE] [ |crouping |62 paciage [ cotecton tose J] oo .| [B]ER]]
e
[a Al Objects According to Type Colected objects T | Technicalname | Elevated... | Last.. |Last Cha... | Tt

[ Transport Connection + & InfoSource -
+ [ DataSource X

+ [ source system

~ Y SAP Transport = + & Open Hub Destination
+ @ Infoproviders by InfoAreas + B Data Flow

« A8 mfanhiacts hv Tnfaareas » (@] nfnpackzas

Grouping and Collection Settings
3. Select Bl Content in the left-hand frame.

4. Determine your Bl Content installation requirements and apply these to each subsequent step.
If you are carrying out a brand new installation, proceed to the next step.

- Recommendation

If, however, you have previously installed/activated any of the /rRap/* Bl Content, you need to apply
special considerations to the installation/activation of Bl Content following a system upgrade.

o If you have modified any of the previously installed /rRap/* Bl Content objects, we recommend
that for the modified objects, you enable the Match (X) or copy option. When this options is
selected, you will be asked to carry out an additional Transfer selections step during which you
select to install the Active Version (that is, your modified version) or the Content Version (that is,
the SAP delivered, and possibly updated version of the object).

o If you have not modified any of the previously installed /rap/* Bl Content objects, you do not need
to enable the Match (X) or copy option for any of the Bl Content objects, and you don't need to
choose whether to install the Active Version or the Content Version of the objects.

5. Activate InfoObject catalogs.
1. Expand InfoObject Catalog.
2. Use Select Objects to select the /RAP/CHAR CAT and the /RAP/KYF CAT catalogs, that s, all the
InfoObject catalogs that starting with /rRap/*.
3. Choose Transfer Selections.
4. Intheright-hand frame, in the list of Collected objects, verify that both InfoObject catalogs are listed.
5. Right-click on each of the InfoObject catalogs, and choose Install all Bellow.
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6. Choose Install.

If an information dialog box appears, choose Continue. Choose Local Object or enter a package if you
need to transport the objects.

6. Maintain version master data. As of FP3, two new versions, AW1 and AW2, are required.
1. Expand InfoObjects.
2. Search for InfoObject /RAP/VERSN, located under |» Assortment Planning for Retail » RAP Character
InfoObject Catalog 3.

3. Right-click the InfoObject /RAP/VERSN, choose Maintain Master Data from the context menu, and
maintain the following entries on the Time Independent tab:

Version

AP1

AP2

AW1

AW2

0OC1

0Cc2

OM1

oM2

APF

REF

000

The supported planning versions are described in detail in the Maintain Customizing Table /RAP/
RS_VARCUST section of the Common Installation Guide.

i Note

If you encounter problems opening the master data maintenance WebDynpro application, ensure
that you have implemented SAP Note 2034623 .

7. Activate DataStore Objects.

1. Expand | More Types ¥ DataStore Object (Classic) 3.
Use Select Objects to select all DataStore Objects starting with /rRaP/ *.
Choose Transfer Selections.

In the list of Collected objects, verify that the option in the Install column is enabled for each of the
objects.

> w

5. Choose Install. If an information dialog box appears, choose Continue. Choose Local Object or enter a
package if you need to transport the objects.
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8. Activate InfoCubes.
Expand InfoCube.

100

> w e

If during the installation, you are presented with a dialog asking you to add objects to a personal list,

select No.
If activation warnings similar to the ones displayed below appear, you can ignore them.

Date/ Time/User

* & Attribute _RAP_CLSET: Conversion routing ALPHA ignor
= ¢ Attribute _RAP_CLUST: Compounding ignored

= & Attribute _RAP_LOCAT: Conversion routine ATINN ignof
= & Attribute _RAP_PRDCT: Conversion routine ALPHA ignoi
= & Attribute _RAP_VARNT: Conversion routine ALPHA igno
* & Attribute _RAP_VERSN: Conversion routine ALPHA ignoi

* @ Creating column view of type IDS for object /RAP/DSO01...

£ Column view activated for object /RAP/DS01
* @D DataStore Object (classic) /RAP/DSOL activated
* & Post Processing/Checking the Activation for DataStore Object (|
~ & Creating Export DataSource and dependent Objects
* @ Reading the Metadata of /RAP/DS02 ...
* @ Creating DataSource /RAP/SDS02 ...
* & The short text of DataSource /RAP/8DS02 is not mainta
« & The short text of DataSource /RAP/8DS02 is not mainta

» @ Writing of object catalog entries (TADIR)
« @ Program ID Q0L57Y1I6BIWYCOBVZUS1IWVYK retrieved for [
~ & Initial entry written on the status of data of the InfoProvider
b & Activate external SAP HANA view for object /RAR/DSO2

* @ Creating column view of type IDS for object /RAP/DSD2...

& Colurmn view activated for object /RAP/DS02

* @ DataStore Object (classic) /RAP/DS02 activated

v A Post Processing/Checking the Activation for DataStore Object (
v A Initial entry written on the status of data of the InfoProvider

+ PR Fracbine rabame ssines nf e TAC £ar ahin INARIMECAD

Warnings

Use Select Objects to select all InfoCubes starting with /RAP/RC*.

Choose Transfer Selections.

In the list of Collected objects, verify that the option in the Install column is enabled for each of the

objects.

Choose Install. If an information dialog box appears, choose Continue. Choose Local Object or enter a
package if you need to transport the objects.

If activation warnings similar to the ones displayed below appear, you can ignore them.
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+ @ Checking InfoCube /RAP/RCOS
* & Checking InfoCube [RAP/VCD1

> & Column view activated for object HRAPIRCOI

= & Check of InfoProvider /RAP/VCD1: = _& Activate external SAP HANA view for object ;RAP;‘RCl}l

* 8 Unable to find SAP HANA information model sap.is.retad.rap_ ap/INVENTORY_ACTUALS_VC
+ £ Mapped attrbute AP_PLN_ID does not exst for characteristic /RAP/ASRTP

* O Mapped attrbute CLUSTERSET_ID does not exist for charactenstic /RAP/CLSET

= & Mapped attrbute CLUSTER_ID does not exst for charactenstic /RAP/CLUST

* 8 Mapped attrbute EXT_LOC_ID does not exst for characteristic [RAP/LOCAT

* & Mapped attrbute COLOR does not exist for characteristic [RAP/PROLR

= ﬂ Hawed attrbute EXT_PROD_ID does not exit for characteristic IWIPRIKT

& o Mapped attrbute VERSION does not exist for characterst IWNERSH

* & Mapped attrbute CURRENCY does not exist for characteristic DCURRENCY

+ & Mapped attrbute MANDT does not exst for characteristic OMANDT

* & Mapped attrbute UOM does not exst for characterstic OUNIT

* & Mapped attrbute INVENTORY_AT_COST does not exist for key figure /RAR/CIVCY
+ O Mapped attrbute INVENTORY_AT_RETAIL does not exit for key figure [RAP/CIVRY
+ & Mapped attrbute INVENTORY does not exist for key figure /RAP/CIVUN

+ & Mapped attrbute ON_ORDER does not exst for key figure /RAP/ONOUN

= & Wamings occurred whie checking the InfoProvider

Warnings

9. Activate new Aggregation Level.

> w =

Expand | Planning » Aggregation Level 3.

Choose Transfer Selections.

objects.

D Package system—lom\ bw.bwzhana. rap, type: Analytic View, name: R

= & Attribute _RAP_ASRTP: Conversion routine ALPHA ignored
= ¢ Attribute _RAP_CLSET: Conversion routine ALPHA ignored
= & Attribute _RAP_CLUST: Compounding ignored

= & Attribute _RAP_LOCAT: Conversion routine ATINN ignored
= & Attribute _RAP_PRDCT: Conversion routine ALPHA ignored
= & Attribute _RAP_VARNT: Conversion routine ALPHA ignored
= & Attribute _RAP_VERSN: Conversion routine ALPHA ignored
= ¢ Attribute OFISCPER: Conversion routine PERI7 ignored

= & Attribute OFISCPER: Compounding ignored

* & Attribute DREQUID: Conversion routine RQUID ignored

* & Attribute OUNIT: Conversion routine BUNIT ignored

Use Select Objects to select the /RAP/D08A02 Aggregation Level.

In the list of Collected objects, verify that the option in the Install column is enabled for each of the

5. Choose Install. If an information dialog box appears, choose Continue. Choose Local Object or enter a
package if you need to transport the objects.

10. Reactivate Planning Sequence Objects.

1. Expand|p Planning ¥ Planning Sequence 3.

2. Use Select Objects to select the following Planning Sequences:

o

o}

o

o}

/RAP/D12A01 PSO1
/RAP/D12A01 PS02
/RAP/D15A01 PSO1
/RAP/D15A01 PS02
/RAP/D07A04 PSO1
/RAP/MO6A01 PSO7
/RAP/R10A01 PS02

3. Choose Transfer Selections.

4. Inthe list of Collected objects, verify that the option in the Install column is enabled for each of the
objects.
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5. Choose Install. If an information dialog box appears, choose Continue. Choose Local Object or enter a
package if you need to transport the objects.
11. Reactivate Workbooks.

Expand | More Types # Analysis Office Excel Workbook .
2. Use Select Objects to select the following workbooks:

© /RAP/OPTIONPLANBYMODULE

© /RAP/OPTIONPLANBYCLUSTER

© /RAP/REFINEASSORTMENT

O /RAP/PLANASSORTMENT
3. Choose Transfer Selections.

4. Inthe list of Collected objects, verify that the option in the Install column is enabled for each of the
objects.

5. Choose Install. If an information dialog box appears, choose Continue. Choose Local Object or enter a
package if you need to transport the objects.

12. Choose Exit to leave the transaction.

4.2.2.3.2.4 Activate SAP HANA Content for SAP Assortment
Planning for Retail - Part 2

Use

In this procedure, you perform the final activation of SAP HANA content (views and stored procedures)
required by the SAP Assortment Planning for Retail application. This final activation results in a full activation
of the SAP HANA content for SAP Assortment Planning for Retail. Several SAP HANA views depend on local Bl
Content objects, and as such, have to be activated following the activation of these Bl Content objects, as
described in this procedure.

Prerequisites

As a mandatory prerequisite for a successful activation of SAP HANA content for SAP Assortment Planning for
Retail, you must have successfully completed all of the procedures listed in the previous sections of this guide.

Procedure

1. Ensurethatthe sys REPO user has the authorizations required to successfully activate SAP HANA
content.
1. Provideuser SYsS REPO with object privilege SELECT, with option "Grantable to others", on the
following physical DB schemas:
o Physical database schema of your back-end system, typically this is called SAP<SID>.
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o Physical database schema that contains the SAP ERP tables
You can use the following example SQL statement to grant the required privilege:
GRANT SELECT ON SCHEMA <Your schema name> TO _SYS REPO WITH GRANT OPTION;
2. Assign the required privileges described in section Authorization Requirements for the UDF AFL, of the
SAP Customer Activity Repository Security Guide.
2. Use transaction SE38 to run program /RAP/ACTIVATE HANA CONTENT.
The program activates the remaining SAP HANA content (views and stored procedures) required by SAP
Assortment Planning for Retail.

Log on to SAP HANA studio.
Open the Modeler and use the Navigator to access your back-end system.
Expand the Content folder located under your system name in the Navigator.

o ok w

Expand the package listed below:
O sap.is.retail.rap
All the content in the underlying folders should be active.

More Information

Section Activating Objects, of the SAP HANA Developer Guide SAP

4.2.2.3.2.5 Verify Activation of External Views

Use

During activation of SAP HANA content for SAP Assortment Planning for Retail, several external views are not
automatically activated. Following an upgrade, you need to verify that all previously activated external views
remain active.

Procedure

1. Use either transaction SE11 or SE80 to verify that all the external views listed in SAP Note 2067030#% are
in an activate state. If they are not, manually activate the views.
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4.2.2.3.3 Maintain Customizing Table /RAP/RS_VARCUST

Use

In this procedure, you maintain entries in the variable customizing table /RAP/RS_VARCUST in the back-end
system. For each SAP Assortment Planning for Retail query, the entries of this table specify a mapping of a
data version (for example, actual data versus planning data) to the source of data (InfoCube).

Procedure

1. Log on to your back-end system.

2. Runreport /RAP/SEED BW CUSTOMIZING DATA (transaction SE38).

3. Determine whether you want to overwrite the existing entries in the /RAP/RS_VARCUST table.
If you do want to overwrite the contents of the table, enable the Remove Existing Entries option. If you don't
want to overwrite the contents of the table, but want to append the new entries, disable the Remove
Existing Entries option.

i Note

Duplicate entries that can potentially be created if you choose to disable the Remove Existing Entries
option, which will result in an error.

4. Enable the Test option and choose Execute to run the report in test mode.
Running the report in test mode allows you to verify that you can successfully update the /rRaP/
RS VARCUST table. No entries are persisted in the table as a result.
5. Once you have successfully executed the /RAP/SEED BW CUSTOMIZING DATA report in test mode,
disable the Test option and choose Execute to run the report.
6. Optionally, once the report has finished executing, you can verify the entries of the /RAP/RS_VARCUST
variable customizing table.
If required, you can make changes to any of the entries made by the /RAP/SEED BW CUSTOMIZING DATA
report by doing the following:
1. Open the Data Browser (transaction SE16).
2. Enter /RAP/RS_VARCUST in the Table Name field and choose Create Entries.

3. Choose Execute followed by Create.
On the Table /RAP/RS_VARCUST Insert screen, you will be able to make the following entries:

Field Name User Entry

COMPID SAP Assortment Planning for Retail technical query name.

For example, /RAP/M01A02_TIRQ02.

VNAM ICUBE InfoCube variable name.

For example, /RAP/INFOPROV_ESM 01.
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Field Name User Entry

INFOCUBE InfoCube identifier.

For example, /RAP/RCO1.

VNAM VERS Version variable name.

For example, /RAP/VERSN MSM 01.

VERSION Version |dentifier.

There are several supported planning versions:

o AP1:Location level version 1. Version that is typically used as the planning version.

o ap2:Location level version 2. Version typically used to simulate different scenarios without
having to change your planned version.

o awl: Week level version 1. Version that is typically used as the planning version.

o aw2: Week level version 2. Version typically used to simulate different scenarios without hav-
ing to change your planned version.

o oc1: Option plan by cluster simulation version 1. Version that is typically used as the plan-
ning version.

o oc2: Option plan by cluster simulation version 2. Version typically used to simulate different
scenarios without having to change your planned version.

o oM1: Option plan by module simulation version 1. Version that is typically used as the plan-
ning version.

o oM2: Option plan by module simulation version 2. Version typically used to simulate different
scenarios without having to change your planned version.

o APF: Final version (planned data). After completing the planning, the user will select the
plan they want to finalize and review in the Plan Weekly Sales and Receipts workbook. Only
the APF version is available in Plan Weekly Sales and Receipts.

o REF: Reference version (past data). This is historical data for the items from the time frame
of the reference period. This data is used to pre-populate the planning version by using the
copy function. This allows the planner to have a baseline when starting the planning proc-
ess. It is recommended to seed the planning version with the REF data.

o 000: Actual version (current data). The user can see current inventory values with this such

as Actual Inventory and Open Orders.

F4HELP Flag that specifies whether the field provides F4 help or not.

4. Maintain entries in the /RAP/RS_VARCUST table as required.
For example you can change the InfoCube used as the source of data for a particular planning version.
5. Choose Save.
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4.2.2.3.4 Update Fiscal Year Variant Entries

Use

In this procedure you update previously maintained fiscal year variants ( OFISCVARNT 'RW'). The SAP
Merchandise Planning for Retail application, which can be used in conjunction with the SAP Assortment
Planning for Retail application, only supports fiscal years with 52 posting periods. As a result, fiscal year variant
entries must be adjusted, entering each year with 53 posting periods as a shortened fiscal year.

A\ Caution

You must maintain fiscal year variants for at least one year past the years for which you are planning. For
example, if your assortment plans extend to December 2018, you must maintain fiscal year variants until
December 2019.

The steps provided in this procedure allow you to maintain 0OFTSCVARNT 'RW' using the standard 4-5-4
calendar entries. If you are using alternative fiscal periods in your retail business, for example, each week
starting on a Sunday instead of Saturday, you can provide your own entries instead of the ones suggested in
this guide.

Procedure

1. Logon to your back-end system.
2. Launch fiscal year variant maintenance (transaction GVAR).

3. Choose New Entries.
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4. Onthe New Entries: Overview of Added Entries screen make the following sets of entries:

Fiscal year variants

FV  Description Year-depen... Calendar yr Number of postin... No.of special peri
BW Assort. Plan Week v O 53 -
r -

Create New Fiscal Year Variant
5. Choose Enter.
An information message is displayed about creating more than 16 periods, choose Continue.
6. Choose Back.
You can see the newly created entry.

7. Mark the entry RW and double-click on Shortened Fiscal Years from the Dialog Structure.

8. Enter 2012 inthe Fiscal year field and choose Continue.

9. Choose New Entries.

10. Enter 52 in the No. of posting periods field in the Shortened Fiscal Years section.

11. Choose Back twice.

12. Open SAP Note 2112634#% , locate the entries for year 2012, and enter the data by copy-and-paste.

13. Repeat steps 7-12 to maintain the weekly fiscal year variant for years 2013, 2014, 2015, 2016, 2017, 2018,
2019, and 2020, entering each year as shortened fiscal year. The corresponding tables are available in SAP
Note 2112634 # .

14. Choose Save after you have finished the maintenance for year 2020.
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4.2.2.35 Set Language for Ribbons and Buttons in
Workbooks (Optional)

Use

In this optional procedure, you can change the language settings specific to SAP Assortment Planning for
Retail workbooks. During the upgrade, some of the workbooks are updated, and, if you have previously
changed the language settings of these workbooks, you need to make these settings again following the
upgrade.

You can set the desired language of the following user interface objects:

® Ribbons Planning Functions, Refinement Functions, and Extended Features
® Tooltips for planning functions

® Message texts

e Buttons

The content of the workbooks consists of multiple parts:

e The language of the standard menus and standard ribbons depends on the language set for Microsoft
Excel.

e The language of the contents in the cells (mainly KPIs) depends on the user-selected system language of
the back-end system.

e The language of the user interface objects that are specific to the workbooks of SAP Assortment Planning
for Retall, is not set by the selected system language of the back-end system, but you can change it for
each workbook according to the following procedure. The default language is English.

Procedure

1. Unhide the worksheet SAP_TEXT_CUSTOMIZING using standard functionality of Microsoft Excel.

2. Onthe worksheet SAP_TEXT_CUSTOMIZING, copy the column of the desired language to column B -
Custom Text.

3. Hide the worksheet SAP_TEXT_CUSTOMIZING.

4. Save your changes in the worksheet on the SAP NetWeaver Server by choosing |» File » Analysis » Save
Workbook to SAP NetWeaver

4.2.2.3.6 Verify that Data Replication is Running Following
the Upgrade

In general, following the upgrade, you need to ensure that all of the data replication described in Configure Data
Replication section of the Common Installation Guide is still running.
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In particular, you need to pay attention to the following:

Ensure that time-dependent article hierarchies are properly loaded into SAP Assortment Planning for
Retail following the upgrade. See Load of Time-Dependent Article Hierarchies section of the Common
Installation Guide.

All the tables listed in SAP Note 2054656#% are being replicated. New tables can be added with each new
release.

Ensure that periodic tasks to load product attributes into SAP Assortment Planning for Retail are still
running following the upgrade. See, Load Product Attributes into SAP Assortment Planning for Retail section
of the Common Installation Guide.

Ensure that OTB data is being loaded from the appropriate source. For more information, see the Load
Merchandise Planning Data section of the Common Installation Guide.

4.2.2.3.7 Run the Validation Report

Run transaction SE38.
Execute the /DMF/VALIDATE CAR INSTALLATION report.

3. Select the Assortment Planning scenario and select Execute.

Running this report allows you verify the success of the installation, providing a log of potential issues. For
example, you may be presented with the following results:

[ Display logs x

R = e S A =) 09 509 =~ | P Py (BT

Type Message Text LTxt
— Check - Installed SAP Notes

- Check - Planning Application Kit (PAK)

--- Check - Fiscal Calendar

Maintain fiscal year variant 'RW'. &
— Check - SAP HANA Time Dimension

Maintain SAP HANA time dim. at least 2 years back and 5 years in future. (2]
— Check - Table /RAP/RS_VARCUST

— Check - BI Master Data for Planning Versions

- Check - BI Technical Content Activation

--- Check - BI APR Content Activation

-~ Check - SAP HANA AFL PAL

— Check - SAP HANA AFL OFL

ODDDD0DCE D@00 D

.
@ }ﬂf Technical Information JEl Help J@

Validation Report Results

View the long text associated with each message to see the link to the documentation describing the
procedure you need to troubleshoot.
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4.2.3 1.0 FP3 to 1.0 SP5

Upgrade information.

This section is intended for existing SAP Assortment Planning for Retail customers who have installed and
configured SAP Assortment Planning for Retail 1.0 FP3 and would like to upgrade to SAP Assortment Planning
for Retail 1.0 SP5.

4.2.3.1 Quick Guide

SAP Assortment Planning for Retail 1.0 FP3 to 1.0 SP5 upgrade checkilist.

Checklist

Prerequisites
Mandatory Steps

1 Ensure that you have implemented the necessary SAP Notes listed in the SAP Notes for the Upgrade
section.

] Ensure that your landscape meets the requirements outlined in the Prerequisites section.
Preparation
Mandatory Steps

[ Verify that you have all of the required SAP HANA users and privileges. See Verify SAP HANA Users and
Privileges [page 83].

] Configure AFL and OFL usage. See Enable Usage of PAL Functions [page 86] and Check the OFL
Installation [page 87].

Upgrade Process
Mandatory Steps

O Implement SAP Note 2298340 if your landscape includes a NW version earlier than NW 740 SP15.
You must perform this step prior to upgrading the back-end system product version.

[1 Upgrade your back-end system product version in SAP Solution Manager.
[ Upgrade the application function libraries (UDFAFL_INST 100, POSAFL INST 100).

[J Upgrade or install product-specific SAP Fiori Ul component on the front-end server.
Follow-Up Activities
Mandatory Steps

[0 Create SAP ERP tables.

[ Verify SAP HANA and back-end system roles. See the Verify Users, Privileges, and Roles section in the
Common Installation Guide.
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Reactivate SAP Assortment Planning for Retail planning framework content.
Maintain Customizing table /RAP/RS_VARCUST.

Update fiscal year entries.

Optionally, restore language settings in workbooks.

Verify that data replication is running following the upgrade.

Run the validation report.

Configure index calculation.

Activate SAP Assortment Planning for Retail OData services.

OO00o0ooooogd

Verify that all the ICF services relevant to SAP Assortment Planning for Retail are active following the
upgrade.

[] Define system alias for back-end transactions.

] Troubleshoot front-end server upgrade.

4.2.3.2 Upgrade Process
42321 Implement SAP Note 2298340

Use

Prior to upgrading the CAR RETAIL APPL BUNDLE 1.0 back-end product version from an older support
package stack (SPS) to a newer one, you need to verify the SAP NetWeaver 740 SPS in your system landscape.
Important corrections, relevant for Core Data Services (CDS) views, and required by the latest SPS of cAR
RETAIL APPL BUNDLE 1.0, are only available as of SAP NetWeaver 740 SPS 15.

Procedure

1. Verify your SAP NetWeaver 740 support package stack.
If your landscape contains SAP NetWeaver 740 SPS 12, SPS13, or SPS14, you will need to implement SAP
Note 2298340 to apply corrections relevant for CDS views.
If your landscape has been upgraded to SAP NetWeaver 740 SPS 15, you do not need to implement SAP
Note 2298340#% , and you can go to the next procedure.

2. Read and implement SAP Note 2298340 prior to upgrading the back-end system product version.

More Information

http://help.sap.com/hana_platform#&| Development and Modeling » SAP HANA Modeling Guide (For SAP
HANA Studio) 3
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4.2.3.2.2 Upgrade SAP Customer Activity Repository Retail
Applications Bundle

Use

This procedure describes how to upgrade the CAR RETAIL APPL BUNDLE 1.0 back-end product version
from an older support package stack to a newer one.

Procedure

1. Check your upgrade scenario:

1. Navigate to the Product Availability Matrix (PAM) at http://support.sap.com/pam .

2. Forinformation about the available support package stacks (SPS), search for the CAR RETAIL APPL
BUNDLE 1.0 product version, and choose Support Package Stacks.

3. Forinformation about the supported upgrade paths, choose Related Product Versions.

4. Forinformation about the software components in the SPS, choose Technical Release Information and
consult the subsections, such as Database Systems.

5. To navigate directly to the download area for the SPS, choose |+ SAP Software Download Center # CAR

RETAIL APPL BUNDLE 1.0 - Support Packages & Patches 3.
Alternatively, you can get there from the SAP Support Portal by choosing http://support.sap.com/

swdc# | Support Packages and Patches » Software Downloads j» SUPPORT PACKAGES & PATCHES »
By Alphabetical Index (A-Z) » C » CAR RETAIL APPLICATIONS BUNDLE ¥ CAR RETAIL APPL BUNDLE
1.0 73
2. Patch the support package stack using the Support Package Manager tool (transaction spaMm).
For more information about this tool, see SAP Help Portal at http://help.sap.com/spmanager

|+ Application Help 3, as well as SAP Note 1803986 #4r .

To finalize the upgrade of the back-end product version, you must additionally do some manual steps. Continue
with the next section.

Download and Install the Application Function Libraries (AFLs)
There are two components that you cannot upgrade using Support Package Manager.

e Unified Demand Forecast application function library (UDF AFL, software component version
UDFAFL_INST 100, provides the demand modeling and forecasting services in SAP Customer Activity
Repository, runs directly in the SAP HANA database)

e On-Shelf Availability application function library (POS AFL, software component version POSAFL INST
100, provides the On-Shelf Availability services in SAP Customer Activity Repository, runs directly in the
SAP HANA database)

You need to download one UDF AFL revision and one POS AFL revision manually and install them together in
your SAP HANA database.

Where to Download

Both AFLs are provided as part of the CAR RETATIL APPIL BUNDLE 1.0 product version onthe SAP Support

Portal under http:/support.sap.com/swdcP|» Support Packages and Patches  Software Downloads »
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SUPPORT PACKAGES & PATCHES » By Alphabetical Index (A-Z) ¥ C » CAR RETAIL APPLICATIONS BUNDLE ¥
CAR RETAIL APPL BUNDLE 1.0 }» Entry by Component » Analytics AFL 3.

For a successful upgrade, you need to be aware of the following dependencies.

Dependencies Between the AFLs and the SAP HANA Database

The AFLs are released independently of the releases of SAP Customer Activity Repository retail applications
bundle. This is because the AFLs follow the release cycle of the SAP HANA database. The releases are called
“revisions”. Whenever a new revision of the SAP HANA database is released, a new revision of each AFL is

released. As a result, multiple revisions of each AFL are available on the SAP Support Portal at any one time.

A Caution

For each revision of an AFL, there is only one compatible revision of the SAP HANA database. For example,
you can only use revision 112.20 of the UDF AFL with revision 112.02 of the SAP HANA database. Whenever
you upgrade an AFL, you must also upgrade the database and any other AFLs to the compatible revisions.

Reversely, whenever you upgrade the database, you must upgrade the AFLs.

Note that this dependency applies not only to the UDF AFL and the POS AFL but also to the generic SAP
HANA AFL. Both the SAP HANA AFL and the SAP HANA database are components of the SAP HANA
Platform (see Prerequisites [page 16]).

When you download an AFL revision from the SAP Support Portal, the compatible revision of the SAP
HANA database is indicated.

Nomenclature

The following table explains how you can see the dependencies by looking at the release numbers:

Release of ... Released as ... Example Guideline

SAP HANA Platform <Support Package Stack> SAP HANA Platform SPS11  The number of the support
package stack determines
the first digits of the revi-
sions.

SAP HANA Database <Revision>.<Patch> SAP HANA Database 112.02  All 11x.xx database revisions
belong to the SPS 11 plat-
form stack.

The patch number deter-
mines the first digit of the
AFL patch.

UDF AFL <Revision>.<Patch> UDF AFL112. 20

POS AFL POS AFL 112. 20

SAP HANA AFL SAP HANA AFL 112. 20
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- Recommendation

We recommend that you upgrade all the AFLs at the same time. This means:

e UDF AFL and POS AFL, which you must both install for a successful upgrade of SAP Customer Activity
Repository retail applications bundle

e SAP HANA AFL, which is one of the mandatory prerequisites
e ifapplicable, other AFLs provided with SAP HANA that might be relevant for your scenario

Focus on the AFL that provides the most important functionality for your scenario (for example, demand
forecasting with the UDF AFL). Select the best revision of that AFL for your scenario. This in turn will give
you the compatible revision of the SAP HANA database and the compatible revisions of the other AFLs.
Then install all the AFLs together.

Download and Install the UDF AFL (Focus: Demand Forecasting)

1. Select an AFL revision.
Multiple revisions are available on the SAP Support Portal. For guidance on selecting the best revision for
your Unified Demand Forecast scenario, see the following:

o Prerequisites [page 16]: Indicates the minimum revision of the AFL and the SAP HANA Platform for
this release.

o SAP Note 2088924 #: Release Information Note (RIN) for SAP Customer Activity Repository retail
applications bundle 1.0.

o SAP Note 2050229#% : Gives you an overview of all UDF AFL revisions as of revision 82 and provides
instructions for downloading, installing, and upgrading the UDF AFL.
o SAP-HANA-related information:

o Release and maintenance strategy of the SAP HANA Platform at http://support.sap.com/swdc#
| Support Packages and Patches # Software Downloads » SUPPORT PACKAGES & PATCHES ¥ By
Alphabetical Index (A-Z) » H » SAP HANA Platform Edition » Info J

o SAP Note 2021789#% : SAP HANA Revision and Maintenance Strategy

o SAP Note 2227464#% : SAP HANA Platform SPS 11 Release Note

o SAP Note 1948334 #%: SAP HANA Database Update Paths for Maintenance Revisions

o SAP Note 1914052#% : Dependencies between SAP NetWeaver and the SAP HANA Database

2. Download and install your AFL revision (together with the other AFLs) as described in SAP Note 2050229
P

i Note

To use the UDF functionality in your implementation scenario, you must additionally do some post-
installation steps. For more information, see Configure Unified Demand Forecast (Optional) [page 64].

Download and Install the POS AFL (Focus: On-Shelf Availability)

1. Select an AFL revision.
Multiple revisions are available on the SAP Support Portal. For guidance on selecting the best revision for
your On-Shelf Availability scenario, see the following:
o Prerequisites [page 16]: Indicates the minimum revision of the AFL and the SAP HANA Platform for
this release.
o SAP Note 2088924 #% : Release Information Note (RIN) for SAP Customer Activity Repository retail
applications bundle 1.0.
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o SAP Note 2056102#% : Gives you an overview of all POS AFL revisions as of revision 82 and provides
instructions for downloading, installing, and upgrading the POS AFL.

o SAP-HANA-related information:

o Release and maintenance strategy of the SAP HANA Platform at http:/support.sap.com/swdc#
| Support Packages and Patches ¥ Software Downloads » SUPPORT PACKAGES & PATCHES » By
Alphabetical Index (A-Z) » H » SAP HANA Platform Edition » Info 3

o SAP Note 2021789#% : SAP HANA Revision and Maintenance Strategy

o SAP Note 2227464#% : SAP HANA Platform SPS 11 Release Note

o SAP Note 1948334 #%: SAP HANA Database Update Paths for Maintenance Revisions

o SAP Note 1914052#%: Dependencies between SAP NetWeaver and the SAP HANA Database

2. Download and install your AFL revision (together with the other AFLs) as described in SAP Note 2056102
i

i Note

To use the On-Shelf Availability functionality in your implementation scenario, you must additionally do
some post-installation steps. For more information, see Configure On-Shelf Availability (Optional) [page
53].

Result

You have successfully upgraded the CAR RETATL APPIL BUNDLE 1.0 back-end product version to the current
SPS. Continue with the next section.

4.2.3.2.3 Upgrade Product-Specific SAP Fiori Ul
Component

Use

This procedure describes how to upgrade the SAP FIORI FOR SAP CARAB front-end product version from an
older support package stack to a newer one.

The ABAP front-end server contains the complete Ul layer, which consists of the SAP Gateway, the central SAP
Fiori Ul component, and the product-specific SAP Fiori Ul component. The product-specific SAP Fiori Ul
component contains all the SAP Fiori user interfaces for the applications provided for the SAP Customer
Activity Repository retail applications bundle.

Procedure

1. Identify the support package stack on the SAP Support Portal at http:/support.sap.com# | Software
Downloads # Support Packages and Patches # Software Downloads » By Alphabetical Index (A-Z) ¥ F
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SAP FIORI » SAP FIORI FOR SUITE » SAP FIORI FOR SAP CARAB » SAP FIORI FOR SAP CARAB 2.0

SPSO01 .
For more information on support package stacks, see http:/support.sap.com/sp-stacks .
2. Patch the support package stack using the Support Package Manager tool (transaction SpaMm).

For more information, see SAP Help Portal at http://help.sap.com/spmanager# | Application Help 3, as
well as SAP Note 1803986 # .

A\ Caution

As of the FP3 release, software components UTSCARO1 and UTRAP0OO1 have been merged into one,
UICAR0O01, software component.

3. If you are using SAP Assortment Planning for Retail, consult SAP Note 2077357#% , which lists the SAP
Notes relevant for your release.

4.2.3.3 Follow-Up Activities
4.2.3.3.1 Create SAP ERP Tables

A Caution
Following an upgrade, it is important to remember to create any additional tables required by the new

release.

Tables required to be created as of the SAP Assortment Planning for Retail are listed in SAP Note 2263205 .
Ensure that all tables listed in this note have been created.

4.2.3.3.2 Reactivate SAP Assortment Planning for Retail
Planning Framework Content

4.2.3.3.2.1 Activate SAP HANA Content

Use

In this procedure, you activate all SAP HANA content required by SAP Customer Activity Repository.

For more information about activating SAP HANA content, see SAP Help Portal at http://help.sap.com/
hana_platform#|l <your SAP HANA Platform SPS> » Development and Modeling » SAP HANA Developer
Guide (For SAP HANA Studio) ¥ Setting Up the Analytic Model ¥ Creating Views # Activating Objects .
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Prerequisites

e Asamandatory prerequisite for a successful activation of the SAP HANA content for SAP Customer
Activity Repository, you must have successfully completed all of the procedures listed in the previous
sections of this guide.

e You must also set up the roles and privileges for the Unified Demand Foreast module as described in the
Authorization Requirements for the UDF AFL section of the SAP Customer Activity Repository Security

Guide, available at http:/help.sap.com/car]l <your release> ¥ Security Information 3.

You must do this regardless of whether you want to use UDF forecasting in your scenario or not. This
procedure not only enables UDF, but it is required so that the SAP HANA content for SAP Customer
Activity Repository can be activated correctly.

Procedure

To activate the SAP HANA content, carefully follow the instructions provided in SAP Note 2330386 .

A\ Caution

If you are applying a support package or correction on an existing installation and this support package or
correction involves SAP HANA content for the DDF module or the UDF module in SAP Customer Activity
Repository, then you must manually activate this content again. For example, this is the case when you
apply an SAP Note using transaction SNOTE.

Follow the instructions in SAP Note 2145356 #% .

More Information

If you encounter issues during the activation, see the Troubleshooting [page 75] section for possible solutions.

4.2.3.3.2.2 Activate SAP HANA Content for SAP Assortment
Planning for Retail - Part 1

Use

In this procedure, you perform the initial activation of SAP HANA content (views and stored procedures)
required by the SAP Assortment Planning for Retail application.

A\ Caution

This initial activation results in a partial activation of the SAP HANA content for SAP Assortment Planning
for Retail. Several SAP HANA views depend on local Bl Content objects, and as such, have to be activated
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following the activation of these Bl Content objects. For more information, see Activate SAP HANA Content
for SAP Assortment Planning for Retail - Part 2 [page 102].

Prerequisites

As a mandatory prerequisite for a successful activation of SAP HANA content for SAP Assortment Planning for
Retail, you must have successfully completed all of the procedures listed in the previous sections of this guide.
In particular, you must have activated SAP HANA content for SAP Customer Activity Repository.

Procedure

1. Ensurethatthe sys REPO user has the authorizations required to successfully activate SAP HANA
content.

1. Provideuser sys REPO with object privilege SELECT, with option "Grantable to others”, on the
following physical DB schemas:
o Physical database schema of your back-end system, typically this is called SAP<SID>.
o Physical database schema that contains the SAP ERP tables
You can use the following example SQL statement to grant the required privilege:
GRANT SELECT ON <Your schema name> TO _SYS REPO WITH GRANT OPTION;
2. Assign the required privileges described in section Authorization Requirements for the UDF AFL, of the
SAP Customer Activity Repository Security Guide.
2. Use transaction SE38 to run program /RAP/ACTIVATE HANA CONTENT.

The program activates a majority of the SAP HANA content (views and stored procedures) required by SAP
Assortment Planning for Retail.

Log on to SAP HANA studio.

Open the Modeler and use the Navigator to access your back-end system.
Expand the Content folder located under your system name in the Navigator.
Expand the package listed below:

o ook~ w

O sap.is.retail.rap

You will notice that some of the content in the underlying folders is not deployed. The figure below provides
an example of content that has not been deployed.
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[ k= PROJECT Chbjects (1)

Example of SAP HANA content not deployed

A small number of views not deploying is an expected result of this procedure, and the remaining content
will be deployed in the Activate SAP HANA Content for SAP Assortment Planning for Retail - Part 2 [page
102] procedure.

O\ Caution

If you see that none of the views/procedures inthe sap.is.retail.rap package are deployed, you
can resolve this by manually selecting, right-clicking, and choosing to Redeploy each of the sub-folders.
This manual redeployment should leave only the views/procedures highlighted above as not deployed.

More Information

Section Activating Objects, of the SAP HANA Developer Guide SAP
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4.2.3.3.2.3 Activate Application Bl Content

Use

In this procedures, you perform a sequential, step-by-step activation of the local Bl Content objects following
the upgrade to SAP Assortment Planning for Retail 1.0 FP3.

i Note

To ensure correct activation of the local Bl Content objects, carry out the activation sequentially, as
specified in the following procedures.

Also, the default Bl setting to collect and activate all dependencies must not be disabled by the user. The
instructions below activate a minimum subset of objects, and it assumed that all their dependencies will be
collected and activated.

Procedure

1. Onyour back-end SAP Assortment Planning for Retail system, open the Data Warehousing Workbench
(transaction RSA1).
2. Verify transport connections.
1. Select Transport Connection in the left-hand frame.
2. Select Object Types.
3. Expand Source System.
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Data Warehousing Workbench: Transport Connection

Switch (Business Functions)
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=~ [ Export
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v E Workbook
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+ B8 Infoset
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» [ semantically Partitioned Object
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» &) Data Transfer Process

v @3 process Chain

» [ Processes -

» 3 Panning -

Selecting Source Systems

(@ (s Grouping .|| ][2 Package [ Collection Mode [

Displat *

Collected objects

Use Select Objects to ensure that the back-end system is selected as the source system.

Choose Transfer Selections.

| 7| Technical name | Blevated... | Last... |1

At the top of the right-hand frame, above the list of Collected objects, choose Grouping and select Only

Necessary Objects.

At the top of the right-hand frame, choose Collection Mode and select Collect Automatically.
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Data Warehousing Workbench: Transport Connection

P
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Grouping and Collection Settings
3. Select Bl Content in the left-hand frame.

4. Determine your Bl Content installation requirements and apply these to each subsequent step.
If you are carrying out a brand new installation, proceed to the next step.

- Recommendation

If, however, you have previously installed/activated any of the /rRap/* Bl Content, you need to apply
special considerations to the installation/activation of Bl Content following a system upgrade.

o If you have modified any of the previously installed /rRap/* Bl Content objects, we recommend
that for the modified objects, you enable the Match (X) or copy option. When this options is
selected, you will be asked to carry out an additional Transfer selections step during which you
select to install the Active Version (that is, your modified version) or the Content Version (that is,
the SAP delivered, and possibly updated version of the object).

o If you have not modified any of the previously installed /rap/* Bl Content objects, you do not need
to enable the Match (X) or copy option for any of the Bl Content objects, and you don't need to
choose whether to install the Active Version or the Content Version of the objects.

5. Activate InfoObject catalogs.
1. Expand InfoObject Catalog.
2. Use Select Objects to select the /RAP/CHAR CAT and the /RAP/KYF CAT catalogs, that s, all the
InfoObject catalogs that starting with /rRap/*.
3. Choose Transfer Selections.
4. Intheright-hand frame, in the list of Collected objects, verify that both InfoObject catalogs are listed.
5. Right-click on each of the InfoObject catalogs, and choose Install all Bellow.
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6. Choose Install.

If an information dialog box appears, choose Continue. Choose Local Object or enter a package if you
need to transport the objects.

6. Maintain version master data. As of FP3, two new versions, AW1 and AW2, are required.
1. Expand InfoObjects.
2. Search for InfoObject /RAP/VERSN, located under |» Assortment Planning for Retail » RAP Character
InfoObject Catalog 3.

3. Right-click the InfoObject /RAP/VERSN, choose Maintain Master Data from the context menu, and
maintain the following entries on the Time Independent tab:

Version

AP1

AP2

AW1

AW2

0OC1

0Cc2

OM1

oM2

APF

REF

000

The supported planning versions are described in detail in the Maintain Customizing Table /RAP/
RS_VARCUST section of the Common Installation Guide.

i Note

If you encounter problems opening the master data maintenance WebDynpro application, ensure
that you have implemented SAP Note 2034623 .

7. Activate DataStore Objects.

1. Expand | More Types ¥ DataStore Object (Classic) 3.
Use Select Objects to select all DataStore Objects starting with /rRaP/ *.
Choose Transfer Selections.

In the list of Collected objects, verify that the option in the Install column is enabled for each of the
objects.

> w

5. Choose Install. If an information dialog box appears, choose Continue. Choose Local Object or enter a
package if you need to transport the objects.
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8. Activate InfoCubes.
Expand InfoCube.

124

> w e

If during the installation, you are presented with a dialog asking you to add objects to a personal list,

select No.
If activation warnings similar to the ones displayed below appear, you can ignore them.

Date/ Time/User

* & Attribute _RAP_CLSET: Conversion routing ALPHA ignor
= ¢ Attribute _RAP_CLUST: Compounding ignored

= & Attribute _RAP_LOCAT: Conversion routine ATINN ignof
= & Attribute _RAP_PRDCT: Conversion routine ALPHA ignoi
= & Attribute _RAP_VARNT: Conversion routine ALPHA igno
* & Attribute _RAP_VERSN: Conversion routine ALPHA ignoi

* @ Creating column view of type IDS for object /RAP/DSO01...

£ Column view activated for object /RAP/DS01
* @D DataStore Object (classic) /RAP/DSOL activated
* & Post Processing/Checking the Activation for DataStore Object (|
~ & Creating Export DataSource and dependent Objects
* @ Reading the Metadata of /RAP/DS02 ...
* @ Creating DataSource /RAP/SDS02 ...
* & The short text of DataSource /RAP/8DS02 is not mainta
« & The short text of DataSource /RAP/8DS02 is not mainta

» @ Writing of object catalog entries (TADIR)
« @ Program ID Q0L57Y1I6BIWYCOBVZUS1IWVYK retrieved for [
~ & Initial entry written on the status of data of the InfoProvider
b & Activate external SAP HANA view for object /RAR/DSO2

* @ Creating column view of type IDS for object /RAP/DSD2...

& Colurmn view activated for object /RAP/DS02

* @ DataStore Object (classic) /RAP/DS02 activated

v A Post Processing/Checking the Activation for DataStore Object (
v A Initial entry written on the status of data of the InfoProvider

+ PR Fracbine rabame ssines nf e TAC £ar ahin INARIMECAD

Warnings

Use Select Objects to select all InfoCubes starting with /RAP/RC*.

Choose Transfer Selections.

In the list of Collected objects, verify that the option in the Install column is enabled for each of the

objects.

Choose Install. If an information dialog box appears, choose Continue. Choose Local Object or enter a
package if you need to transport the objects.

If activation warnings similar to the ones displayed below appear, you can ignore them.

PUBLIC
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+ @ Checking InfoCube /RAP/RCOS
* & Checking InfoCube [RAP/VCD1

> & Column view activated for object HRAPIRCOI

= & Check of InfoProvider /RAP/VCD1: = _& Activate external SAP HANA view for object ;RAP;‘RCl}l

* 8 Unable to find SAP HANA information model sap.is.retad.rap_ ap/INVENTORY_ACTUALS_VC
+ £ Mapped attrbute AP_PLN_ID does not exst for characteristic /RAP/ASRTP

* O Mapped attrbute CLUSTERSET_ID does not exist for charactenstic /RAP/CLSET

= & Mapped attrbute CLUSTER_ID does not exst for charactenstic /RAP/CLUST

* 8 Mapped attrbute EXT_LOC_ID does not exst for characteristic [RAP/LOCAT

* & Mapped attrbute COLOR does not exist for characteristic [RAP/PROLR

= ﬂ Hawed attrbute EXT_PROD_ID does not exit for characteristic IWIPRIKT

& o Mapped attrbute VERSION does not exist for characterst IWNERSH

* & Mapped attrbute CURRENCY does not exist for characteristic DCURRENCY

+ & Mapped attrbute MANDT does not exst for characteristic OMANDT

* & Mapped attrbute UOM does not exst for characterstic OUNIT

* & Mapped attrbute INVENTORY_AT_COST does not exist for key figure /RAR/CIVCY
+ O Mapped attrbute INVENTORY_AT_RETAIL does not exit for key figure [RAP/CIVRY
+ & Mapped attrbute INVENTORY does not exist for key figure /RAP/CIVUN

+ & Mapped attrbute ON_ORDER does not exst for key figure /RAP/ONOUN

= & Wamings occurred whie checking the InfoProvider

Warnings

9. Activate new Aggregation Level.

> w =

Expand | Planning » Aggregation Level 3.

Choose Transfer Selections.

objects.

D Package system—lom\ bw.bwzhana. rap, type: Analytic View, name: R

= & Attribute _RAP_ASRTP: Conversion routine ALPHA ignored
= ¢ Attribute _RAP_CLSET: Conversion routine ALPHA ignored
= & Attribute _RAP_CLUST: Compounding ignored

= & Attribute _RAP_LOCAT: Conversion routine ATINN ignored
= & Attribute _RAP_PRDCT: Conversion routine ALPHA ignored
= & Attribute _RAP_VARNT: Conversion routine ALPHA ignored
= & Attribute _RAP_VERSN: Conversion routine ALPHA ignored
= ¢ Attribute OFISCPER: Conversion routine PERI7 ignored

= & Attribute OFISCPER: Compounding ignored

* & Attribute DREQUID: Conversion routine RQUID ignored

* & Attribute OUNIT: Conversion routine BUNIT ignored

Use Select Objects to select the /RAP/D08A02 Aggregation Level.

In the list of Collected objects, verify that the option in the Install column is enabled for each of the

5. Choose Install. If an information dialog box appears, choose Continue. Choose Local Object or enter a
package if you need to transport the objects.

10. Reactivate Planning Sequence Objects.

1. Expand|p Planning ¥ Planning Sequence 3.

2. Use Select Objects to select the following Planning Sequences:

o

o}

o

o}

/RAP/D12A01 PSO1
/RAP/D12A01 PS02
/RAP/D15A01 PSO1
/RAP/D15A01 PS02
/RAP/D07A04 PSO1
/RAP/MO6A01 PSO7
/RAP/R10A01 PS02

3. Choose Transfer Selections.

4. Inthe list of Collected objects, verify that the option in the Install column is enabled for each of the
objects.
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5. Choose Install. If an information dialog box appears, choose Continue. Choose Local Object or enter a
package if you need to transport the objects.
11. Reactivate Workbooks.

Expand | More Types # Analysis Office Excel Workbook .
2. Use Select Objects to select the following workbooks:

© /RAP/OPTIONPLANBYMODULE

© /RAP/OPTIONPLANBYCLUSTER

© /RAP/REFINEASSORTMENT

O /RAP/PLANASSORTMENT
3. Choose Transfer Selections.

4. Inthe list of Collected objects, verify that the option in the Install column is enabled for each of the
objects.

5. Choose Install. If an information dialog box appears, choose Continue. Choose Local Object or enter a
package if you need to transport the objects.

12. Choose Exit to leave the transaction.

4.2.3.3.2.4 Activate SAP HANA Content for SAP Assortment
Planning for Retail - Part 2

Use

In this procedure, you perform the final activation of SAP HANA content (views and stored procedures)
required by the SAP Assortment Planning for Retail application. This final activation results in a full activation
of the SAP HANA content for SAP Assortment Planning for Retail. Several SAP HANA views depend on local Bl
Content objects, and as such, have to be activated following the activation of these Bl Content objects, as
described in this procedure.

Prerequisites

As a mandatory prerequisite for a successful activation of SAP HANA content for SAP Assortment Planning for
Retail, you must have successfully completed all of the procedures listed in the previous sections of this guide.

Procedure

1. Ensurethatthe sys REPO user has the authorizations required to successfully activate SAP HANA
content.
1. Provideuser SYs REPO with object privilege SELECT, with option "Grantable to others", on the
following physical DB schemas:
o Physical database schema of your back-end system, typically this is called SAP<SID>.
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o Physical database schema that contains the SAP ERP tables
You can use the following example SQL statement to grant the required privilege:
GRANT SELECT ON SCHEMA <Your schema name> TO _SYS REPO WITH GRANT OPTION;
2. Assign the required privileges described in section Authorization Requirements for the UDF AFL, of the
SAP Customer Activity Repository Security Guide.
2. Use transaction SE38 to run program /RAP/ACTIVATE HANA CONTENT.
The program activates the remaining SAP HANA content (views and stored procedures) required by SAP
Assortment Planning for Retail.

Log on to SAP HANA studio.
Open the Modeler and use the Navigator to access your back-end system.
Expand the Content folder located under your system name in the Navigator.

o ok w

Expand the package listed below:
O sap.is.retail.rap
All the content in the underlying folders should be active.

More Information

Section Activating Objects, of the SAP HANA Developer Guide SAP

4.2.3.3.2.5 Verify Activation of External Views

Use

During activation of SAP HANA content for SAP Assortment Planning for Retail, several external views are not
automatically activated. Following an upgrade, you need to verify that all previously activated external views
remain active.

Procedure

1. Use either transaction SE11 or SE80 to verify that all the external views listed in SAP Note 2067030#% are
in an activate state. If they are not, manually activate the views.
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4.2.3.3.3 Maintain Customizing Table /RAP/RS_VARCUST

Use

In this procedure, you maintain entries in the variable customizing table /RAP/RS_VARCUST in the back-end
system. For each SAP Assortment Planning for Retail query, the entries of this table specify a mapping of a
data version (for example, actual data versus planning data) to the source of data (InfoCube).

Procedure

1. Log on to your back-end system.

2. Runreport /RAP/SEED BW CUSTOMIZING DATA (transaction SE38).

3. Determine whether you want to overwrite the existing entries in the /RAP/RS_VARCUST table.
If you do want to overwrite the contents of the table, enable the Remove Existing Entries option. If you don't
want to overwrite the contents of the table, but want to append the new entries, disable the Remove
Existing Entries option.

i Note

Duplicate entries that can potentially be created if you choose to disable the Remove Existing Entries
option, which will result in an error.

4. Enable the Test option and choose Execute to run the report in test mode.
Running the report in test mode allows you to verify that you can successfully update the /rRaP/
RS VARCUST table. No entries are persisted in the table as a result.
5. Once you have successfully executed the /RAP/SEED BW CUSTOMIZING DATA report in test mode,
disable the Test option and choose Execute to run the report.
6. Optionally, once the report has finished executing, you can verify the entries of the /RAP/RS_VARCUST
variable customizing table.
If required, you can make changes to any of the entries made by the /RAP/SEED BW CUSTOMIZING DATA
report by doing the following:
1. Open the Data Browser (transaction SE16).
2. Enter /RAP/RS_VARCUST in the Table Name field and choose Create Entries.

3. Choose Execute followed by Create.
On the Table /RAP/RS_VARCUST Insert screen, you will be able to make the following entries:

Field Name User Entry

COMPID SAP Assortment Planning for Retail technical query name.

For example, /RAP/M01A02_TIRQ02.

VNAM ICUBE InfoCube variable name.

For example, /RAP/INFOPROV_ESM 01.
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Field Name User Entry

INFOCUBE InfoCube identifier.

For example, /RAP/RCO1.

VNAM VERS Version variable name.

For example, /RAP/VERSN MSM 01.

VERSION Version |dentifier.

There are several supported planning versions:

o AP1:Location level version 1. Version that is typically used as the planning version.

o ap2:Location level version 2. Version typically used to simulate different scenarios without
having to change your planned version.

o awl: Week level version 1. Version that is typically used as the planning version.

o aw2: Week level version 2. Version typically used to simulate different scenarios without hav-
ing to change your planned version.

o oc1: Option plan by cluster simulation version 1. Version that is typically used as the plan-
ning version.

o oc2: Option plan by cluster simulation version 2. Version typically used to simulate different
scenarios without having to change your planned version.

o oM1: Option plan by module simulation version 1. Version that is typically used as the plan-
ning version.

o oM2: Option plan by module simulation version 2. Version typically used to simulate different
scenarios without having to change your planned version.

o APF: Final version (planned data). After completing the planning, the user will select the
plan they want to finalize and review in the Plan Weekly Sales and Receipts workbook. Only
the APF version is available in Plan Weekly Sales and Receipts.

o REF: Reference version (past data). This is historical data for the items from the time frame
of the reference period. This data is used to pre-populate the planning version by using the
copy function. This allows the planner to have a baseline when starting the planning proc-
ess. It is recommended to seed the planning version with the REF data.

o 000: Actual version (current data). The user can see current inventory values with this such

as Actual Inventory and Open Orders.

F4HELP Flag that specifies whether the field provides F4 help or not.

4. Maintain entries in the /RAP/RS_VARCUST table as required.
For example you can change the InfoCube used as the source of data for a particular planning version.
5. Choose Save.

Common Upgrade Guide for SAP Customer Activity Repository retail applications bundle 1.0
SPS7
Upgrade Scenarios PUBLIC 129



4.2.3.3.4 Update Fiscal Year Variant Entries

Use

In this procedure you update previously maintained fiscal year variants ( OFISCVARNT 'RW'). The SAP
Merchandise Planning for Retail application, which can be used in conjunction with the SAP Assortment
Planning for Retail application, only supports fiscal years with 52 posting periods. As a result, fiscal year variant
entries must be adjusted, entering each year with 53 posting periods as a shortened fiscal year.

A\ Caution

You must maintain fiscal year variants for at least one year past the years for which you are planning. For
example, if your assortment plans extend to December 2018, you must maintain fiscal year variants until
December 2019.

The steps provided in this procedure allow you to maintain 0OFTSCVARNT 'RW' using the standard 4-5-4
calendar entries. If you are using alternative fiscal periods in your retail business, for example, each week
starting on a Sunday instead of Saturday, you can provide your own entries instead of the ones suggested in
this guide.

Procedure

1. Logon to your back-end system.
2. Launch fiscal year variant maintenance (transaction GVAR).

3. Choose New Entries.
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4. Onthe New Entries: Overview of Added Entries screen make the following sets of entries:

Fiscal year variants

FV  Description Year-depen... Calendar yr Number of postin... No.of special peri
BW Assort. Plan Week v O 53 -
r -

Create New Fiscal Year Variant
5. Choose Enter.
An information message is displayed about creating more than 16 periods, choose Continue.
6. Choose Back.
You can see the newly created entry.

7. Mark the entry RW and double-click on Shortened Fiscal Years from the Dialog Structure.

8. Enter 2012 inthe Fiscal year field and choose Continue.

9. Choose New Entries.

10. Enter 52 in the No. of posting periods field in the Shortened Fiscal Years section.

11. Choose Back twice.

12. Open SAP Note 2112634#% , locate the entries for year 2012, and enter the data by copy-and-paste.

13. Repeat steps 7-12 to maintain the weekly fiscal year variant for years 2013, 2014, 2015, 2016, 2017, 2018,
2019, and 2020, entering each year as shortened fiscal year. The corresponding tables are available in SAP
Note 2112634 # .

14. Choose Save after you have finished the maintenance for year 2020.
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4.2.3.3.5 Set Language for Ribbons and Buttons in
Workbooks (Optional)

Use

In this optional procedure, you can change the language settings specific to SAP Assortment Planning for
Retail workbooks. During the upgrade, some of the workbooks are updated, and, if you have previously
changed the language settings of these workbooks, you need to make these settings again following the
upgrade.

You can set the desired language of the following user interface objects:

® Ribbons Planning Functions, Refinement Functions, and Extended Features
® Tooltips for planning functions

® Message texts

e Buttons

The content of the workbooks consists of multiple parts:

e The language of the standard menus and standard ribbons depends on the language set for Microsoft
Excel.

e The language of the contents in the cells (mainly KPIs) depends on the user-selected system language of
the back-end system.

e The language of the user interface objects that are specific to the workbooks of SAP Assortment Planning
for Retall, is not set by the selected system language of the back-end system, but you can change it for
each workbook according to the following procedure. The default language is English.

Procedure

1. Unhide the worksheet SAP_TEXT_CUSTOMIZING using standard functionality of Microsoft Excel.

2. Onthe worksheet SAP_TEXT_CUSTOMIZING, copy the column of the desired language to column B -
Custom Text.

3. Hide the worksheet SAP_TEXT_CUSTOMIZING.

4. Save your changes in the worksheet on the SAP NetWeaver Server by choosing |» File » Analysis » Save
Workbook to SAP NetWeaver

4.2.3.3.6 Verify that Data Replication is Running Following
the Upgrade

In general, following the upgrade, you need to ensure that all of the data replication described in Configure Data
Replication section of the Common Installation Guide is still running.
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In particular, you need to pay attention to the following:

Ensure that time-dependent article hierarchies are properly loaded into SAP Assortment Planning for
Retail following the upgrade. See Load of Time-Dependent Article Hierarchies section of the Common
Installation Guide.

All the tables listed in SAP Note 2054656#% are being replicated. New tables can be added with each new
release.

Ensure that periodic tasks to load product attributes into SAP Assortment Planning for Retail are still
running following the upgrade. See, Load Product Attributes into SAP Assortment Planning for Retail section
of the Common Installation Guide.

Ensure that OTB data is being loaded from the appropriate source. For more information, see the Load
Merchandise Planning Data section of the Common Installation Guide.

4.2.3.3.7 Run the Validation Report

Run transaction SE38.
Execute the /DMF/VALIDATE CAR INSTALLATION report.

3. Select the Assortment Planning scenario and select Execute.

Running this report allows you verify the success of the installation, providing a log of potential issues. For
example, you may be presented with the following results:

[ Display logs x

R = e S A =) 09 509 =~ | P Py (BT

Type Message Text LTxt
— Check - Installed SAP Notes

- Check - Planning Application Kit (PAK)

--- Check - Fiscal Calendar

Maintain fiscal year variant 'RW'. &
— Check - SAP HANA Time Dimension

Maintain SAP HANA time dim. at least 2 years back and 5 years in future. (2]
— Check - Table /RAP/RS_VARCUST

— Check - BI Master Data for Planning Versions

- Check - BI Technical Content Activation

--- Check - BI APR Content Activation

-~ Check - SAP HANA AFL PAL

— Check - SAP HANA AFL OFL

ODDDD0DCE D@00 D

.
@ }ﬂf Technical Information JEl Help J@

Validation Report Results

View the long text associated with each message to see the link to the documentation describing the
procedure you need to troubleshoot.
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4.2.3.3.8 Configure Index Calculation

Use

The SAPUIS application index provides an indexing and caching mechanism for information related to SAPUIS
apps, components, and libraries that are contained in SAPUI5 repositories on the SAP NetWeaver Application
Server for ABAP. This index, calculated by the Calculation of SAPUI5 Application Index for SAPUI5 Repositories
report ( /UI5/APP_INDEX CALCULATE), makes it possible to retrieve and find this information significantly
faster than when carrying out the calculations each time it's requested.

We recommend that you schedule the Calculation of SAPUI5 Application Index for SAPUI5 Repositories report
as to run as a background job on your front-end server.

Following any changes to the content of the SAPUI5 ABAP repository (for example, installation of a new version
of the SAPUI5 distribution layer or implementation of an SAP Note containing changes to an SAPUI5 app), the
SAPUI5 application index should be updated using the calculation report. This report has to be executed in
every system whenever the content of the SAPUI5 ABAP repository has changed.

Procedure

1. Determine the SAP NetWeaver version on your front-end server.
2. Carry out the instructions specific to your SAP NetWeaver version:
o SAP Gateway for SAP NetWeaver 7.31
o http:/help.sap.com/nw-uiaddon20#& ¢ Application Help » SAPUI5: Ul Development Toolkit for
HTML5 » Developing Apps # The SAPUI5 ABAP Repository and the ABAP Back-End Infrastructure
» SAPUI5 Application Index J
o  SAP Gateway for SAP NetWeaver 740
o http:/help.sap.com/nw74f |l Application Help » Ul Technologies in SAP NetWeaver with SAP_UI
740 ¥ SAPUI5: Ul Development Toolkit for HTML5 # Using the SAPUI5 Repository # SAPUI5

Application Index 3
Alternatively, you can launch the Calculation of SAPUI5 Application Index for SAPUI5 Repositories

report ( /UT5/APP_TINDEX CALCULATE)from Customizing under | SAP NetWeaver » Ul
Technologies ¥ SAP Fiori ¥ Initial Setup ¥ Schedule SAPUI5 Application Index Calculation 4.

4.2.3.3.9 Activate SAP Assortment Planning for Retail
OData Services

Use

A number of OData services are required to run the SAP Assortment Planning for Retail application.
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For security reasons, all OData services are delivered in an inactive state. You must activate these application-
specific OData services to use the SAP Fiori user interface of the SAP Assortment Planning for Retail
application.

Procedure

1. Logon toyour front-end system (your SAP NetWeaver system).
2. Goto Customizing (transaction SPRO).
3. Navigate to |* SAP NetWeaver » Gateway p OData Channel » Administration » General Settings  Activate
and Maintain Services .
You are presented with the service catalog. This is a list of all the services that are currently active on your
SAP Gateway.
4. Get SAP Assortment Planning for Retail OData services:
1. Choose Add Service.
The Add Service screen is displayed.

2. Enter the system alias of your back-end system.
This is the alias created for your back-end system in the Connect SAP NetWeaver Gateway to your
Back-End System [page 48] procedure. For example RAPCLNT100.

3. Enter /DMF* in the Technical Service Name field.

4. Choose Get Services.
The Add Selected Services screen is displayed.

5. Select the SAP Assortment Planning for Retail OData services you would like to activate, and choose
Add Selected Services.

OData Service

/DMF/CURRENCY LIST SRV

/DMF/LOCATION CLUSTERSET SRV

/DMF/MODULE_MANAGEMENT SRV

/DMF/0OBJ_ATTRIBUTE SRV

/DMF/SEARCH LOCATIONS SRV

/DMF/SEARCH PRODUCTS SRV

/DMF/SEASONS_SRV

/DMF/MASTER_DATA SRV

The selected OData services are now active in your SAP Gateway.

6. Enter /RAP* in the Technical Service Name field.

7. Choose Get Services.
The Add Selected Services screen is displayed.
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8. Select the SAP Assortment Planning for Retail OData services you would like to activate, and choose
Add Selected Services.

OData Service

/RAP/ASSORT AUTOMATIC PROP SRV

/RAP/ASSORT LIST MODULE SRV

/RAP/ASSORTMENT PLAN SRV

/RAP/OPTION PLAN SRV

/RAP/PHP_MATCH_ SRV

/RAP/SADL PROD LIST KPI SRV

The selected OData services are now active in your SAP Gateway.

More Information

For SAP NetWeaver 7.31, see SAP Library for User Interface Add-On 1.0 on SAP Help Portal at http:/
help.sap.com/nw-uiaddon20#& |+ Application Help » SAP Fiori Launchpad j Setting Up the Launchpad »
Activating SAP Gateway OData Services 4.

For SAP NetWeaver 74, see the documentation on SAP Help Portal at http://help.sap.com/nw74 Fr |l
Application Help » Ul Technologies in SAP NetWeaver with SAP_UI 740 » SAP Fiori Launchpad ¥ Setting Up the
Launchpad ¥ Activating SAP Gateway OData Services 4.

4.2.3.3.10 Activate SAP Assortment Planning for Retail ICF
Services

Use

For security reasons, all Internet Communication Framework (ICF) services relevant to your SAP Assortment
Planning for Retail application are made available in an inactive state.

You have activated the central ICF services in the Perform General SAP NetWeaver Gateway Configuration
[page 48] and Configure Central Ul Component [page 51] procedures. This procedure provides the instructions
to activate ICF services required for the SAP Assortment Planning for Retail SAP Fiori apps.
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Procedure

1. Log on to your front-end server.

2. Open service maintenance (transaction SICF).

3. Inthe Maintain Service screen, select the Location Clustering service by specifying the following:

o

o

Hierarchy Type: SERVICE

Virtual Host: DEFAULT_HOST

o Service Path: /sap/bc/ui5_ui5/sap/locclsts_v2/

4. Choose Execute.

o

To activate the service, choose Service/host Activate.

6. Repeat steps 3 to 5 to ensure that all of the following services are activated:

o

o

e}

/sap/bc/ui5 uiS/sap/attribmgmt v2/
/sap/bc/uib uiS5/sap/assortmodule v2/
/sap/bc/uib uiS/sap/assortplan v2/
/sap/bc/ui5 uib5/sap/ddfreuse v2/
/sap/bc/uib5 uiS/sap/locclsts v2/
/sap/bc/uib ui5/sap/modulemgmt v2/
/sap/bc/uib5 uiS/sap/optionplan v2/
/sap/bc/uib5 uiS/sap/phpmatch _v2/

4.2.3.3.11 Define System Alias for Back-End Transactions

Use

A number of SAP Assortment Planning for Retail SAP Fiori apps, installed on your front-end system, launch
transactions directly on the back-end system. For example, the Manage Products tile actually launches the

Demand Data Foundation (DDF) powL EASY WebDynpro application.

To enable this behavior, you need to create a dedicated RFC connection between the front-end and the back-

end systems.

Procedure

1. Logon toyour front-end system, that is, the system where you have installed the user interface (Ul)
components of the SAP Assortment Planning for Retail application.

2. Launch Configuration of RFC Connections (transaction sM59).

3. Create an RFC connection with the RFC Destination set to SAP_ISR_CARAB and Connection Type set to H

(HTTP connection).
Ensure to maintain all of the settings required to connect to your back-end system, in particular, the Target
Host entry on the Technical Settings tab.

4. Create another RFC connection with the RFC Destination set to SAP_ ERP ISR CARAB and Connection

Type set to # (HTTP connection).
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Ensure to maintain all of the settings required to connect to your front-end system to the SAP ERP system,
in particular, the Target Host entry on the Technical Settings tab.

o

Save your changes.

N o

Open Launchpad Customizing (transaction LPD CUST).

Select the SAP Assortment Planning for Retail role (UTRAP001), and choose Display.

The two catalogs, Assortment Planner and Planning Administrator, are displayed.

8. Ineach of the catalogs, selecting one app at a time, make the following settings:

Catalog App

System Alias

Description

Assortment View Log
Planner

SAP ISR CARAB

This setting allows the My Assortment Plans (Version 2)
app to launch transaction SL.G1 on the back-end system.

i Note

This application is only used to configure a link to
the back-end system, you do not need to add this
app to your SAP Fiori launchpad.

View ExtAssort
Listing Conditions

SAP_ERP ISR CAR This setting allows the My Assortment Plans (Version 2)

AB

app to launch transaction wsL.10 on the connected SAP
ERP system.

i Note

This application is only used to configure a link to
the SAP ERP system, you do not need to add this
app to your SAP Fiori launchpad.

View External
Assortments

SAP_ERP ISR CAR This setting allows the My Assortment Plans (Version 2)

AB

app to launch transaction WRF_WSOA3 on the connected
SAP ERP system.

i Note

This application is only used to configure a link to
the SAP ERP system, you do not need to add this
app to your SAP Fiori launchpad.

Assortment Manage Category
Planner responsibilities

SAP_ISR_CARAB

This setting allows the Manage Category Responsibilities
app to launch the corresponding DDF WebDynpro appli-
cation.

Manage Products

SAP ISR CARAB

This setting allows the Manage Products app to launch
the corresponding DDF WebDynpro application.

Manage Locations

SAP ISR CARAB

This setting allows the Manage Locations app to launch
the corresponding DDF WebDynpro application.
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4.2.3.3.12 Troubleshoot Front-End Server Upgrade

Use

Following the upgrade of the product version on the front-end server, you may not be able to see some of the
SAP Assortment Planing for Retail 1.0 FP3 SAP Fiori tiles in your launchpad. This section outlines how to
troubleshoot these issues, should you experience them.

These steps are also listed in the Troubleshooting section of the SAP Assortment Planing for Retail
Administrator's Guide available on the SAP Help Portal at http://help.sap.com/rap# | <Your Release> »

System Administration and Maintenance Information » Administrator's Guide 3.

Process

Do the following:

1. Check that all of the required BSP applications are listed in the UTRAP001 package.

Log on to your front-end system (your SAP Gateway system).

Launch the Object Navigator (transaction SE80).

In the Repository Browser, open package UTRAP0O1.

Expand all of the embedded packages of embedded package CONTENT RAP TRANS.

o~ w D=

Verify that the following BSP Applications are listed:

Package v ~
[uIRAPOO1 >[4 v
@ L= L=la] & 13 E
Object Name Description
~ [ UIRAPOO1 Structure package for UIRAP
~ [ Subpackages
+ 2] CONTENT_RAP_COMMON Main package for common obejcts for RAP
~ [ CONTENT_RAP_TRANS Main package for transactional for RAP
~ [ Subpackages
~ [ RETAIL_DDF Package for DDF
~ [ BSP Lbrary
~ [ BSP Applications
» CIATTRIBUGMT_V2 Manage Product Attriubtes: Fiori ID FO829A |
» 3 DDFREUSE_V2 Fiori Reuse Components for DDF: Fiori 1D FO854A
» 1 LOCCLSTS_V2 Location Clustering: Fiori ID FO550A
» (11 MODULEMGMT_V2 Module Management: Fiori ID F1682A
~ [= RETAIL_RAP_AP Package for RAP AP
~ [ BSP Library
= [ BSP Applications
» DASSORTMODULE7V2 Assortment Module: Fiori ID F1567A
» I_:IASSORTPLAN,VZ Assortment Plan: Fiori ID FO551A
» 1 OPTIONPLAN_V2 Option Plan: Fiori ID FOB30A
» [[T1PHPMATCH_v2 PHP Matching: Fiori ID FO831A

BSP Applications
6. If you do not see one or more of the BSP applications listed above, right-click on each of the

RETATL_DDF and RETATL_ RAP_ AP packages, and select B Other Functions # Rebuild Object List 1.
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A\ Caution

Do not rebuild objects on a higher package level.

2. Cleanthe cache.
1. Logon to your front-end system (your SAP Gateway system).
2. In Customizing (transaction SPRO), navigate to | SAP NetWeaver » Ul Technologies ¥ SAP Fiori

Data Administration ¥ Invalidate Caches 3.

This activity launches the /UI2/INVALIDATE GLOBAL CACHES report. This report invalidates all
server-side caches in SAP NetWeaver user interface services, which can become out-of-date following
an upgrade.

3. If necessary, implement instructions listed in SAP Note 2147669 ¥,

3. Remove any previously customized versions of the UTRAP001 launchpad.

1. Logon to your front-end system (your SAP Gateway system).

2. Launch the Overview for Launchpads (transaction LPD_CUST).

3. Search for Role UIRAP001, and see whether any instances exist where the User Name is not SAP. If so,
this means that customized versions of the UIRAP001 launchpad exist, and these take precedence
over the standard launchpad instance delivered by SAP.

4. Delete all but the launchpad instance delivered by SAP.

4.2.4 1.0 FP2 to 1.0 SP5

This section is intended for existing SAP Assortment Planning for Retail customers who have installed and
configured SAP Assortment Planning for Retail 1.0 FP2 and would like to upgrade to SAP Assortment Planning
for Retail 1.0 SP5.

4.2.4.1 Quick Guide

This section includes a checklist with all actions that you have to perform. The actions are in chronological
order, so that you can work through them like a checklist.

Checklist

Prerequisites
Mandatory Steps

[] Ensure that you have implemented the necessary SAP Notes listed in the SAP Notes for the Upgrade
section.

[J Ensure that your landscape meets the requirements outlined in the Prerequisites section.

Preparation
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Mandatory Steps

g
O

O

Configure AFL and OFL usage.

Verify that you have all of the required SAP HANA users and privileges. See Verify SAP HANA Users and
Privileges [page 83].

Configure AFL and OFL usage. See Enable Usage of PAL Functions [page 86] and Check the OFL
Installation [page 87].

Upgrade Process

Mandatory Steps

O

O
U
O

Implement SAP Note 2298340 if your landscape includes a NW version earlier than NW 740 SP15.
You must perform this step prior to upgrading the back-end system product version.

Upgrade your back-end system product version in SAP Solution Manager.
Upgrade the application function libraries (UDFAFL INST 100, POSAFL INST 100).

Upgrade or install product-specific SAP Fiori Ul components on the front-end server.

Follow-Up Activities

Mandatory Steps

O
O

Oooo0oo4goooooogood

Create SAP ERP tables.

Verify SAP HANA and back-end system roles. See the Verify Users, Privileges, and Roles section in the
Common Installation Guide.

Adjust Customizing settings.

Reactivate SAP Assortment Planning for Retail planning framework content.
Maintain Customizing table /RAP/RS VARCUST.

Update fiscal year entries.

Optionally, restore language settings in workbooks.

Verify that data replication is running following the upgrade.

Run the SAP Assortment Planning for Retail 1.0 FP3 update report.

Run the validation report.

Configure index calculation.

Activate SAP Assortment Planning for Retail OData services.

Verify that all the ICF services relevant to SAP Assortment Planning for Retail are active following the
upgrade.

Define system alias for back-end transactions.

Troubleshoot front-end server upgrade.
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4.2.4.2 Upgrade Process

42421 Implement SAP Note 2298340

Use

Prior to upgrading the CAR RETAIL APPL BUNDLE 1.0 back-end product version from an older support
package stack (SPS) to a newer one, you need to verify the SAP NetWeaver 740 SPS in your system landscape.
Important corrections, relevant for Core Data Services (CDS) views, and required by the latest SPS of cAR
RETAIL APPL BUNDLE 1.0, are only available as of SAP NetWeaver 740 SPS 15.

Procedure

1. Verify your SAP NetWeaver 740 support package stack.
If your landscape contains SAP NetWeaver 740 SPS 12, SPS13, or SPS14, you will need to implement SAP
Note 2298340#% to apply corrections relevant for CDS views.
If your landscape has been upgraded to SAP NetWeaver 740 SPS 15, you do not need to implement SAP
Note 2298340#% , and you can go to the next procedure.

2. Read and implement SAP Note 2298340 prior to upgrading the back-end system product version.

More Information

http://help.sap.com/hana_platform#|» Development and Modeling » SAP HANA Modeling Guide (For SAP
HANA Studio)

42422 Upgrade SAP Customer Activity Repository Retail
Applications Bundle

Use

This procedure describes how to upgrade the CAR RETAIL APPL BUNDLE 1.0 back-end product version
from an older support package stack to a newer one.
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Procedure

1. Check your upgrade scenario:
1. Navigate to the Product Availability Matrix (PAM) at http:/support.sap.com/pam#te .

2. Forinformation about the available support package stacks (SPS), search for the CAR RETAIL APPL
BUNDLE 1.0 product version, and choose Support Package Stacks.

3. Forinformation about the supported upgrade paths, choose Related Product Versions.

4. For information about the software components in the SPS, choose Technical Release Information and
consult the subsections, such as Database Systems.

5. To navigate directly to the download area for the SPS, choose [ SAP Software Download Center » CAR

RETAIL APPL BUNDLE 1.0 - Support Packages & Patches 3.
Alternatively, you can get there from the SAP Support Portal by choosing http://support.sap.com/

swdc# | Support Packages and Patches » Software Downloads j SUPPORT PACKAGES & PATCHES »
By Alphabetical Index (A-Z) » C » CAR RETAIL APPLICATIONS BUNDLE » CAR RETAIL APPL BUNDLE
103
2. Patch the support package stack using the Support Package Manager tool (transaction spaMm).
For more information about this tool, see SAP Help Portal at http://help.sap.com/spmanager

| Application Help 3, as well as SAP Note 18039867 .

To finalize the upgrade of the back-end product version, you must additionally do some manual steps. Continue
with the next section.

Download and Install the Application Function Libraries (AFLs)

There are two components that you cannot upgrade using Support Package Manager.

e Unified Demand Forecast application function library (UDF AFL, software component version
UDFAFL_INST 100, provides the demand modeling and forecasting services in SAP Customer Activity
Repository, runs directly in the SAP HANA database)

e On-Shelf Availability application function library (POS AFL, software component version POSAFL_INST
100, provides the On-Shelf Availability services in SAP Customer Activity Repository, runs directly in the
SAP HANA database)

You need to download one UDF AFL revision and one POS AFL revision manually and install them together in
your SAP HANA database.

Where to Download

Both AFLs are provided as part of the CAR RETAIL APPL BUNDLE 1.0 product version onthe SAP Support
Portal under http://support.sap.com/swdc#|» Support Packages and Patches j» Software Downloads »
SUPPORT PACKAGES & PATCHES ¥ By Alphabetical Index (A-Z) » C » CAR RETAIL APPLICATIONS BUNDLE ¥
CAR RETAIL APPL BUNDLE 1.0 }» Entry by Component » Analytics AFL 3.

For a successful upgrade, you need to be aware of the following dependencies.
Dependencies Between the AFLs and the SAP HANA Database

The AFLs are released independently of the releases of SAP Customer Activity Repository retail applications
bundle. This is because the AFLs follow the release cycle of the SAP HANA database. The releases are called
“revisions”. Whenever a new revision of the SAP HANA database is released, a new revision of each AFL is

released. As a result, multiple revisions of each AFL are available on the SAP Support Portal at any one time.
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A Caution

For each revision of an AFL, there is only one compatible revision of the SAP HANA database. For example,
you can only use revision 112.20 of the UDF AFL with revision 112.02 of the SAP HANA database. Whenever
you upgrade an AFL, you must also upgrade the database and any other AFLs to the compatible revisions.
Reversely, whenever you upgrade the database, you must upgrade the AFLs.

Note that this dependency applies not only to the UDF AFL and the POS AFL but also to the generic SAP
HANA AFL. Both the SAP HANA AFL and the SAP HANA database are components of the SAP HANA
Platform (see Prerequisites [page 16]).

When you download an AFL revision from the SAP Support Portal, the compatible revision of the SAP
HANA database is indicated.

Nomenclature

The following table explains how you can see the dependencies by looking at the release numbers:

Release of ... Released as ... Example Guideline

SAP HANA Platform <Support Package Stack> SAP HANA Platform SPS11 ~ The number of the support
package stack determines
the first digits of the revi-
sions.

SAP HANA Database <Revision>.<Patch> SAP HANA Database 112.02  All 11x.xx database revisions

belong to the SPS 11 plat-
form stack.

The patch number deter-
mines the first digit of the
AFL patch.

UDF AFL

POS AFL

SAP HANA AFL

<Revision>.<Patch>

UDF AFL112. 20

POS AFL112. 20

SAP HANA AFL 112. 20

- Recommendation

We recommend that you upgrade all the AFLs at the same time. This means:

e UDF AFL and POS AFL, which you must both install for a successful upgrade of SAP Customer Activity
Repository retail applications bundle

e SAP HANA AFL, which is one of the mandatory prerequisites

e ifapplicable, other AFLs provided with SAP HANA that might be relevant for your scenario

Focus on the AFL that provides the most important functionality for your scenario (for example, demand
forecasting with the UDF AFL). Select the best revision of that AFL for your scenario. This in turn will give
you the compatible revision of the SAP HANA database and the compatible revisions of the other AFLs.

Then install all the AFLs together.

Download and Install the UDF AFL (Focus: Demand Forecasting)
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1. Select an AFL revision.
Multiple revisions are available on the SAP Support Portal. For guidance on selecting the best revision for
your Unified Demand Forecast scenario, see the following:

o Prerequisites [page 16]: Indicates the minimum revision of the AFL and the SAP HANA Platform for
this release.

o SAP Note 2088924 : Release Information Note (RIN) for SAP Customer Activity Repository retail
applications bundle 1.0.

o SAP Note 2050229#% : Gives you an overview of all UDF AFL revisions as of revision 82 and provides
instructions for downloading, installing, and upgrading the UDF AFL.
o  SAP-HANA-related information:

o Release and maintenance strategy of the SAP HANA Platform at http://support.sap.com/swdc#
| Support Packages and Patches # Software Downloads » SUPPORT PACKAGES & PATCHES ¥ By
Alphabetical Index (A-Z) » H » SAP HANA Platform Edition ¥ Info J

o SAP Note 2021789#% : SAP HANA Revision and Maintenance Strategy

o SAP Note 2227464 : SAP HANA Platform SPS 11 Release Note

o SAP Note 1948334 #%: SAP HANA Database Update Paths for Maintenance Revisions

o SAP Note 1914052#: Dependencies between SAP NetWeaver and the SAP HANA Database

2. Download and install your AFL revision (together with the other AFLs) as described in SAP Note 2050229
.

i Note

To use the UDF functionality in your implementation scenario, you must additionally do some post-
installation steps. For more information, see Configure Unified Demand Forecast (Optional) [page 64].

Download and Install the POS AFL (Focus: On-Shelf Availability)

1. Select an AFL revision.
Multiple revisions are available on the SAP Support Portal. For guidance on selecting the best revision for
your On-Shelf Availability scenario, see the following:

o Prerequisites [page 16]: Indicates the minimum revision of the AFL and the SAP HANA Platform for
this release.

o SAP Note 2088924 #% : Release Information Note (RIN) for SAP Customer Activity Repository retail
applications bundle 1.0.

o SAP Note 2056102#% : Gives you an overview of all POS AFL revisions as of revision 82 and provides
instructions for downloading, installing, and upgrading the POS AFL.
o SAP-HANA-related information:

o Release and maintenance strategy of the SAP HANA Platform at http:/support.sap.com/swdc#
| Support Packages and Patches ¥ Software Downloads » SUPPORT PACKAGES & PATCHES ¥ By
Alphabetical Index (A-Z) » H » SAP HANA Platform Edition j Info 3

o SAP Note 2021789#% : SAP HANA Revision and Maintenance Strategy

o SAP Note 2227464#% : SAP HANA Platform SPS 11 Release Note

o SAP Note 1948334 #%: SAP HANA Database Update Paths for Maintenance Revisions

o SAP Note 1914052#% : Dependencies between SAP NetWeaver and the SAP HANA Database

2. Download and install your AFL revision (together with the other AFLs) as described in SAP Note 2056102
i
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i Note

To use the On-Shelf Availability functionality in your implementation scenario, you must additionally do
some post-installation steps. For more information, see Configure On-Shelf Availability (Optional) [page
53].

Result

You have successfully upgraded the CAR RETATL APPIL BUNDLE 1.0 back-end product version to the current
SPS. Continue with the next section.

4.2.4.2.3 Upgrade Product-Specific SAP Fiori Ul
Component

Use

This procedure describes how to upgrade the SAP FIORI FOR SAP CARAB front-end product version from an
older support package stack to a newer one.

The ABAP front-end server contains the complete Ul layer, which consists of the SAP Gateway, the central SAP
Fiori Ul component, and the product-specific SAP Fiori Ul component. The product-specific SAP Fiori Ul
component contains all the SAP Fiori user interfaces for the applications provided for the SAP Customer
Activity Repository retail applications bundle.

Procedure

1. Identify the support package stack on the SAP Support Portal at http:/support.sap.com#| Software
Downloads # Support Packages and Patches # Software Downloads » By Alphabetical Index (A-Z) ¥ F
SAP FIORI » SAP FIORI FOR SUITE » SAP FIORI FOR SAP CARAB » SAP FIORI FOR SAP CARAB 2.0
SPS01 1.

For more information on support package stacks, see http:/support.sap.com/sp-stacks .
2. Patch the support package stack using the Support Package Manager tool (transaction spam).

For more information, see SAP Help Portal at http:/help.sap.com/spmanager#& |} Application Help 3, as
well as SAP Note 1803986 # .

A\ Caution

As of the FP3 release, software components UTSCARO1 and UTRAP0OO1 have been merged into one,
UICARO001, software component.
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3. If you are using SAP Assortment Planning for Retail, consult SAP Note 2077357#% , which lists the SAP
Notes relevant for your release.

42.4.3 Follow-Up Activities
4.2.4.3.1 Create SAP ERP Tables

A Caution

Following an upgrade, it is important to remember to create any additional tables required by the new
release.

Tables required to be created as of the SAP Assortment Planning for Retail are listed in SAP Note 2263205 # .
Ensure that all tables listed in this note have been created.

42432 Adjust Customizing Settings

Use

Following the upgrade, you need to make settings in Customizing to be able to use SAP Assortment Planning
for Retail 1.0 FP3.

Procedure

1. Log on to your back-end system.
2. In Customizing (transaction SPRO), navigate to |+ Cross-Application Components » Assortment Planning
for Retail » Imported Demand Data Foundation Settings ¥ Integration » Sending System and Master Data

System Coupling 4.

As of FP3, a new column HTTP Destination has been added. You must specify an entry for a relevant SAP
ERP system, including a valid HTTP Destination value, to be able to access SAP ERP assortments and
listing conditions from My Assortment Plans (Version 2) app.
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4.2.4.3.3 Reactivate SAP Assortment Planning for Retail
Planning Framework Content

4.2.4.3.3.1 Activate SAP HANA Content

Use

In this procedure, you activate all SAP HANA content required by SAP Customer Activity Repository.

For more information about activating SAP HANA content, see SAP Help Portal at http:/help.sap.com/
hana_platform#& | <your SAP HANA Platform SPS> » Development and Modeling » SAP HANA Developer
Guide (For SAP HANA Studio) » Setting Up the Analytic Model ¥ Creating Views # Activating Objects 3.

Prerequisites

e Asamandatory prerequisite for a successful activation of the SAP HANA content for SAP Customer
Activity Repository, you must have successfully completed all of the procedures listed in the previous
sections of this guide.

e You must also set up the roles and privileges for the Unified Demand Foreast module as described in the
Authorization Requirements for the UDF AFL section of the SAP Customer Activity Repository Security
Guide, available at http:/help.sap.com/carlp <your release> ¥ Security Information .

You must do this regardless of whether you want to use UDF forecasting in your scenario or not. This
procedure not only enables UDF, but it is required so that the SAP HANA content for SAP Customer
Activity Repository can be activated correctly.

Procedure

To activate the SAP HANA content, carefully follow the instructions provided in SAP Note 2330386 .

A\ Caution

If you are applying a support package or correction on an existing installation and this support package or
correction involves SAP HANA content for the DDF module or the UDF module in SAP Customer Activity
Repository, then you must manually activate this content again. For example, this is the case when you
apply an SAP Note using transaction SNOTE.

Follow the instructions in SAP Note 2145356 #% .

More Information

If you encounter issues during the activation, see the Troubleshooting [page 75] section for possible solutions.
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4.2.4.3.3.2 Activate SAP HANA Content for SAP Assortment
Planning for Retail - Part 1

Use

In this procedure, you perform the initial activation of SAP HANA content (views and stored procedures)
required by the SAP Assortment Planning for Retail application.

A Caution

This initial activation results in a partial activation of the SAP HANA content for SAP Assortment Planning
for Retail. Several SAP HANA views depend on local Bl Content objects, and as such, have to be activated
following the activation of these Bl Content objects. For more information, see Activate SAP HANA Content
for SAP Assortment Planning for Retail - Part 2 [page 102].

Prerequisites

As a mandatory prerequisite for a successful activation of SAP HANA content for SAP Assortment Planning for
Retail, you must have successfully completed all of the procedures listed in the previous sections of this guide.
In particular, you must have activated SAP HANA content for SAP Customer Activity Repository.

Procedure

1. Ensurethatthe svys REPO user has the authorizations required to successfully activate SAP HANA
content.
1. Provideuser sys REPO with object privilege SELECT, with option "Grantable to others”, on the
following physical DB schemas:
o Physical database schema of your back-end system, typically this is called SAP<SID>.
o Physical database schema that contains the SAP ERP tables
You can use the following example SQL statement to grant the required privilege:
GRANT SELECT ON <Your schema name> TO _SYS REPO WITH GRANT OPTION;
2. Assign the required privileges described in section Authorization Requirements for the UDF AFL, of the
SAP Customer Activity Repository Security Guide.
2. Use transaction SE38 to run program /RAP/ACTIVATE HANA_ CONTENT.

The program activates a majority of the SAP HANA content (views and stored procedures) required by SAP
Assortment Planning for Retail.

Log on to SAP HANA studio.

Open the Modeler and use the Navigator to access your back-end system.
Expand the Content folder located under your system name in the Navigator.
Expand the package listed below:

o ok w

O sap.is.retail.rap
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You will notice that some of the content in the underlying folders is not deployed. The figure below provides
an example of content that has not been deployed.

« g 1ap
a & ap
4 & plan
a i Calculabion Migves (3)
::i" BW_DS02.calculationview
1@ BW_DS03_OPT_PLN_PRD_COUNT calculationview
;:;' BW_RCOL.calculatiorview
i@ BW_RCO5_OPT_PLN_SALES_KPLcalculationview
«'g RETAIL_PURCHASE_PLAN_INTERFACE.calculationview
4 [ Attribute Views (1)
T AP_PLN_HDR.attribubeview
# = Caleulation Views (50
I3 AMMUAL_SEASONS.calculationview
.'J ASSORTMEMNT_LIST_LOCATIONS_HIER.calculationview
13 ASSORTMENT_LIST_PRODUCTS_HIER. calculationview
'J ASSORTMENT_LIST_PRODUCTS_NO_COLOR.calculatiomview
o2 ASSORTMENT_LIST_PROD_LOC. calculationview
/3] ASSORTMENT_LIST_PROD_LOCS_MOKPLcalculationview
] ASSDRTMENT _LIST SALES_HISTORY.calculationview
{7 ASSORTMEMNT_PLAN_HDR.calculstiomview
'J ASSORTMENT_PLAM_MERCH_TC_OTB.calculatiomview
o3 ASSORTMENT PLAN NODE.calculationview
o ASSORTMENT_PLAN_SALES_HISTORY_BW.calculationview
.J ASSORTMEMNT_PLAMN_SALES HISTORY_VERSIOMS.calculationview
ASSORTMENT PLAN WEDGE VARIANTS. calculationview

il CLUSTER.calculatiomview
o1 CLUSTERSET.calculationview
3 CLUSTER_LOCATION.calculationview
.J DISTRIBUTIOMN_CHAMMEL. calculationview
/5] MASTER_ASSORTMENTS_TO_BE_DELETED.calculationview
4 = Procedures (4]
XECUTE P& ABA ¢ re

fi GET_AP_PLAN_HEADER.procedure |
L& GET_MERCH_PLAN_DATA.procedure
£ GET_PROD_LIST_KPLEY_NODE_ID.procedure

b = PROJECT Objects (1)

Example of SAP HANA content not deployed

A small number of views not deploying is an expected result of this procedure, and the remaining content

will be deployed in the Activate SAP HANA Content for SAP Assortment Planning for Retail - Part 2 [page
102] procedure.

O\ Caution

If you see that none of the views/procedures in the sap.is.retail.rap package are deployed, you

can resolve this by manually selecting, right-clicking, and choosing to Redeploy each of the sub-folders.
This manual redeployment should leave only the views/procedures highlighted above as not deployed.

More Information
Section Activating Objects, of the SAP HANA Developer Guide SAP
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4.2.4.3.3.3 Activate Application Bl Content

Use

In this procedures, you perform a sequential, step-by-step activation of the local Bl Content objects following
the upgrade to SAP Assortment Planning for Retail 1.0 FP3.

i Note

To ensure correct activation of the local Bl Content objects, carry out the activation sequentially, as
specified in the following procedures.

Also, the default Bl setting to collect and activate all dependencies must not be disabled by the user. The
instructions below activate a minimum subset of objects, and it assumed that all their dependencies will be
collected and activated.

Procedure

1. Onyour back-end SAP Assortment Planning for Retail system, open the Data Warehousing Workbench
(transaction RSA1).
2. Verify transport connections.
1. Select Transport Connection in the left-hand frame.
2. Select Object Types.
3. Expand Source System.
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Data Warehousing Workbench: Transport Connection

Switch (Business Functions)

O T2 Tacollected O Doeete &£ Lcro [E Econverson | Gaeex  Ehobject Changeabilty
[tiodaig ]
[ Adminstration || a1 objects Accordng to Type
| Transport Connection ]l » 4% InfoArea -
L » @ Appication -
- €3 54P Transport : g :ioﬁm Catalog

- @ InfoProviders by InfoAreas
. & InfoObjects by InfoAreas

* 95 BEx Web Template
» [1# BEx Web Irem
v [E) crystal Report
» @3 Xcelsius Dashboard

- @mnf es by Application C:
« @ Roles
- [ Object Types
1] ransport Heque
- (@ Packages
* B ML
=~ [ Export

+ @ InfoProviders by InfoAreas

» & InfoObjects by InfoAreas

« & InfoSources by Appication Component
- @ Roles

+ (1 Object Typas

+ B Transport Request

* @ Packages

» [ Enterprise Report

v E Workbook

+ [ Query view

v [H Query Elements

* & Broadeast Setting

» % CompositeProvider

+ [ Open 0DS View

* 2 SAP HAMA Analysis Process

v G MuttiProvider

+ B8 Infoset

v & HybridProvider

» [ semantically Partitioned Object
» €9 InfoCube

» @ Datastore Object (Advanced)
+ [ infoobject

v P Transformation

* "% Open Hub Destination

+ BB Data Flow

» [8) infopackage

» &) Data Transfer Process

v @3 process Chain

» [ Processes -

» 3 Panning -

Selecting Source Systems

(@ (s Grouping .|| ][2 Package [ Collection Mode [

Displat *

Collected objects

Use Select Objects to ensure that the back-end system is selected as the source system.

Choose Transfer Selections.

| 7| Technical name | Blevated... | Last... |1

At the top of the right-hand frame, above the list of Collected objects, choose Grouping and select Only

Necessary Objects.

At the top of the right-hand frame, choose Collection Mode and select Collect Automatically.

PUBLIC
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Data Warehousing Workbench: Transport Connection

P

O s Tacolected WE S Doekte & Lct0 [Elconverson  BbBEx B Object Changeabiity  Switch (Business Functions)

[todeing | [ETEEE] [ |crouping |62 paciage [ cotecton tose J] oo .| [B]ER]]
e
[a Al Objects According to Type Colected objects T | Technicalname | Elevated... | Last.. |Last Cha... | Tt

[ Transport Connection + & InfoSource -
+ [ DataSource X

+ [ source system

~ Y SAP Transport = + & Open Hub Destination
+ @ Infoproviders by InfoAreas + B Data Flow

« A8 mfanhiacts hv Tnfaareas » (@] nfnpackzas

Grouping and Collection Settings
3. Select Bl Content in the left-hand frame.

4. Determine your Bl Content installation requirements and apply these to each subsequent step.
If you are carrying out a brand new installation, proceed to the next step.

- Recommendation

If, however, you have previously installed/activated any of the /rRap/* Bl Content, you need to apply
special considerations to the installation/activation of Bl Content following a system upgrade.

o If you have modified any of the previously installed /rRap/* Bl Content objects, we recommend
that for the modified objects, you enable the Match (X) or copy option. When this options is
selected, you will be asked to carry out an additional Transfer selections step during which you
select to install the Active Version (that is, your modified version) or the Content Version (that is,
the SAP delivered, and possibly updated version of the object).

o If you have not modified any of the previously installed /rap/* Bl Content objects, you do not need
to enable the Match (X) or copy option for any of the Bl Content objects, and you don't need to
choose whether to install the Active Version or the Content Version of the objects.

5. Activate InfoObject catalogs.
1. Expand InfoObject Catalog.
2. Use Select Objects to select the /RAP/CHAR CAT and the /RAP/KYF CAT catalogs, that s, all the
InfoObject catalogs that starting with /rRap/*.
3. Choose Transfer Selections.
4. Intheright-hand frame, in the list of Collected objects, verify that both InfoObject catalogs are listed.
5. Right-click on each of the InfoObject catalogs, and choose Install all Bellow.
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6. Choose Install.

If an information dialog box appears, choose Continue. Choose Local Object or enter a package if you
need to transport the objects.

6. Maintain version master data. As of FP3, two new versions, AW1 and AW2, are required.
1. Expand InfoObjects.
2. Search for InfoObject /RAP/VERSN, located under |» Assortment Planning for Retail » RAP Character
InfoObject Catalog 3.

3. Right-click the InfoObject /RAP/VERSN, choose Maintain Master Data from the context menu, and
maintain the following entries on the Time Independent tab:

Version

AP1

AP2

AW1

AW2

0OC1

0Cc2

OM1

oM2

APF

REF

000

The supported planning versions are described in detail in the Maintain Customizing Table /RAP/
RS_VARCUST section of the Common Installation Guide.

i Note

If you encounter problems opening the master data maintenance WebDynpro application, ensure
that you have implemented SAP Note 2034623 .

7. Activate DataStore Objects.

1. Expand | More Types ¥ DataStore Object (Classic) 3.
Use Select Objects to select all DataStore Objects starting with /rRaP/ *.
Choose Transfer Selections.

In the list of Collected objects, verify that the option in the Install column is enabled for each of the
objects.

> w

5. Choose Install. If an information dialog box appears, choose Continue. Choose Local Object or enter a
package if you need to transport the objects.
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If during the installation, you are presented with a dialog asking you to add objects to a personal list,
select No.
If activation warnings similar to the ones displayed below appear, you can ignore them.

Date/ Time/User
* & Attribute _RAP_CLSET: Conversion routing ALPHA ignor
= ¢ Attribute _RAP_CLUST: Compounding ignored
= & Attribute _RAP_LOCAT: Conversion routine ATINN ignof
= & Attribute _RAP_PRDCT: Conversion routine ALPHA ignoi
= & Attribute _RAP_VARNT: Conversion routine ALPHA igno
* & Attribute _RAP_VERSN: Conversion routine ALPHA ignoi
* @ Creating column view of type IDS for object /RAP/DSO01...
~ & Column view activated for object /RAP/DSO1
* @D DataStore Object (classic) /RAP/DSOL activated
* & Post Processing/Checking the Activation for DataStore Object (|
~ & Creating Export DataSource and dependent Objects
* @ Reading the Metadata of /RAP/DS02 ...
* @ Creating DataSource /RAP/SDS02 ...
* & The short text of DataSource /RAP/8DS02 is not mainta
« & The short text of DataSource /RAP/8DS02 is not mainta

» @ Writing of object catalog entries (TADIR)
« @ Program ID Q0L57Y1I6BIWYCOBVZUS1IWVYK retrieved for [
~ & Initial entry written on the status of data of the InfoProvider
b & Activate external SAP HANA view for object /RAR/DSO2
* @ Creating column view of type IDS for object /RAP/DSD2...
* & Column view activated for object /RAP/DS02
* @ DataStore Object (classic) /RAP/DS02 activated
v A Post Processing/Checking the Activation for DataStore Object (
v A Initial entry written on the status of data of the InfoProvider

+ PR Fracbine rabame ssines nf e TAC £ar ahin INARIMECAD

Warnings
8. Activate InfoCubes.

Expand InfoCube.
Use Select Objects to select all InfoCubes starting with /RAP/RC*.
Choose Transfer Selections.

> w e

In the list of Collected objects, verify that the option in the Install column is enabled for each of the
objects.

5. Choose Install. If an information dialog box appears, choose Continue. Choose Local Object or enter a

package if you need to transport the objects.
If activation warnings similar to the ones displayed below appear, you can ignore them.
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+ @ Checking InfoCube /RAP/RCOS
* & Checking InfoCube [RAP/VCD1

> & Column view activated for object HRAPIRCOI

= & Check of InfoProvider /RAP/VCD1: = _& Activate external SAP HANA view for object ;RAP;‘RCl}l

* 8 Unable to find SAP HANA information model sap.is.retad.rap_ ap/INVENTORY_ACTUALS_VC
+ £ Mapped attrbute AP_PLN_ID does not exst for characteristic /RAP/ASRTP

* O Mapped attrbute CLUSTERSET_ID does not exist for charactenstic /RAP/CLSET

= & Mapped attrbute CLUSTER_ID does not exst for charactenstic /RAP/CLUST

* 8 Mapped attrbute EXT_LOC_ID does not exst for characteristic [RAP/LOCAT

* & Mapped attrbute COLOR does not exist for characteristic [RAP/PROLR

= ﬂ Hawed attrbute EXT_PROD_ID does not exit for characteristic IWIPRIKT

& o Mapped attrbute VERSION does not exist for characterst IWNERSH

* & Mapped attrbute CURRENCY does not exist for characteristic DCURRENCY

+ & Mapped attrbute MANDT does not exst for characteristic OMANDT

* & Mapped attrbute UOM does not exst for characterstic OUNIT

* & Mapped attrbute INVENTORY_AT_COST does not exist for key figure /RAR/CIVCY
+ O Mapped attrbute INVENTORY_AT_RETAIL does not exit for key figure [RAP/CIVRY
+ & Mapped attrbute INVENTORY does not exist for key figure /RAP/CIVUN

+ & Mapped attrbute ON_ORDER does not exst for key figure /RAP/ONOUN

= & Wamings occurred whie checking the InfoProvider

Warnings

9. Activate new Aggregation Level.

> w =

Expand | Planning » Aggregation Level 3.

Choose Transfer Selections.

objects.

D Package system—lom\ bw.bwzhana. rap, type: Analytic View, name: R

= & Attribute _RAP_ASRTP: Conversion routine ALPHA ignored
= ¢ Attribute _RAP_CLSET: Conversion routine ALPHA ignored
= & Attribute _RAP_CLUST: Compounding ignored

= & Attribute _RAP_LOCAT: Conversion routine ATINN ignored
= & Attribute _RAP_PRDCT: Conversion routine ALPHA ignored
= & Attribute _RAP_VARNT: Conversion routine ALPHA ignored
= & Attribute _RAP_VERSN: Conversion routine ALPHA ignored
= ¢ Attribute OFISCPER: Conversion routine PERI7 ignored

= & Attribute OFISCPER: Compounding ignored

* & Attribute DREQUID: Conversion routine RQUID ignored

* & Attribute OUNIT: Conversion routine BUNIT ignored

Use Select Objects to select the /RAP/D08A02 Aggregation Level.

In the list of Collected objects, verify that the option in the Install column is enabled for each of the

5. Choose Install. If an information dialog box appears, choose Continue. Choose Local Object or enter a
package if you need to transport the objects.

10. Reactivate Planning Sequence Objects.

1. Expand|p Planning ¥ Planning Sequence 3.

2. Use Select Objects to select the following Planning Sequences:

o

o}

o

o}

/RAP/D12A01 PSO1
/RAP/D12A01 PS02
/RAP/D15A01 PSO1
/RAP/D15A01 PS02
/RAP/D07A04 PSO1
/RAP/MO6A01 PSO7
/RAP/R10A01 PS02

3. Choose Transfer Selections.

4. Inthe list of Collected objects, verify that the option in the Install column is enabled for each of the
objects.
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5. Choose Install. If an information dialog box appears, choose Continue. Choose Local Object or enter a
package if you need to transport the objects.
11. Reactivate Workbooks.

Expand | More Types # Analysis Office Excel Workbook .
2. Use Select Objects to select the following workbooks:

© /RAP/OPTIONPLANBYMODULE

© /RAP/OPTIONPLANBYCLUSTER

© /RAP/REFINEASSORTMENT

O /RAP/PLANASSORTMENT
3. Choose Transfer Selections.

4. Inthe list of Collected objects, verify that the option in the Install column is enabled for each of the
objects.

5. Choose Install. If an information dialog box appears, choose Continue. Choose Local Object or enter a
package if you need to transport the objects.

12. Choose Exit to leave the transaction.

4.2.4.3.3.4 Activate SAP HANA Content for SAP Assortment
Planning for Retail - Part 2

Use

In this procedure, you perform the final activation of SAP HANA content (views and stored procedures)
required by the SAP Assortment Planning for Retail application. This final activation results in a full activation
of the SAP HANA content for SAP Assortment Planning for Retail. Several SAP HANA views depend on local Bl
Content objects, and as such, have to be activated following the activation of these Bl Content objects, as
described in this procedure.

Prerequisites

As a mandatory prerequisite for a successful activation of SAP HANA content for SAP Assortment Planning for
Retail, you must have successfully completed all of the procedures listed in the previous sections of this guide.

Procedure

1. Ensurethatthe sys REPO user has the authorizations required to successfully activate SAP HANA
content.
1. Provideuser SYsS REPO with object privilege SELECT, with option "Grantable to others", on the
following physical DB schemas:
o Physical database schema of your back-end system, typically this is called SAP<SID>.
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o Physical database schema that contains the SAP ERP tables
You can use the following example SQL statement to grant the required privilege:
GRANT SELECT ON SCHEMA <Your schema name> TO _SYS REPO WITH GRANT OPTION;
2. Assign the required privileges described in section Authorization Requirements for the UDF AFL, of the
SAP Customer Activity Repository Security Guide.
2. Use transaction SE38 to run program /RAP/ACTIVATE HANA CONTENT.
The program activates the remaining SAP HANA content (views and stored procedures) required by SAP
Assortment Planning for Retail.

Log on to SAP HANA studio.
Open the Modeler and use the Navigator to access your back-end system.
Expand the Content folder located under your system name in the Navigator.

o ok w

Expand the package listed below:
O sap.is.retail.rap
All the content in the underlying folders should be active.

More Information

Section Activating Objects, of the SAP HANA Developer Guide SAP

4.2.4.3.3.5 Verify Activation of External Views

Use

During activation of SAP HANA content for SAP Assortment Planning for Retail, several external views are not
automatically activated. Following an upgrade, you need to verify that all previously activated external views
remain active.

Procedure

1. Use either transaction SE11 or SE80 to verify that all the external views listed in SAP Note 2067030#% are
in an activate state. If they are not, manually activate the views.
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4.2.4.3.4 Maintain Customizing Table /RAP/RS_VARCUST

Use

In this procedure, you maintain entries in the variable customizing table /RAP/RS_VARCUST in the back-end
system. For each SAP Assortment Planning for Retail query, the entries of this table specify a mapping of a
data version (for example, actual data versus planning data) to the source of data (InfoCube).

Procedure

1. Log on to your back-end system.

2. Runreport /RAP/SEED BW CUSTOMIZING DATA (transaction SE38).

3. Determine whether you want to overwrite the existing entries in the /RAP/RS_VARCUST table.
If you do want to overwrite the contents of the table, enable the Remove Existing Entries option. If you don't
want to overwrite the contents of the table, but want to append the new entries, disable the Remove
Existing Entries option.

i Note

Duplicate entries that can potentially be created if you choose to disable the Remove Existing Entries
option, which will result in an error.

4. Enable the Test option and choose Execute to run the report in test mode.
Running the report in test mode allows you to verify that you can successfully update the /rRaP/
RS VARCUST table. No entries are persisted in the table as a result.
5. Once you have successfully executed the /RAP/SEED BW CUSTOMIZING DATA report in test mode,
disable the Test option and choose Execute to run the report.
6. Optionally, once the report has finished executing, you can verify the entries of the /RAP/RS_VARCUST
variable customizing table.
If required, you can make changes to any of the entries made by the /RAP/SEED BW CUSTOMIZING DATA
report by doing the following:
1. Open the Data Browser (transaction SE16).
2. Enter /RAP/RS_VARCUST in the Table Name field and choose Create Entries.

3. Choose Execute followed by Create.
On the Table /RAP/RS_VARCUST Insert screen, you will be able to make the following entries:

Field Name User Entry

COMPID SAP Assortment Planning for Retail technical query name.

For example, /RAP/M01A02_TIRQ02.

VNAM ICUBE InfoCube variable name.

For example, /RAP/INFOPROV_ESM 01.
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Field Name User Entry

INFOCUBE InfoCube identifier.

For example, /RAP/RCO1.

VNAM VERS Version variable name.

For example, /RAP/VERSN MSM 01.

VERSION Version |dentifier.

There are several supported planning versions:

@]

@]

AP1: Location level version 1. Version that is typically used as the planning version.

AP2: Location level version 2. Version typically used to simulate different scenarios without
having to change your planned version.

aWl: Week level version 1. Version that is typically used as the planning version.

aw2: Week level version 2. Version typically used to simulate different scenarios without hav-
ing to change your planned version.

oc1: Option plan by cluster simulation version 1. Version that is typically used as the plan-
ning version.

oc2: Option plan by cluster simulation version 2. Version typically used to simulate different
scenarios without having to change your planned version.

oM1: Option plan by module simulation version 1. Version that is typically used as the plan-
ning version.

oM2: Option plan by module simulation version 2. Version typically used to simulate different
scenarios without having to change your planned version.

APF: Final version (planned data). After completing the planning, the user will select the
plan they want to finalize and review in the Plan Weekly Sales and Receipts workbook. Only
the APF version is available in Plan Weekly Sales and Receipts.

REF: Reference version (past data). This is historical data for the items from the time frame
of the reference period. This data is used to pre-populate the planning version by using the
copy function. This allows the planner to have a baseline when starting the planning proc-
ess. It is recommended to seed the planning version with the REF data.

000: Actual version (current data). The user can see current inventory values with this such

as Actual Inventory and Open Orders.

F4HELP Flag that specifies whether the field provides F4 help or not.

4. Maintain entries in the /RAP/RS_VARCUST table as required.
For example you can change the InfoCube used as the source of data for a particular planning version.

5. Choose Save.

160 PUBLIC
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4.2.4.3.5 Update Fiscal Year Variant Entries

Use

In this procedure you update previously maintained fiscal year variants ( OFISCVARNT 'RW'). The SAP
Merchandise Planning for Retail application, which can be used in conjunction with the SAP Assortment
Planning for Retail application, only supports fiscal years with 52 posting periods. As a result, fiscal year variant
entries must be adjusted, entering each year with 53 posting periods as a shortened fiscal year.

A\ Caution

You must maintain fiscal year variants for at least one year past the years for which you are planning. For
example, if your assortment plans extend to December 2018, you must maintain fiscal year variants until
December 2019.

The steps provided in this procedure allow you to maintain 0OFTSCVARNT 'RW' using the standard 4-5-4
calendar entries. If you are using alternative fiscal periods in your retail business, for example, each week
starting on a Sunday instead of Saturday, you can provide your own entries instead of the ones suggested in
this guide.

Procedure

1. Logon to your back-end system.
2. Launch fiscal year variant maintenance (transaction GVAR).

3. Choose New Entries.
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4. Onthe New Entries: Overview of Added Entries screen make the following sets of entries:

Fiscal year variants

FV  Description Year-depen... Calendar yr Number of postin... No.of special peri
BW Assort. Plan Week v O 53 -
r -

Create New Fiscal Year Variant
5. Choose Enter.
An information message is displayed about creating more than 16 periods, choose Continue.
6. Choose Back.
You can see the newly created entry.

7. Mark the entry RW and double-click on Shortened Fiscal Years from the Dialog Structure.

8. Enter 2012 inthe Fiscal year field and choose Continue.

9. Choose New Entries.

10. Enter 52 in the No. of posting periods field in the Shortened Fiscal Years section.

11. Choose Back twice.

12. Open SAP Note 2112634#% , locate the entries for year 2012, and enter the data by copy-and-paste.

13. Repeat steps 7-12 to maintain the weekly fiscal year variant for years 2013, 2014, 2015, 2016, 2017, 2018,
2019, and 2020, entering each year as shortened fiscal year. The corresponding tables are available in SAP
Note 2112634 # .

14. Choose Save after you have finished the maintenance for year 2020.
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4.2.4.3.6 SetlLanguage for Ribbons and Buttons in
Workbooks (Optional)

Use

In this optional procedure, you can change the language settings specific to SAP Assortment Planning for
Retail workbooks. During the upgrade, some of the workbooks are updated, and, if you have previously
changed the language settings of these workbooks, you need to make these settings again following the
upgrade.

You can set the desired language of the following user interface objects:

® Ribbons Planning Functions, Refinement Functions, and Extended Features
® Tooltips for planning functions

® Message texts

e Buttons

The content of the workbooks consists of multiple parts:

e The language of the standard menus and standard ribbons depends on the language set for Microsoft
Excel.

e The language of the contents in the cells (mainly KPIs) depends on the user-selected system language of
the back-end system.

e The language of the user interface objects that are specific to the workbooks of SAP Assortment Planning
for Retall, is not set by the selected system language of the back-end system, but you can change it for
each workbook according to the following procedure. The default language is English.

Procedure

1. Unhide the worksheet SAP_TEXT_CUSTOMIZING using standard functionality of Microsoft Excel.

2. Onthe worksheet SAP_TEXT_CUSTOMIZING, copy the column of the desired language to column B -
Custom Text.

3. Hide the worksheet SAP_TEXT_CUSTOMIZING.

4. Save your changes in the worksheet on the SAP NetWeaver Server by choosing |» File » Analysis » Save
Workbook to SAP NetWeaver

4.2.4.3.7 \Verify that Data Replication is Running Following
the Upgrade

In general, following the upgrade, you need to ensure that all of the data replication described in Configure Data
Replication section of the Common Installation Guide is still running.
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In particular, you need to pay attention to the following:

e Ensure that time-dependent article hierarchies are properly loaded into SAP Assortment Planning for
Retail following the upgrade. See Load of Time-Dependent Article Hierarchies section of the Common
Installation Guide.

e Allthe tables listed in SAP Note 2054656#% are being replicated. New tables can be added with each new
release.

e Ensure that periodic tasks to load product attributes into SAP Assortment Planning for Retail are still
running following the upgrade. See, Load Product Attributes into SAP Assortment Planning for Retail section
of the Common Installation Guide.

e Ensure that OTB data is being loaded from the appropriate source. For more information, see the Load
Merchandise Planning Data section of the Common Installation Guide.

4.2.4.38 Runthe SAP Assortment Planning for Retail 1.0
FP3 Update Report

1. Runtransaction SE38.
2. Executethe /RAP/FP03 UPGRADE APR report.

4.2.4.3.9 Run the Validation Report

1. Runtransaction SE38.
2. Executethe /DMF/VALIDATE CAR INSTALLATION report.
3. Select the Assortment Planning scenario and select Execute.
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Running this report allows you verify the success of the installation, providing a log of potential issues. For
example, you may be presented with the following results:

[= Display logs x

= B e S == 0 509 T | P ) (T

Type Message Text LTxt
- Check - Installed SAP Notes

- Check - Planning Application Kit (PAK)

— Check - Fiscal Calendar

Maintain fiscal year variant 'RW". @‘
— Check - SAP HANA Time Dimension

Maintain SAP HANA time dim. at least 2 years back and 5 years in future. (]
- Check - Table /RAP/RS_VARCUST

--- Check - BI Master Data for Planning Versions

— Check - BI Technical Content Activation

— Check - BI APR Content Activation

— Check - SAP HANA AFL PAL

— Check - SAP HANA AFL OFL

CODDDODsD@OmD

L |

‘:::1 W Technical Information JE Help JE

Validation Report Results

View the long text associated with each message to see the link to the documentation describing the
procedure you need to troubleshoot.

4.2.4.3.10 Configure Index Calculation

Use

The SAPUI5 application index provides an indexing and caching mechanism for information related to SAPUI5
apps, components, and libraries that are contained in SAPUI5 repositories on the SAP NetWeaver Application
Server for ABAP. This index, calculated by the Calculation of SAPUI5 Application Index for SAPUI5 Repositories
report ( /UI5/APP INDEX CALCULATE), makes it possible to retrieve and find this information significantly
faster than when carrying out the calculations each time it's requested.

We recommend that you schedule the Calculation of SAPUI5 Application Index for SAPUI5 Repositories report
as to run as a background job on your front-end server.

Following any changes to the content of the SAPUI5 ABAP repository (for example, installation of a new version
of the SAPUI5 distribution layer or implementation of an SAP Note containing changes to an SAPUI5 app), the
SAPUI5 application index should be updated using the calculation report. This report has to be executed in
every system whenever the content of the SAPUI5 ABAP repository has changed.
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Procedure

1. Determine the SAP NetWeaver version on your front-end server.
2. Carry out the instructions specific to your SAP NetWeaver version:
o SAP Gateway for SAP NetWeaver 7.31
o http:/help.sap.com/nw-uiaddon20# | Application Help » SAPUI5: Ul Development Toolkit for
HTML5 » Developing Apps # The SAPUI5 ABAP Repository and the ABAP Back-End Infrastructure
» SAPUI5 Application Index 3
o SAP Gateway for SAP NetWeaver 740
o http:/help.sap.com/nw74#% |y Application Help ¥ Ul Technologies in SAP NetWeaver with SAP_UI
740 » SAPUI5: Ul Development Toolkit for HTML5 » Using the SAPUI5 Repository » SAPUI5
Application Index
Alternatively, you can launch the Calculation of SAPUI5 Application Index for SAPUI5 Repositories
report ( /UT5/APP_INDEX CALCULATE) from Customizing under [ SAP NetWeaver » Ul

Technologies ¥ SAP Fiori ¥ Initial Setup ¥ Schedule SAPUI5 Application Index Calculation 4.

4.2.4.3.11 Activate SAP Assortment Planning for Retail
OData Services

Use

A number of OData services are required to run the SAP Assortment Planning for Retail application.

For security reasons, all OData services are delivered in an inactive state. You must activate these application-
specific OData services to use the SAP Fiori user interface of the SAP Assortment Planning for Retail
application.

Procedure

1. Logon to your front-end system (your SAP NetWeaver system).
2. Go to Customizing (transaction SPRO).

3. Navigate to | SAP NetWeaver » Gateway # OData Channel » Administration  General Settings j Activate

and Maintain Services .
You are presented with the service catalog. This is a list of all the services that are currently active on your
SAP Gateway.
4. Get SAP Assortment Planning for Retail OData services:
1. Choose Add Service.
The Add Service screen is displayed.
2. Enter the system alias of your back-end system.
This is the alias created for your back-end system in the Connect SAP NetWeaver Gateway to your
Back-End System [page 48] procedure. For example RAPCLNT100.
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3. Enter /DMF* in the Technical Service Name field.

4. Choose Get Services.
The Add Selected Services screen is displayed.

5. Select the SAP Assortment Planning for Retail OData services you would like to activate, and choose
Add Selected Services.

OData Service

/DMF/CURRENCY LIST SRV

/DMF/LOCATION CLUSTERSET SRV

/DMF/MODULE_MANAGEMENT SRV

/DMF/OBJ_ATTRIBUTE_ SRV

/DMF/SEARCH LOCATIONS SRV

/DMF/SEARCH PRODUCTS SRV

/DMF/SEASONS SRV

/DMF/MASTER _DATA SRV

The selected OData services are now active in your SAP Gateway.

6. Enter /RaP* in the Technical Service Name field.

7. Choose Get Services.
The Add Selected Services screen is displayed.

8. Select the SAP Assortment Planning for Retail OData services you would like to activate, and choose
Add Selected Services.

OData Service

/RAP/ASSORT AUTOMATIC PROP SRV

/RAP/ASSORT LIST MODULE SRV

/RAP/ASSORTMENT PLAN SRV

/RAP/OPTION PLAN SRV

/RAP/PHP_ MATCH SRV

/RAP/SADL_PROD LIST KPI SRV

The selected OData services are now active in your SAP Gateway.
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More Information

For SAP NetWeaver 7.31, see SAP Library for User Interface Add-On 1.0 on SAP Help Portal at http://
help.sap.com/nw-uiaddon20# |+ Application Help » SAP Fiori Launchpad  Setting Up the Launchpad »
Activating SAP Gateway OData Services 4.

For SAP NetWeaver 74, see the documentation on SAP Help Portal at http://help.sap.com/nw 74 Fr |l
Application Help » Ul Technologies in SAP NetWeaver with SAP_UI 740 » SAP Fiori Launchpad ¥ Setting Up the
Launchpad ¥ Activating SAP Gateway OData Services 4.

4.2.4.3.12 Activate SAP Assortment Planning for Retail ICF
Services

Use

For security reasons, all Internet Communication Framework (ICF) services relevant to your SAP Assortment
Planning for Retail application are made available in an inactive state.

You have activated the central ICF services in the Perform General SAP NetWeaver Gateway Configuration
[page 48] and Configure Central Ul Component [page 51] procedures. This procedure provides the instructions
to activate ICF services required for the SAP Assortment Planning for Retail SAP Fiori apps.

Procedure

1. Log on to your front-end server.

2. Open service maintenance (transaction SICF).

3. Inthe Maintain Service screen, select the Location Clustering service by specifying the following:
o Hierarchy Type: SERVICE
© Virtual Host: DEFAULT HOST
o Service Path: /sap/bc/ui5_ui5/sap/locclsts_v2/

4. Choose Execute.

o

To activate the service, choose Service/host Activate.

6. Repeat steps 3 to 5 to ensure that all of the following services are activated:
© /sap/bc/ui5 uiS/sap/attribmgmt v2/

© /sap/bc/uib uiS5/sap/assortmodule v2/

© /sap/bc/ui5 uiS/sap/assortplan v2/

© /sap/bc/ui5 uiS5/sap/ddfreuse v2/

© /sap/bc/ui5 uiS5/sap/locclsts v2/

© /sap/bc/ui5 ui5/sap/modulemgmt v2/

© /sap/bc/ui5 uiS5/sap/optionplan v2/
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0 /sap/bc/ui5 uib5/sap/phpmatch v2/

4.2.4.3.13 Define System Alias for Back-End Transactions

Use

A number of SAP Assortment Planning for Retail SAP Fiori apps, installed on your front-end system, launch
transactions directly on the back-end system. For example, the Manage Products tile actually launches the
Demand Data Foundation (DDF) powL EASY WebDynpro application.

To enable this behavior, you need to create a dedicated RFC connection between the front-end and the back-
end systems.

Procedure

1. Logon to your front-end system, that is, the system where you have installed the user interface (Ul)
components of the SAP Assortment Planning for Retail application.

2. Launch Configuration of RFC Connections (transaction sM59).

3. Create an RFC connection with the RFC Destination set to SAp_ ISR _CARAB and Connection Type set to H
(HTTP connection).
Ensure to maintain all of the settings required to connect to your back-end system, in particular, the Target
Host entry on the Technical Settings tab.

4. Create another RFC connection with the RFC Destination set to SAP ERP ISR CARAB and Connection
Type set to 5 (HTTP connection).
Ensure to maintain all of the settings required to connect to your front-end system to the SAP ERP system,
in particular, the Target Host entry on the Technical Settings tab.

5. Save your changes.

6. Open Launchpad Customizing (transaction LPD CUST).

7. Select the SAP Assortment Planning for Retail role (UTRAP001), and choose Display.
The two catalogs, Assortment Planner and Planning Administrator, are displayed.

8. Ineach of the catalogs, selecting one app at a time, make the following settings:

Catalog App System Alias Description

Assortment View Log SAP ISR CARAB This setting allows the My Assortment Plans (Version 2)

Planner app to launch transaction SL.G1 on the back-end system.
i Note

This application is only used to configure a link to
the back-end system, you do not need to add this
app to your SAP Fiori launchpad.
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Catalog App

System Alias

Description

View ExtAssort
Listing Conditions

SAP ERP ISR CAR
AB

This setting allows the My Assortment Plans (Version 2)
app to launch transaction wsL.10 on the connected SAP
ERP system.

i Note

This application is only used to configure a link to
the SAP ERP system, you do not need to add this
app to your SAP Fiori launchpad.

View External
Assortments

SAP ERP ISR CAR
AB

This setting allows the My Assortment Plans (Version 2)
app to launch transaction wRF_Ws0A3 on the connected
SAP ERP system.

i Note

This application is only used to configure a link to
the SAP ERP system, you do not need to add this
app to your SAP Fiori launchpad.

Assortment Manage Category
Planner responsibilities

SAP ISR CARAB

This setting allows the Manage Category Responsibilities
app to launch the corresponding DDF WebDynpro appli-
cation.

Manage Products

SAP ISR CARAB

This setting allows the Manage Products app to launch
the corresponding DDF WebDynpro application.

Manage Locations

SAP ISR CARAB

This setting allows the Manage Locations app to launch
the corresponding DDF WebDynpro application.

4.2.4.3.14 Troubleshoot Front-End Server Upgrade

Use

Following the upgrade of the product version on the front-end server, you may not be able to see some of the
SAP Assortment Planing for Retail 1.0 FP3 SAP Fiori tiles in your launchpad. This section outlines how to
troubleshoot these issues, should you experience them.

These steps are also listed in the Troubleshooting section of the SAP Assortment Planing for Retail

Administrator's Guide available on the SAP Help Portal at http://help.sap.com/rap#r|¢ <Your Release> »

System Administration and Maintenance Information j» Administrator's Guide .
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Process

Do the following:

1. Check that all of the required BSP applications are listed in the UTRAP001 package.

Log on to your front-end system (your SAP Gateway system).

Launch the Object Navigator (transaction SE80).

In the Repository Browser, open package UTRAP0O1.

Expand all of the embedded packages of embedded package CONTENT RAP TRANS.

o K~ w D=

Verify that the following BSP Applications are listed:

Package v
[uIRAPOO1 v &
(@ L= LIelal &R I3 ]
Object Name Description
~ [ UIRAPOOL Structure package for UIRAP
~ [ Subpackages
+ [ CONTENT_RAP_COMMON Main package fer common obejcts for RAP
~ [ CONTENT_RAP_TRANS Main package for transactional for RAP
= [= Subpackages
~ [ RETAIL_DDF Package for DDF
~ [ BSP Library
= [ BSP Applications
» ‘I_:I ATTRIBMGMT_V2 Manage Product Attriubtes: Fiori ID FO829A
» 1 DDFREUSE_V2 Fiori Reuse Components for DDF: Fiori ID FOB54A
» 1 LOCCLSTS_ V2 Location Clustering: Fiori ID FO550A
» [(21MODULEMGMT _V2 Module Management: Fiori ID F1682A
~ [ RETAIL_RAP_AP Package for RAP AP
~ [£= BSP Library
~ [ BSP Applications

» [1ASSORTMODULE_V2 Assortment Module: Fiori ID F1567A
» 1 ASSORTPLAN_V2 Assortment Plan: Fiori ID FO551A
» [Z1OPTIONPLAN V2 Option Plan: Fiori ID FO830A
» [IIPHPMATCH_v2 PHP Matching: Fiori ID FO831A

BSP Applications
6. If you do not see one or more of the BSP applications listed above, right-click on each of the

RETATL_DDF and RETATL RAP AP packages, and select | Other Functions » Rebuild Object List 3.

A\ Caution

Do not rebuild objects on a higher package level.

2. Cleanthe cache.
1. Logon to your front-end system (your SAP Gateway system).

2. In Customizing (transaction SPRO), navigate to [ SAP NetWeaver » Ul Technologies  SAP Fiori

Data Administration ¥ Invalidate Caches 3.

This activity launches the /UI2/INVALIDATE GLOBAL CACHES report. This reportinvalidates all

server-side caches in SAP NetWeaver user interface services, which can become out-of-date following

an upgrade.
3. If necessary, implement instructions listed in SAP Note 2147669 #r .
3. Remove any previously customized versions of the UTRAP001 launchpad.
1. Logon to your front-end system (your SAP Gateway system).
2. Launch the Overview for Launchpads (transaction LPD_CUST).
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3. Search for Role UIRAP001, and see whether any instances exist where the User Name is not SAP. If so,
this means that customized versions of the UTRAP001 launchpad exist, and these take precedence
over the standard launchpad instance delivered by SAP.

4. Delete all but the launchpad instance delivered by SAP.

4.2.5 1.0 FP1t0 1.0 SP5

This section is intended for existing SAP Assortment Planning for Retail customers who have installed and
configured SAP Assortment Planning for Retail 1.0 FP1 and would like to upgrade to SAP Assortment Planning
for Retail 1.0 SP5.

4.25.1 Quick Guide

This section includes a checklist with all actions that you have to perform. The actions are in chronological
order, so that you can work through them like a checklist.

Checklist

Prerequisites
Mandatory Steps

] Ensure that you have implemented the necessary SAP Notes listed in the SAP Notes for the Upgrade
section.

1 Ensure that your landscape meets the requirements outlined in the Prerequisites section.
Preparation
Mandatory Steps

[ Verify that you have all of the required SAP HANA users and privileges. See Verify SAP HANA Users and
Privileges [page 83].

i Note
As for the FP2 release, anew role (AFL__SYS AFL OFL_AREA EXECUTE) must be assigned to the
SAP<SID> user.
[1 Configure AFL and OFL usage. See Enable Usage of PAL Functions [page 86] and Check the OFL
Installation [page 87].
Upgrade Process

Mandatory Steps

[0 Implement SAP Note 2298340 if your landscape includes a NW version earlier than NW 740 SP15.
You must perform this step prior to upgrading the back-end system product version.
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O
0
0

Upgrade your back-end system product version in SAP Solution Manager.
Upgrade the application function libraries ( UDFAFL_INST 100, POSAFL_INST 100).

Upgrade or install product-specific SAP Fiori Ul components on the front-end server.

Follow-Up Activities

Mandatory Steps

O
O

OOo0O0ooooboooogn

O

Create SAP ERP tables.

Verify SAP HANA and back-end system roles. See the Verify Users, Privileges, and Roles section in the
Common Installation Guide.

Adjust Customizing settings.

Reactivate SAP Assortment Planning for Retail planning framework content.
Maintain Customizing table /RAP/RS VARCUST.

Update fiscal year entries.

Optionally, restore language settings in workbooks.

Verify that data replication is running following the upgrade.

Run the SAP Assortment Planning for Retail 1.0 FP3 update report.

Run the validation report.

Configure index calculation.

Activate SAP Assortment Planning for Retail OData services.

Verify that all the ICF services relevant to SAP Assortment Planning for Retail are active following the
upgrade.

Define system alias for back-end transactions.

Troubleshoot front-end server upgrade.

4.25.2 Upgrade Process

42521 Implement SAP Note 2298340

Use

Prior to upgrading the CAR RETAIL APPL BUNDLE 1.0 back-end product version from an older support

package stack (SPS) to a newer one, you need to verify the SAP NetWeaver 740 SPS in your system landscape.

Important corrections, relevant for Core Data Services (CDS) views, and required by the latest SPS of CAR

RETAIL APPL BUNDLE 1.0, areonly available as of SAP NetWeaver 740 SPS 15.
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Procedure

1. Verify your SAP NetWeaver 740 support package stack.

If your landscape contains SAP NetWeaver 740 SPS 12, SPS13, or SPS14, you will need to implement SAP
Note 2298340#% to apply corrections relevant for CDS views.

If your landscape has been upgraded to SAP NetWeaver 740 SPS 15, you do not need to implement SAP
Note 2298340#% , and you can go to the next procedure.

2. Read and implement SAP Note 2298340 prior to upgrading the back-end system product version.

More Information

http://help.sap.com/hana_platform#& | Development and Modeling # SAP HANA Modeling Guide (For SAP
HANA Studio) 3

4.25.2.2 Upgrade SAP Customer Activity Repository Retail

Use

Applications Bundle

This procedure describes how to upgrade the CAR RETAIL APPL BUNDLE 1.0 back-end product version
from an older support package stack to a newer one.

Procedure

Check your upgrade scenario:

1
2.

Navigate to the Product Availability Matrix (PAM) at http://support.sap.com/pam .

For information about the available support package stacks (SPS), search for the CAR RETAIL APPL
BUNDLE 1.0 product version, and choose Support Package Stacks.

For information about the supported upgrade paths, choose Related Product Versions.

For information about the software components in the SPS, choose Technical Release Information and
consult the subsections, such as Database Systems.

To navigate directly to the download area for the SPS, choose | SAP Software Download Center » CAR

RETAIL APPL BUNDLE 1.0 - Support Packages & Patches 3.
Alternatively, you can get there from the SAP Support Portal by choosing http://support.sap.com/

swdc# | Support Packages and Patches » Software Downloads j SUPPORT PACKAGES & PATCHES »
By Alphabetical Index (A-Z) » C » CAR RETAIL APPLICATIONS BUNDLE » CAR RETAIL APPL BUNDLE

103

2. Patch the support package stack using the Support Package Manager tool (transaction spam).
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For more information about this tool, see SAP Help Portal at http://help.sap.com/spmanager
|» Application Help 7, as well as SAP Note 1803986 # .

To finalize the upgrade of the back-end product version, you must additionally do some manual steps. Continue
with the next section.

Download and Install the Application Function Libraries (AFLs)

There are two components that you cannot upgrade using Support Package Manager.

e Unified Demand Forecast application function library (UDF AFL, software component version
UDFAFL INST 100, provides the demand modeling and forecasting services in SAP Customer Activity
Repository, runs directly in the SAP HANA database)

e On-Shelf Availability application function library (POS AFL, software component version POSAFL INST
100, provides the On-Shelf Availability services in SAP Customer Activity Repository, runs directly in the
SAP HANA database)

You need to download one UDF AFL revision and one POS AFL revision manually and install them together in
your SAP HANA database.

Where to Download

Both AFLs are provided as part of the CAR RETAIL APPIL BUNDLE 1.0 product version onthe SAP Support
Portal under http://support.sap.com/swdc#|j¢ Support Packages and Patches j Software Downloads »
SUPPORT PACKAGES & PATCHES » By Alphabetical Index (A-Z) » C » CAR RETAIL APPLICATIONS BUNDLE »
CAR RETAIL APPL BUNDLE 1.0 » Entry by Component » Analytics AFL 3.

For a successful upgrade, you need to be aware of the following dependencies.
Dependencies Between the AFLs and the SAP HANA Database

The AFLs are released independently of the releases of SAP Customer Activity Repository retail applications
bundle. This is because the AFLs follow the release cycle of the SAP HANA database. The releases are called
“revisions”. Whenever a new revision of the SAP HANA database is released, a new revision of each AFL is

released. As a result, multiple revisions of each AFL are available on the SAP Support Portal at any one time.

A\ Caution

For each revision of an AFL, there is only one compatible revision of the SAP HANA database. For example,
you can only use revision 112.20 of the UDF AFL with revision 112.02 of the SAP HANA database. Whenever
you upgrade an AFL, you must also upgrade the database and any other AFLs to the compatible revisions.
Reversely, whenever you upgrade the database, you must upgrade the AFLs.

Note that this dependency applies not only to the UDF AFL and the POS AFL but also to the generic SAP
HANA AFL. Both the SAP HANA AFL and the SAP HANA database are components of the SAP HANA
Platform (see Prerequisites [page 16]).

When you download an AFL revision from the SAP Support Portal, the compatible revision of the SAP
HANA database is indicated.

Nomenclature
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The following table explains how you can see the dependencies by looking at the release numbers:

Release of ... Released as ... Example Guideline

SAP HANA Platform <Support Package Stack> SAP HANA Platform SPS11 ~ The number of the support

package stack determines
the first digits of the revi-

sions.

SAP HANA Database <Revision>.<Patch> SAP HANA Database 112.02  All 11x.xx database revisions

belong to the SPS 11 plat-
form stack.

The patch number deter-
mines the first digit of the

AFL patch.
UDF AFL <Revision>.<Patch> UDF AFL112.20
POS AFL POS AFL 112. 20
SAP HANA AFL SAP HANA AFL 112. 20

- Recommendation

We recommend that you upgrade all the AFLs at the same time. This means:

UDF AFL and POS AFL, which you must both install for a successful upgrade of SAP Customer Activity
Repository retail applications bundle

SAP HANA AFL, which is one of the mandatory prerequisites
if applicable, other AFLs provided with SAP HANA that might be relevant for your scenario

Focus on the AFL that provides the most important functionality for your scenario (for example, demand
forecasting with the UDF AFL). Select the best revision of that AFL for your scenario. This in turn will give
you the compatible revision of the SAP HANA database and the compatible revisions of the other AFLs.
Then install all the AFLs together.

Download and Install the UDF AFL (Focus: Demand Forecasting)

1. Select an AFL revision.
Multiple revisions are available on the SAP Support Portal. For guidance on selecting the best revision for
your Unified Demand Forecast scenario, see the following:

176

o

Prerequisites [page 16]: Indicates the minimum revision of the AFL and the SAP HANA Platform for
this release.

SAP Note 2088924 #% : Release Information Note (RIN) for SAP Customer Activity Repository retail
applications bundle 1.0.

SAP Note 2050229 : Gives you an overview of all UDF AFL revisions as of revision 82 and provides
instructions for downloading, installing, and upgrading the UDF AFL.

SAP-HANA-related information:
o Release and maintenance strategy of the SAP HANA Platform at http://support.sap.com/swdc#
| Support Packages and Patches  Software Downloads » SUPPORT PACKAGES & PATCHES » By
Alphabetical Index (A-Z) » H » SAP HANA Platform Edition j» Info 3
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o SAP Note 2021789#% : SAP HANA Revision and Maintenance Strategy

o SAP Note 2227464 : SAP HANA Platform SPS 11 Release Note

o SAP Note 1948334+t : SAP HANA Database Update Paths for Maintenance Revisions

o SAP Note 1914052#% : Dependencies between SAP NetWeaver and the SAP HANA Database

2. Download and install your AFL revision (together with the other AFLs) as described in SAP Note 2050229
i

i Note

To use the UDF functionality in your implementation scenario, you must additionally do some post-
installation steps. For more information, see Configure Unified Demand Forecast (Optional) [page 64].

Download and Install the POS AFL (Focus: On-Shelf Availability)

1. Select an AFL revision.
Multiple revisions are available on the SAP Support Portal. For guidance on selecting the best revision for
your On-Shelf Availability scenario, see the following:

o Prerequisites [page 16]: Indicates the minimum revision of the AFL and the SAP HANA Platform for
this release.

o SAP Note 2088924 #: Release Information Note (RIN) for SAP Customer Activity Repository retail
applications bundle 1.0.

o SAP Note 2056102#% : Gives you an overview of all POS AFL revisions as of revision 82 and provides
instructions for downloading, installing, and upgrading the POS AFL.

o  SAP-HANA-related information:

o Release and maintenance strategy of the SAP HANA Platform at http://support.sap.com/swdc#
| Support Packages and Patches # Software Downloads » SUPPORT PACKAGES & PATCHES ¥ By
Alphabetical Index (A-Z) » H » SAP HANA Platform Edition » Info J

o SAP Note 2021789#% : SAP HANA Revision and Maintenance Strategy

o SAP Note 22274644 : SAP HANA Platform SPS 11 Release Note

o SAP Note 1948334 #%: SAP HANA Database Update Paths for Maintenance Revisions

o SAP Note 1914052#%: Dependencies between SAP NetWeaver and the SAP HANA Database

2. Download and install your AFL revision (together with the other AFLs) as described in SAP Note 2056102
.

i Note

To use the On-Shelf Availability functionality in your implementation scenario, you must additionally do
some post-installation steps. For more information, see Configure On-Shelf Availability (Optional) [page
53].

Result

You have successfully upgraded the CAR RETAIL APPL BUNDLE 1.0 back-end product version to the current
SPS. Continue with the next section.
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4.2.52.3 Upgrade Product-Specific SAP Fiori Ul
Component

Use

This procedure describes how to upgrade the SAP FIORI FOR SAP CARAB front-end product version from an
older support package stack to a newer one.

The ABAP front-end server contains the complete Ul layer, which consists of the SAP Gateway, the central SAP
Fiori Ul component, and the product-specific SAP Fiori Ul component. The product-specific SAP Fiori Ul
component contains all the SAP Fiori user interfaces for the applications provided for the SAP Customer
Activity Repository retail applications bundle.

Procedure

1. ldentify the support package stack on the SAP Support Portal at http:/support.sap.com# | Software
Downloads # Support Packages and Patches # Software Downloads » By Alphabetical Index (A-Z) ¥ F
SAP FIORI » SAP FIORI FOR SUITE » SAP FIORI FOR SAP CARAB » SAP FIORI FOR SAP CARAB 2.0

SPS01 1.
For more information on support package stacks, see http:/support.sap.com/sp-stacks .
2. Patch the support package stack using the Support Package Manager tool (transaction sSpaM).

For more information, see SAP Help Portal at http://help.sap.com/spmanager# | Application Help 3, as
well as SAP Note 1803986 # .

A\ Caution

As of the FP3 release, software components UISCARO01 and UIRAPOO1 have been merged into one,
UICARO0O01, software component.

3. If you are using SAP Assortment Planning for Retail, consult SAP Note 2077357 %, which lists the SAP
Notes relevant for your release.

4.25.3 Follow-Up Activities
4.2.5.3.1 Create SAP ERP Tables

A\ Caution

Following an upgrade, it is important to remember to create any additional tables required by the new
release.

Tables required to be created as of the SAP Assortment Planning for Retail are listed in SAP Note 2263205 .
Ensure that all tables listed in this note have been created.
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4.2.53.2 Verify SAP HANA and Back-End Roles

As of the SAP Assortment Planning for Retail 1.0 FP2 release, a new role and a new authorization object have
been added to the SAP_ISR AP MASTER back-end role. Following the upgrade, use transactions su01 and
PFCG to ensure that the following are assigned to your back-end user:

® SAP DDF MODULEMGMT APP role
e /DMF/MD authorization object

In general, following the upgrade, you need to ensure that all of the SAP HANA and back-end system roles
listed in the Verify Users, Privileges, and Roles section of the Common Installation Guide are still assigned to all
of the required users.

4.25.3.3 Adjust Customizing Settings

Use

Following the upgrade, there are several settings you need to make in Customizing to be able to use SAP
Assortment Planning for Retail 1.0 FP3.

Procedure

1. Log on to your back-end system.
2. Open Customizing (transaction SPRO) and navigate to | Cross-Application Components » Assortment

Planning for Retail » Number Range 3.
3. Provide settings in the Maintain Number Range for Attribute Container ID activity.
4. Provide settings in the Maintain Number Range for Assortment Modules activity.

5. In Customizing, navigate to | Cross-Application Components # Assortment Planning for Retail ¥ Imported

Demand Data Foundation Settings ¥ Integration 3.

As of FP2, the default configuration of SAP Assortment Planning for Retail is to consume merchandise
planning data from the SAP Merchandise Planning for Retail application, another add-on to the SAP
Customer Activity Repository. You perform the verification of these new default settings in the steps below.
Otherwise, if you are determining the OTB using the SAP Planning for Retail, rapid-deployment solution,
the OTB-related figures, or KPIs, (including planned sales, open orders, and purchase quantities) are
stored in SAP Business Warehouse (SAP BW) InfoProviders. To access these figures from SAP Assortment
Planning for Retail, this data must first be imported from the SAP BW system to your back-end system, as
described in SAP Note 2208191 .

6. Verify that in the Define SAP BW Application for Merchandise Planning Customizing activity, under | Cross-
Application Components » Assortment Planning for Retail ¥ Imported Demand Data Foundation Settings »

Integration 1, the default settings are applied as follows:
o Destination: LOCAL

Common Upgrade Guide for SAP Customer Activity Repository retail applications bundle 1.0
SPS7
Upgrade Scenarios PUBLIC 179


http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/2208191

7.

If this field is empty, the application assumes that the InfoProvider exists in the back-end system,
which is the case if SAP Assortment Planning for Retail and SAP Merchandise Planning for Retail are
installed on the same back-end system.

o InfoProvider: /RAP/MPRCO1

Remaining in the Define SAP BW Application for Merchandise Planning Customizing activity, specify the
same Fiscal Year Variant as the one maintained under |+ Cross-Application Components # Assortment
Planning for Retail » Maintain fiscal year variant 3.
Verify that in the Define Field Mapping for Merchandise Planning Customizing activity, also under, | Cross-
Application Components ¥ Assortment Planning for Retail ¥ Imported Demand Data Foundation Settings
Integration J, the default settings for field-mapping to the SAP Merchandise Planning for Retail
InfoProvider are maintained.

In the | Cross-Application Components » Assortment Planning for Retail ¥ Imported Demand Data

Foundation Settings # Integration ¥ Sending System and Master Data System Coupling 3 Customizing
activity, a new column HTTP Destination has been added. You must specify an entry for a relevant SAP ERP
system, including a valid HTTP Destination value, to be able to access SAP ERP assortments and listing
conditions from My Assortment Plans (Version 2) app.

4.2.5.3.4 Reactivate SAP Assortment Planning for Retail

Planning Framework Content

4.2.5.3.4.1 Activate SAP HANA Content

Use

In this procedure, you activate all SAP HANA content required by SAP Customer Activity Repository.

For more information about activating SAP HANA content, see SAP Help Portal at http:/help.sap.com/
hana_platform#& | <your SAP HANA Platform SPS> » Development and Modeling » SAP HANA Developer
Guide (For SAP HANA Studio) » Setting Up the Analytic Model » Creating Views # Activating Objects 3.

Prerequisites

180

As a mandatory prerequisite for a successful activation of the SAP HANA content for SAP Customer
Activity Repository, you must have successfully completed all of the procedures listed in the previous
sections of this guide.

You must also set up the roles and privileges for the Unified Demand Foreast module as described in the
Authorization Requirements for the UDF AFL section of the SAP Customer Activity Repository Security

Guide, available at http://help.sap.com/car|p <your release> ¥ Security Information 3.

You must do this regardless of whether you want to use UDF forecasting in your scenario or not. This
procedure not only enables UDF, but it is required so that the SAP HANA content for SAP Customer
Activity Repository can be activated correctly.
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Procedure

To activate the SAP HANA content, carefully follow the instructions provided in SAP Note 2330386 # .

A Caution

If you are applying a support package or correction on an existing installation and this support package or
correction involves SAP HANA content for the DDF module or the UDF module in SAP Customer Activity
Repository, then you must manually activate this content again. For example, this is the case when you
apply an SAP Note using transaction SNOTE.

Follow the instructions in SAP Note 2145356 #% .

More Information

If you encounter issues during the activation, see the Troubleshooting [page 75] section for possible solutions.

4.2.5.3.4.2 Activate SAP HANA Content for SAP Assortment
Planning for Retail - Part 1

Use

In this procedure, you perform the initial activation of SAP HANA content (views and stored procedures)
required by the SAP Assortment Planning for Retail application.

A Caution

This initial activation results in a partial activation of the SAP HANA content for SAP Assortment Planning
for Retail. Several SAP HANA views depend on local Bl Content objects, and as such, have to be activated
following the activation of these Bl Content objects. For more information, see Activate SAP HANA Content
for SAP Assortment Planning for Retail - Part 2 [page 102].

Prerequisites

As a mandatory prerequisite for a successful activation of SAP HANA content for SAP Assortment Planning for
Retail, you must have successfully completed all of the procedures listed in the previous sections of this guide.
In particular, you must have activated SAP HANA content for SAP Customer Activity Repository.
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Procedure

1. Ensurethatthe svys REPO user has the authorizations required to successfully activate SAP HANA
content.
1. Provideuser sys REPO with object privilege SELECT, with option "Grantable to others”, on the
following physical DB schemas:
o Physical database schema of your back-end system, typically this is called SAP<SID>.
o Physical database schema that contains the SAP ERP tables
You can use the following example SQL statement to grant the required privilege:
GRANT SELECT ON <Your schema name> TO _SYS REPO WITH GRANT OPTION;
2. Assign the required privileges described in section Authorization Requirements for the UDF AFL, of the
SAP Customer Activity Repository Security Guide.
2. Use transaction SE38 to run program /RAP/ACTIVATE HANA CONTENT.
The program activates a majority of the SAP HANA content (views and stored procedures) required by SAP
Assortment Planning for Retail.

Log on to SAP HANA studio.
Open the Modeler and use the Navigator to access your back-end system.
Expand the Content folder located under your system name in the Navigator.

o ok~ w

Expand the package listed below:
O sap.is.retail.rap

You will notice that some of the content in the underlying folders is not deployed. The figure below provides
an example of content that has not been deployed.
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“ g rap
a & ap
a4 B plan
a i Calculabion Migve (3]

«1d BW_DS02.calculationview
si@ BW_DS03_OPT_PLN_PRD_COUNT calculationview
;:? BW_RC0L.calculationview
.ig BW_RC0S_OPT_PLN_SALES_KPLcaleulationview
+'@ RETAIL_PURCHASE_PLAN_INTERFACE.calculationview
4 [ Atribute Wiews (1)

T AP_PLN_HDR.attribubeview
4 = Calculation Views (50
L3 ANMUAL_SEASONS. calculationview
1 ASSORTMEMT_LIST_LOCATIONS HIER. calculationview
:':] ASSORTMENT_LIST_PRODUCTS_HIER.calculationview
'J ASSORTMENT_LIST_PRODUCTS_NO_COLOR.calculationview
/2] ASSORTMENT_LIST_PROD_LOC calculationview
I3 ASSORTMENT_LIST_PROD_LOCS_NOKPLcalculationview
7| ASSORTMENT LIST_SALES_HISTORY.calculationview
{1 ASSORTMENT_PLAN_HDR.calculstiomview
'J ASSORTMENT_PLAN_MERCH_TC_OTB.calculationview
{2} ASSORTMENT PLAN MODE.calculationview
< ASSORTMENT_PLAN_SALES_HISTORY_BW.calculationview
L ASSORTMEMT_PLAN_SALES HISTORY VERSIONS. calculationview
s ASSORTMENT PLAM WEDGE VARIANTS. calculationview
.3 CLUSTER.calculationview

il CLUSTERSET.calculationview

13 CLUSTER_LOCATIOM.calculationview

.'J DISTRIBUTIOM_CHAMMEL.calculationview

<2 MASTER_ASSORTMENTS_TO_BE_DELETED.calculationview
4 = Procedures (&)

kA TE PA AMLA I re

f GET_AP_PLAN_HEADER.procedure |

L& GET_MERCH_PLAN_DATA.procedure

(€ GET_PROD_LIST_KPLBY_NODE_ID.procedure
[ k= PROJECT Chbjects (1)

Example of SAP HANA content not deployed

A small number of views not deploying is an expected result of this procedure, and the remaining content
will be deployed in the Activate SAP HANA Content for SAP Assortment Planning for Retail - Part 2 [page
102] procedure.

O\ Caution

If you see that none of the views/procedures inthe sap.is.retail.rap package are deployed, you
can resolve this by manually selecting, right-clicking, and choosing to Redeploy each of the sub-folders.
This manual redeployment should leave only the views/procedures highlighted above as not deployed.

More Information

Section Activating Objects, of the SAP HANA Developer Guide SAP
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4.2.5.3.4.3 Activate Application Bl Content

Use

In this procedures, you perform a sequential, step-by-step activation of the local Bl Content objects following
the upgrade to SAP Assortment Planning for Retail 1.0 FP3.

i Note

To ensure correct activation of the local Bl Content objects, carry out the activation sequentially, as
specified in the following procedures.

Also, the default Bl setting to collect and activate all dependencies must not be disabled by the user. The
instructions below activate a minimum subset of objects, and it assumed that all their dependencies will be
collected and activated.

Procedure

1. Onyour back-end SAP Assortment Planning for Retail system, open the Data Warehousing Workbench
(transaction RSA1).
2. Verify transport connections.
1. Select Transport Connection in the left-hand frame.
2. Select Object Types.
3. Expand Source System.
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Data Warehousing Workbench: Transport Connection

Switch (Business Functions)

O T2 Tacollected O Doeete &£ Lcro [E Econverson | Gaeex  Ehobject Changeabilty
[tiodaig ]
[ Adminstration || a1 objects Accordng to Type
| Transport Connection ]l » 4% InfoArea -
L » @ Appication -
- €3 54P Transport : g :ioﬁm Catalog

- @ InfoProviders by InfoAreas
. & InfoObjects by InfoAreas

* 95 BEx Web Template
» [1# BEx Web Irem
v [E) crystal Report
» @3 Xcelsius Dashboard

- @mnf es by Application C:
« @ Roles
- [ Object Types
1] ransport Heque
- (@ Packages
* B ML
=~ [ Export

+ @ InfoProviders by InfoAreas

» & InfoObjects by InfoAreas

« & InfoSources by Appication Component
- @ Roles

+ (1 Object Typas

+ B Transport Request

* @ Packages

» [ Enterprise Report

v E Workbook

+ [ Query view

v [H Query Elements

* & Broadeast Setting

» % CompositeProvider

+ [ Open 0DS View

* 2 SAP HAMA Analysis Process

v G MuttiProvider

+ B8 Infoset

v & HybridProvider

» [ semantically Partitioned Object
» €9 InfoCube

» @ Datastore Object (Advanced)
+ [ infoobject

v P Transformation

* "% Open Hub Destination

+ BB Data Flow

» [8) infopackage

» &) Data Transfer Process

v @3 process Chain

» [ Processes -

» 3 Panning -

Selecting Source Systems

(@ (s Grouping .|| ][2 Package [ Collection Mode [

Displat *

Collected objects

Use Select Objects to ensure that the back-end system is selected as the source system.

Choose Transfer Selections.

| 7| Technical name | Blevated... | Last... |1

At the top of the right-hand frame, above the list of Collected objects, choose Grouping and select Only

Necessary Objects.

At the top of the right-hand frame, choose Collection Mode and select Collect Automatically.
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Data Warehousing Workbench: Transport Connection

P

O s Tacolected WE S Doekte & Lct0 [Elconverson  BbBEx B Object Changeabiity  Switch (Business Functions)

[todeing | [ETEEE] [ |crouping |62 paciage [ cotecton tose J] oo .| [B]ER]]
e
[a Al Objects According to Type Colected objects T | Technicalname | Elevated... | Last.. |Last Cha... | Tt

[ Transport Connection + & InfoSource -
+ [ DataSource X

+ [ source system

~ Y SAP Transport = + & Open Hub Destination
+ @ Infoproviders by InfoAreas + B Data Flow

« A8 mfanhiacts hv Tnfaareas » (@] nfnpackzas

Grouping and Collection Settings
3. Select Bl Content in the left-hand frame.

4. Determine your Bl Content installation requirements and apply these to each subsequent step.
If you are carrying out a brand new installation, proceed to the next step.

- Recommendation

If, however, you have previously installed/activated any of the /rRap/* Bl Content, you need to apply
special considerations to the installation/activation of Bl Content following a system upgrade.

o If you have modified any of the previously installed /rRap/* Bl Content objects, we recommend
that for the modified objects, you enable the Match (X) or copy option. When this options is
selected, you will be asked to carry out an additional Transfer selections step during which you
select to install the Active Version (that is, your modified version) or the Content Version (that is,
the SAP delivered, and possibly updated version of the object).

o If you have not modified any of the previously installed /rap/* Bl Content objects, you do not need
to enable the Match (X) or copy option for any of the Bl Content objects, and you don't need to
choose whether to install the Active Version or the Content Version of the objects.

5. Activate InfoObject catalogs.
1. Expand InfoObject Catalog.
2. Use Select Objects to select the /RAP/CHAR CAT and the /RAP/KYF CAT catalogs, that s, all the
InfoObject catalogs that starting with /rRap/*.
3. Choose Transfer Selections.
4. Intheright-hand frame, in the list of Collected objects, verify that both InfoObject catalogs are listed.
5. Right-click on each of the InfoObject catalogs, and choose Install all Bellow.
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6. Choose Install.

If an information dialog box appears, choose Continue. Choose Local Object or enter a package if you
need to transport the objects.

6. Maintain version master data. As of FP3, two new versions, AW1 and AW2, are required.
1. Expand InfoObjects.
2. Search for InfoObject /RAP/VERSN, located under |» Assortment Planning for Retail » RAP Character
InfoObject Catalog 3.

3. Right-click the InfoObject /RAP/VERSN, choose Maintain Master Data from the context menu, and
maintain the following entries on the Time Independent tab:

Version

AP1

AP2

AW1

AW2

0OC1

0Cc2

OM1

oM2

APF

REF

000

The supported planning versions are described in detail in the Maintain Customizing Table /RAP/
RS_VARCUST section of the Common Installation Guide.

i Note

If you encounter problems opening the master data maintenance WebDynpro application, ensure
that you have implemented SAP Note 2034623 .

7. Activate DataStore Objects.

1. Expand | More Types ¥ DataStore Object (Classic) 3.
Use Select Objects to select all DataStore Objects starting with /rRaP/ *.
Choose Transfer Selections.

In the list of Collected objects, verify that the option in the Install column is enabled for each of the
objects.

> w

5. Choose Install. If an information dialog box appears, choose Continue. Choose Local Object or enter a
package if you need to transport the objects.
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If during the installation, you are presented with a dialog asking you to add objects to a personal list,
select No.
If activation warnings similar to the ones displayed below appear, you can ignore them.

Date/ Time/User
* & Attribute _RAP_CLSET: Conversion routing ALPHA ignor
= ¢ Attribute _RAP_CLUST: Compounding ignored
= & Attribute _RAP_LOCAT: Conversion routine ATINN ignof
= & Attribute _RAP_PRDCT: Conversion routine ALPHA ignoi
= & Attribute _RAP_VARNT: Conversion routine ALPHA igno
* & Attribute _RAP_VERSN: Conversion routine ALPHA ignoi
* @ Creating column view of type IDS for object /RAP/DSO01...
~ & Column view activated for object /RAP/DSO1
* @D DataStore Object (classic) /RAP/DSOL activated
* & Post Processing/Checking the Activation for DataStore Object (|
~ & Creating Export DataSource and dependent Objects
* @ Reading the Metadata of /RAP/DS02 ...
* @ Creating DataSource /RAP/SDS02 ...
* & The short text of DataSource /RAP/8DS02 is not mainta
« & The short text of DataSource /RAP/8DS02 is not mainta

» @ Writing of object catalog entries (TADIR)
« @ Program ID Q0L57Y1I6BIWYCOBVZUS1IWVYK retrieved for [
~ & Initial entry written on the status of data of the InfoProvider
b & Activate external SAP HANA view for object /RAR/DSO2
* @ Creating column view of type IDS for object /RAP/DSD2...
* & Column view activated for object /RAP/DS02
* @ DataStore Object (classic) /RAP/DS02 activated
v A Post Processing/Checking the Activation for DataStore Object (
v A Initial entry written on the status of data of the InfoProvider

+ PR Fracbine rabame ssines nf e TAC £ar ahin INARIMECAD

Warnings
6. Verify that DataStore Object /RAP/DS07 is activated.
An external view generated from DataStore Object /RAP/DS07 has been added in the SAP Assortment
Planning for Retail 1.0 FP2 release. This requires an explicit verification of the activation of this
DataStore Object.
8. Activate InfoCubes.
Expand InfoCube.
Use Select Objects to select all InfoCubes starting with /RAP/RC*.

Choose Transfer Selections.

> w e

In the list of Collected objects, verify that the option in the Install column is enabled for each of the
objects.

5. Choose Install. If an information dialog box appears, choose Continue. Choose Local Object or enter a
package if you need to transport the objects.

If activation warnings similar to the ones displayed below appear, you can ignore them.
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+ @ Checking InfoCube /RAP/RCOS
* & Checking InfoCube [RAP/VCD1

> & Column view activated for object HRAPIRCOI

= & Check of InfoProvider /RAP/VCD1: = _& Activate external SAP HANA view for object ;RAP;‘RCl}l

* 8 Unable to find SAP HANA information model sap.is.retad.rap_ ap/INVENTORY_ACTUALS_VC
+ £ Mapped attrbute AP_PLN_ID does not exst for characteristic /RAP/ASRTP

* O Mapped attrbute CLUSTERSET_ID does not exist for charactenstic /RAP/CLSET

= & Mapped attrbute CLUSTER_ID does not exst for charactenstic /RAP/CLUST

* 8 Mapped attrbute EXT_LOC_ID does not exst for characteristic [RAP/LOCAT

* & Mapped attrbute COLOR does not exist for characteristic [RAP/PROLR

= ﬂ Hawed attrbute EXT_PROD_ID does not exit for characteristic IWIPRIKT

& o Mapped attrbute VERSION does not exist for characterst IWNERSH

* & Mapped attrbute CURRENCY does not exist for characteristic DCURRENCY

+ & Mapped attrbute MANDT does not exst for characteristic OMANDT

* & Mapped attrbute UOM does not exst for characterstic OUNIT

* & Mapped attrbute INVENTORY_AT_COST does not exist for key figure /RAR/CIVCY
+ O Mapped attrbute INVENTORY_AT_RETAIL does not exit for key figure [RAP/CIVRY
+ & Mapped attrbute INVENTORY does not exist for key figure /RAP/CIVUN

+ & Mapped attrbute ON_ORDER does not exst for key figure /RAP/ONOUN

= & Wamings occurred whie checking the InfoProvider

Warnings

9. Activate new Aggregation Level.

> w =

Expand | Planning » Aggregation Level 3.

Choose Transfer Selections.

objects.

D Package system—lom\ bw.bwzhana. rap, type: Analytic View, name: R

= & Attribute _RAP_ASRTP: Conversion routine ALPHA ignored
= ¢ Attribute _RAP_CLSET: Conversion routine ALPHA ignored
= & Attribute _RAP_CLUST: Compounding ignored

= & Attribute _RAP_LOCAT: Conversion routine ATINN ignored
= & Attribute _RAP_PRDCT: Conversion routine ALPHA ignored
= & Attribute _RAP_VARNT: Conversion routine ALPHA ignored
= & Attribute _RAP_VERSN: Conversion routine ALPHA ignored
= ¢ Attribute OFISCPER: Conversion routine PERI7 ignored

= & Attribute OFISCPER: Compounding ignored

* & Attribute DREQUID: Conversion routine RQUID ignored

* & Attribute OUNIT: Conversion routine BUNIT ignored

Use Select Objects to select the /RAP/D08A02 Aggregation Level.

In the list of Collected objects, verify that the option in the Install column is enabled for each of the

5. Choose Install. If an information dialog box appears, choose Continue. Choose Local Object or enter a
package if you need to transport the objects.

10. Reactivate Planning Sequence Objects.

1. Expand|p Planning ¥ Planning Sequence 3.

2. Use Select Objects to select the following Planning Sequences:

o

o}

o

o}

/RAP/D12A01 PSO1
/RAP/D12A01 PS02
/RAP/D15A01 PSO1
/RAP/D15A01 PS02
/RAP/D07A04 PSO1
/RAP/MO6A01 PSO7
/RAP/R10A01 PS02

3. Choose Transfer Selections.

4. Inthe list of Collected objects, verify that the option in the Install column is enabled for each of the
objects.
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5. Choose Install. If an information dialog box appears, choose Continue. Choose Local Object or enter a
package if you need to transport the objects.
11. Reactivate Workbooks.

Expand | More Types # Analysis Office Excel Workbook .
2. Use Select Objects to select the following workbooks:

© /RAP/OPTIONPLANBYMODULE

© /RAP/OPTIONPLANBYCLUSTER

© /RAP/REFINEASSORTMENT

O /RAP/PLANASSORTMENT
3. Choose Transfer Selections.

4. Inthe list of Collected objects, verify that the option in the Install column is enabled for each of the
objects.

5. Choose Install. If an information dialog box appears, choose Continue. Choose Local Object or enter a
package if you need to transport the objects.

12. Choose Exit to leave the transaction.

4.2.5.3.4.4 Activate SAP HANA Content for SAP Assortment
Planning for Retail - Part 2

Use

In this procedure, you perform the final activation of SAP HANA content (views and stored procedures)
required by the SAP Assortment Planning for Retail application. This final activation results in a full activation
of the SAP HANA content for SAP Assortment Planning for Retail. Several SAP HANA views depend on local Bl
Content objects, and as such, have to be activated following the activation of these Bl Content objects, as
described in this procedure.

Prerequisites

As a mandatory prerequisite for a successful activation of SAP HANA content for SAP Assortment Planning for
Retail, you must have successfully completed all of the procedures listed in the previous sections of this guide.

Procedure

1. Ensurethatthe sys REPO user has the authorizations required to successfully activate SAP HANA
content.
1. Provideuser SYsS REPO with object privilege SELECT, with option "Grantable to others", on the
following physical DB schemas:
o Physical database schema of your back-end system, typically this is called SAP<SID>.
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o Physical database schema that contains the SAP ERP tables
You can use the following example SQL statement to grant the required privilege:
GRANT SELECT ON SCHEMA <Your schema name> TO _SYS REPO WITH GRANT OPTION;
2. Assign the required privileges described in section Authorization Requirements for the UDF AFL, of the
SAP Customer Activity Repository Security Guide.
2. Use transaction SE38 to run program /RAP/ACTIVATE HANA CONTENT.
The program activates the remaining SAP HANA content (views and stored procedures) required by SAP
Assortment Planning for Retail.

Log on to SAP HANA studio.
Open the Modeler and use the Navigator to access your back-end system.
Expand the Content folder located under your system name in the Navigator.

o ok w

Expand the package listed below:
O sap.is.retail.rap
All the content in the underlying folders should be active.

More Information

Section Activating Objects, of the SAP HANA Developer Guide SAP

4.2.5.3.4.5 Verify Activation of External Views

Use

During activation of SAP HANA content for SAP Assortment Planning for Retail, several external views are not
automatically activated. Following an upgrade, you need to verify that all previously activated external views
remain active.

Procedure

1. Use either transaction SE11 or SE80 to verify that all the external views listed in SAP Note 2067030#% are
in an activate state. If they are not, manually activate the views.
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4.2.5.3.5 Maintain Customizing Table /RAP/RS_VARCUST

Use

In this procedure, you maintain entries in the variable customizing table /RAP/RS_VARCUST in the back-end
system. For each SAP Assortment Planning for Retail query, the entries of this table specify a mapping of a
data version (for example, actual data versus planning data) to the source of data (InfoCube).

Procedure

1. Log on to your back-end system.

2. Runreport /RAP/SEED BW CUSTOMIZING DATA (transaction SE38).

3. Determine whether you want to overwrite the existing entries in the /RAP/RS_VARCUST table.
If you do want to overwrite the contents of the table, enable the Remove Existing Entries option. If you don't
want to overwrite the contents of the table, but want to append the new entries, disable the Remove
Existing Entries option.

i Note

Duplicate entries that can potentially be created if you choose to disable the Remove Existing Entries
option, which will result in an error.

4. Enable the Test option and choose Execute to run the report in test mode.
Running the report in test mode allows you to verify that you can successfully update the /rRaP/
RS VARCUST table. No entries are persisted in the table as a result.
5. Once you have successfully executed the /RAP/SEED BW CUSTOMIZING DATA report in test mode,
disable the Test option and choose Execute to run the report.
6. Optionally, once the report has finished executing, you can verify the entries of the /RAP/RS_VARCUST
variable customizing table.
If required, you can make changes to any of the entries made by the /RAP/SEED BW CUSTOMIZING DATA
report by doing the following:
1. Open the Data Browser (transaction SE16).
2. Enter /RAP/RS_VARCUST in the Table Name field and choose Create Entries.

3. Choose Execute followed by Create.
On the Table /RAP/RS_VARCUST Insert screen, you will be able to make the following entries:

Field Name User Entry

COMPID SAP Assortment Planning for Retail technical query name.

For example, /RAP/M01A02_TIRQ02.

VNAM ICUBE InfoCube variable name.

For example, /RAP/INFOPROV_ESM 01.
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Field Name User Entry

INFOCUBE InfoCube identifier.

For example, /RAP/RCO1.

VNAM VERS Version variable name.

For example, /RAP/VERSN MSM 01.

VERSION Version |dentifier.

There are several supported planning versions:

o AP1:Location level version 1. Version that is typically used as the planning version.

o ap2:Location level version 2. Version typically used to simulate different scenarios without
having to change your planned version.

o awl: Week level version 1. Version that is typically used as the planning version.

o aw2: Week level version 2. Version typically used to simulate different scenarios without hav-
ing to change your planned version.

o oc1: Option plan by cluster simulation version 1. Version that is typically used as the plan-
ning version.

o oc2: Option plan by cluster simulation version 2. Version typically used to simulate different
scenarios without having to change your planned version.

o oM1: Option plan by module simulation version 1. Version that is typically used as the plan-
ning version.

o oM2: Option plan by module simulation version 2. Version typically used to simulate different
scenarios without having to change your planned version.

o APF: Final version (planned data). After completing the planning, the user will select the
plan they want to finalize and review in the Plan Weekly Sales and Receipts workbook. Only
the APF version is available in Plan Weekly Sales and Receipts.

o REF: Reference version (past data). This is historical data for the items from the time frame
of the reference period. This data is used to pre-populate the planning version by using the
copy function. This allows the planner to have a baseline when starting the planning proc-
ess. It is recommended to seed the planning version with the REF data.

o 000: Actual version (current data). The user can see current inventory values with this such

as Actual Inventory and Open Orders.

F4HELP Flag that specifies whether the field provides F4 help or not.

4. Maintain entries in the /RAP/RS_VARCUST table as required.
For example you can change the InfoCube used as the source of data for a particular planning version.
5. Choose Save.
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4.2.5.3.6 Update Fiscal Year Variant Entries

Use

In this procedure you update previously maintained fiscal year variants ( OFISCVARNT 'RW'). The SAP
Merchandise Planning for Retail application, which can be used in conjunction with the SAP Assortment
Planning for Retail application, only supports fiscal years with 52 posting periods. As a result, fiscal year variant
entries must be adjusted, entering each year with 53 posting periods as a shortened fiscal year.

A\ Caution

You must maintain fiscal year variants for at least one year past the years for which you are planning. For
example, if your assortment plans extend to December 2018, you must maintain fiscal year variants until
December 2019.

The steps provided in this procedure allow you to maintain 0OFTSCVARNT 'RW' using the standard 4-5-4
calendar entries. If you are using alternative fiscal periods in your retail business, for example, each week
starting on a Sunday instead of Saturday, you can provide your own entries instead of the ones suggested in
this guide.

Procedure

1. Logon to your back-end system.
2. Launch fiscal year variant maintenance (transaction GVAR).

3. Choose New Entries.
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4. Onthe New Entries: Overview of Added Entries screen make the following sets of entries:

Fiscal year variants

FV  Description Year-depen... Calendar yr Number of postin... No.of special peri
BW Assort. Plan Week v O 53 -
r -

Create New Fiscal Year Variant
5. Choose Enter.
An information message is displayed about creating more than 16 periods, choose Continue.
6. Choose Back.
You can see the newly created entry.

7. Mark the entry RW and double-click on Shortened Fiscal Years from the Dialog Structure.

8. Enter 2012 inthe Fiscal year field and choose Continue.

9. Choose New Entries.

10. Enter 52 in the No. of posting periods field in the Shortened Fiscal Years section.

11. Choose Back twice.

12. Open SAP Note 2112634#% , locate the entries for year 2012, and enter the data by copy-and-paste.

13. Repeat steps 7-12 to maintain the weekly fiscal year variant for years 2013, 2014, 2015, 2016, 2017, 2018,
2019, and 2020, entering each year as shortened fiscal year. The corresponding tables are available in SAP
Note 2112634 # .

14. Choose Save after you have finished the maintenance for year 2020.

Common Upgrade Guide for SAP Customer Activity Repository retail applications bundle 1.0
SPS7
Upgrade Scenarios PUBLIC 195


http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/2112634
http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/2112634

4.2.5.3.7 Set Language for Ribbons and Buttons in
Workbooks (Optional)

Use

In this optional procedure, you can change the language settings specific to SAP Assortment Planning for
Retail workbooks. During the upgrade, some of the workbooks are updated, and, if you have previously
changed the language settings of these workbooks, you need to make these settings again following the
upgrade.

You can set the desired language of the following user interface objects:

® Ribbons Planning Functions, Refinement Functions, and Extended Features
® Tooltips for planning functions

® Message texts

e Buttons

The content of the workbooks consists of multiple parts:

e The language of the standard menus and standard ribbons depends on the language set for Microsoft
Excel.

e The language of the contents in the cells (mainly KPIs) depends on the user-selected system language of
the back-end system.

e The language of the user interface objects that are specific to the workbooks of SAP Assortment Planning
for Retall, is not set by the selected system language of the back-end system, but you can change it for
each workbook according to the following procedure. The default language is English.

Procedure

1. Unhide the worksheet SAP_TEXT_CUSTOMIZING using standard functionality of Microsoft Excel.

2. Onthe worksheet SAP_TEXT_CUSTOMIZING, copy the column of the desired language to column B -
Custom Text.

3. Hide the worksheet SAP_TEXT_CUSTOMIZING.

4. Save your changes in the worksheet on the SAP NetWeaver Server by choosing |» File » Analysis » Save
Workbook to SAP NetWeaver

4.2.5.3.8 Verify that Data Replication is Running Following
the Upgrade

In general, following the upgrade, you need to ensure that all of the data replication described in Configure Data
Replication section of the Common Installation Guide is still running.
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In particular, you need to pay attention to the following:

e Ensure that time-dependent article hierarchies are properly loaded into SAP Assortment Planning for
Retail following the upgrade. See Load of Time-Dependent Article Hierarchies section of the Common
Installation Guide.

e Allthe tables listed in SAP Note 2054656#% are being replicated. New tables can be added with each new
release.

e Ensure that periodic tasks to load product attributes into SAP Assortment Planning for Retail are still
running following the upgrade. See, Load Product Attributes into SAP Assortment Planning for Retail section
of the Common Installation Guide.

e Ensure that OTB data is being loaded from the appropriate source. For more information, see the Load
Merchandise Planning Data section of the Common Installation Guide.

4.2.5.3.9 Runthe SAP Assortment Planning for Retail 1.0
FP3 Update Report

1. Runtransaction SE38.
2. Executethe /RAP/FP03 UPGRADE APR report.

4.2.5.3.10 Run the Validation Report

1. Runtransaction SE38.
2. Executethe /DMF/VALIDATE CAR INSTALLATION report.
3. Select the Assortment Planning scenario and select Execute.
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Running this report allows you verify the success of the installation, providing a log of potential issues. For
example, you may be presented with the following results:

[= Display logs x

WL (SRR P . 5 L P [ T ) o |72 A o[ 10 ]

Type Message Text LTxt
- Check - Installed SAP Notes

- Check - Planning Application Kit (PAK)

— Check - Fiscal Calendar

Maintain fiscal year variant 'RW". @‘
— Check - SAP HANA Time Dimension

Maintain SAP HANA time dim. at least 2 years back and 5 years in future. (]
- Check - Table /RAP/RS_VARCUST

--- Check - BI Master Data for Planning Versions

— Check - BI Technical Content Activation

— Check - BI APR Content Activation

— Check - SAP HANA AFL PAL

— Check - SAP HANA AFL OFL

CODDDODsD@OmD

L |

‘:::1 W Technical Information JE Help JE

Validation Report Results

View the long text associated with each message to see the link to the documentation describing the
procedure you need to troubleshoot.

4.2.5.3.11 Configure Index Calculation

Use

The SAPUI5 application index provides an indexing and caching mechanism for information related to SAPUI5
apps, components, and libraries that are contained in SAPUI5 repositories on the SAP NetWeaver Application
Server for ABAP. This index, calculated by the Calculation of SAPUI5 Application Index for SAPUI5 Repositories
report ( /UI5/APP INDEX CALCULATE), makes it possible to retrieve and find this information significantly
faster than when carrying out the calculations each time it's requested.

We recommend that you schedule the Calculation of SAPUI5 Application Index for SAPUI5 Repositories report
as to run as a background job on your front-end server.

Following any changes to the content of the SAPUI5 ABAP repository (for example, installation of a new version
of the SAPUI5 distribution layer or implementation of an SAP Note containing changes to an SAPUI5 app), the
SAPUI5 application index should be updated using the calculation report. This report has to be executed in
every system whenever the content of the SAPUI5 ABAP repository has changed.
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Procedure

1. Determine the SAP NetWeaver version on your front-end server.
2. Carry out the instructions specific to your SAP NetWeaver version:
o SAP Gateway for SAP NetWeaver 7.31
o http:/help.sap.com/nw-uiaddon20# | Application Help » SAPUI5: Ul Development Toolkit for
HTML5 » Developing Apps # The SAPUI5 ABAP Repository and the ABAP Back-End Infrastructure
» SAPUI5 Application Index 3
o SAP Gateway for SAP NetWeaver 740
o http:/help.sap.com/nw74#% |y Application Help ¥ Ul Technologies in SAP NetWeaver with SAP_UI
740 » SAPUI5: Ul Development Toolkit for HTML5 » Using the SAPUI5 Repository » SAPUI5
Application Index
Alternatively, you can launch the Calculation of SAPUI5 Application Index for SAPUI5 Repositories
report ( /UT5/APP_INDEX CALCULATE) from Customizing under [ SAP NetWeaver » Ul

Technologies ¥ SAP Fiori ¥ Initial Setup ¥ Schedule SAPUI5 Application Index Calculation 4.

4.2.5.3.12 Activate SAP Assortment Planning for Retail
OData Services

Use

A number of OData services are required to run the SAP Assortment Planning for Retail application.

For security reasons, all OData services are delivered in an inactive state. You must activate these application-
specific OData services to use the SAP Fiori user interface of the SAP Assortment Planning for Retail
application.

Procedure

1. Logon to your front-end system (your SAP NetWeaver system).
2. Go to Customizing (transaction SPRO).

3. Navigate to | SAP NetWeaver » Gateway # OData Channel » Administration  General Settings j Activate

and Maintain Services .
You are presented with the service catalog. This is a list of all the services that are currently active on your
SAP Gateway.
4. Get SAP Assortment Planning for Retail OData services:
1. Choose Add Service.
The Add Service screen is displayed.
2. Enter the system alias of your back-end system.
This is the alias created for your back-end system in the Connect SAP NetWeaver Gateway to your
Back-End System [page 48] procedure. For example RAPCLNT100.
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3. Enter /DMF* in the Technical Service Name field.

4. Choose Get Services.
The Add Selected Services screen is displayed.

5. Select the SAP Assortment Planning for Retail OData services you would like to activate, and choose
Add Selected Services.

OData Service

/DMF/CURRENCY LIST SRV

/DMF/LOCATION CLUSTERSET SRV

/DMF/MODULE_MANAGEMENT SRV

/DMF/OBJ_ATTRIBUTE_ SRV

/DMF/SEARCH LOCATIONS SRV

/DMF/SEARCH PRODUCTS SRV

/DMF/SEASONS SRV

/DMF/MASTER _DATA SRV

The selected OData services are now active in your SAP Gateway.

6. Enter /RaP* in the Technical Service Name field.

7. Choose Get Services.
The Add Selected Services screen is displayed.

8. Select the SAP Assortment Planning for Retail OData services you would like to activate, and choose
Add Selected Services.

OData Service

/RAP/ASSORT AUTOMATIC PROP SRV

/RAP/ASSORT LIST MODULE SRV

/RAP/ASSORTMENT PLAN SRV

/RAP/OPTION PLAN SRV

/RAP/PHP_ MATCH SRV

/RAP/SADL_PROD LIST KPI SRV

The selected OData services are now active in your SAP Gateway.
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More Information

For SAP NetWeaver 7.31, see SAP Library for User Interface Add-On 1.0 on SAP Help Portal at http://
help.sap.com/nw-uiaddon20# |+ Application Help » SAP Fiori Launchpad  Setting Up the Launchpad »
Activating SAP Gateway OData Services 4.

For SAP NetWeaver 74, see the documentation on SAP Help Portal at http://help.sap.com/nw 74 Fr |l
Application Help » Ul Technologies in SAP NetWeaver with SAP_UI 740 » SAP Fiori Launchpad ¥ Setting Up the
Launchpad ¥ Activating SAP Gateway OData Services 4.

4.2.5.3.13 Activate SAP Assortment Planning for Retail ICF
Services

Use

For security reasons, all Internet Communication Framework (ICF) services relevant to your SAP Assortment
Planning for Retail application are made available in an inactive state.

You have activated the central ICF services in the Perform General SAP NetWeaver Gateway Configuration
[page 48] and Configure Central Ul Component [page 51] procedures. This procedure provides the instructions
to activate ICF services required for the SAP Assortment Planning for Retail SAP Fiori apps.

Procedure

1. Log on to your front-end server.

2. Open service maintenance (transaction SICF).

3. Inthe Maintain Service screen, select the Location Clustering service by specifying the following:
o Hierarchy Type: SERVICE
© Virtual Host: DEFAULT HOST
o Service Path: /sap/bc/ui5_ui5/sap/locclsts_v2/

4. Choose Execute.

o

To activate the service, choose Service/host Activate.

6. Repeat steps 3 to 5 to ensure that all of the following services are activated:
© /sap/bc/ui5 uiS5/sap/attribmgmt v2/

© /sap/bc/uib uiS5/sap/assortmodule v2/

© /sap/bc/ui5 uiS/sap/assortplan v2/

© /sap/bc/ui5 uiS/sap/ddfreuse v2/

© /sap/bc/ui5 uiS5/sap/locclsts v2/

© /sap/bc/ui5 uiS5/sap/modulemgmt v2/

© /sap/bc/ui5 uiS5/sap/optionplan v2/
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0 /sap/bc/ui5 uib5/sap/phpmatch v2/

4.2.5.3.14 Define System Alias for Back-End Transactions

Use

A number of SAP Assortment Planning for Retail SAP Fiori apps, installed on your front-end system, launch
transactions directly on the back-end system. For example, the Manage Products tile actually launches the
Demand Data Foundation (DDF) powL EASY WebDynpro application.

To enable this behavior, you need to create a dedicated RFC connection between the front-end and the back-
end systems.

Procedure

1. Logon to your front-end system, that is, the system where you have installed the user interface (Ul)
components of the SAP Assortment Planning for Retail application.

2. Launch Configuration of RFC Connections (transaction sM59).

3. Create an RFC connection with the RFC Destination set to Sap_ ISR _CARAB and Connection Type set to H
(HTTP connection).
Ensure to maintain all of the settings required to connect to your back-end system, in particular, the Target
Host entry on the Technical Settings tab.

4. Create another RFC connection with the RFC Destination set to SAP ERP ISR CARAB and Connection
Type set to 5 (HTTP connection).
Ensure to maintain all of the settings required to connect to your front-end system to the SAP ERP system,
in particular, the Target Host entry on the Technical Settings tab.

5. Save your changes.

6. Open Launchpad Customizing (transaction LPD CUST).

7. Select the SAP Assortment Planning for Retail role (UTRAP001), and choose Display.
The two catalogs, Assortment Planner and Planning Administrator, are displayed.

8. Ineach of the catalogs, selecting one app at a time, make the following settings:

Catalog App System Alias Description

Assortment View Log SAP ISR CARAB This setting allows the My Assortment Plans (Version 2)

Planner app to launch transaction SL.G1 on the back-end system.
i Note

This application is only used to configure a link to
the back-end system, you do not need to add this
app to your SAP Fiori launchpad.
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Catalog App

System Alias

Description

View ExtAssort
Listing Conditions

SAP ERP ISR CAR
AB

This setting allows the My Assortment Plans (Version 2)
app to launch transaction wsL.10 on the connected SAP
ERP system.

i Note

This application is only used to configure a link to
the SAP ERP system, you do not need to add this
app to your SAP Fiori launchpad.

View External
Assortments

SAP ERP ISR CAR
AB

This setting allows the My Assortment Plans (Version 2)
app to launch transaction wRF_Ws0A3 on the connected
SAP ERP system.

i Note

This application is only used to configure a link to
the SAP ERP system, you do not need to add this
app to your SAP Fiori launchpad.

Assortment Manage Category
Planner responsibilities

SAP ISR CARAB

This setting allows the Manage Category Responsibilities
app to launch the corresponding DDF WebDynpro appli-
cation.

Manage Products

SAP ISR CARAB

This setting allows the Manage Products app to launch
the corresponding DDF WebDynpro application.

Manage Locations

SAP ISR CARAB

This setting allows the Manage Locations app to launch
the corresponding DDF WebDynpro application.

4.2.5.3.15 Troubleshoot Front-End Server Upgrade

Use

Following the upgrade of the product version on the front-end server, you may not be able to see some of the
SAP Assortment Planing for Retail 1.0 FP3 SAP Fiori tiles in your launchpad. This section outlines how to
troubleshoot these issues, should you experience them.

These steps are also listed in the Troubleshooting section of the SAP Assortment Planing for Retail

Administrator's Guide available on the SAP Help Portal at http://help.sap.com/rap#|¢ <Your Release> »

System Administration and Maintenance Information j» Administrator's Guide .
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Process

Do the following:

1. Check that all of the required BSP applications are listed in the UTRAP001 package.

Log on to your front-end system (your SAP Gateway system).

Launch the Object Navigator (transaction SE80).

In the Repository Browser, open package UTRAP0O1.

Expand all of the embedded packages of embedded package CONTENT RAP TRANS.

o K~ w D=

Verify that the following BSP Applications are listed:

Package v ~

[uIRAPOO1 Ears v
(@ L= LIelal &R I3 ]

Object Name Description

~ [ UIRAPOOL Structure package for UIRAP

~ [ Subpackages
+ ] CONTENT_RAP_COMMON
~ [ CONTENT_RAP_TRANS

Main package fer common obejcts for RAP
Main package for transactional for RAP

= [= Subpackages
~ [ RETAIL_DDF Package for DDF
~ [ BSP Library
= [ BSP Applications
» [ ATTRIBMGMT V2 Manage Product Attriubtes: Fiori ID FOB29A |
» 1 DDFREUSE_V2 Fiori Reuse Components for DDF: Fiori ID FOB54A
» 1 LOCCLSTS_ V2 Location Clustering: Fiori ID FO550A
» [(21MODULEMGMT _V2 Module Management: Fiori ID F1682A
~ [ RETAIL_RAP_AP Package for RAP AP
~ [£= BSP Library
~ [ BSP Applications
» [1ASSORTMODULE_V2 Assortment Module: Fiori ID F1567A
» 1 ASSORTPLAN_V2 Assortment Plan: Fiori ID FO551A
» [Z1OPTIONPLAN V2 Option Plan: Fiori ID FO830A
» [IIPHPMATCH_v2 PHP Matching: Fiori ID FO831A

BSP Applications
6. If you do not see one or more of the BSP applications listed above, right-click on each of the

RETATL_DDF and RETATL RAP AP packages, and select | Other Functions » Rebuild Object List 3.

A\ Caution

Do not rebuild objects on a higher package level.

2. Cleanthe cache.
1. Logon to your front-end system (your SAP Gateway system).
2. In Customizing (transaction SPRO), navigate to [ SAP NetWeaver » Ul Technologies  SAP Fiori
Data Administration ¥ Invalidate Caches 3.
This activity launches the /UI2/INVALIDATE GLOBAL CACHES report. This reportinvalidates all

server-side caches in SAP NetWeaver user interface services, which can become out-of-date following
an upgrade.

3. If necessary, implement instructions listed in SAP Note 2147669 #r .
3. Remove any previously customized versions of the UTRAP001 launchpad.

1. Logon to your front-end system (your SAP Gateway system).

2. Launch the Overview for Launchpads (transaction LPD_CUST).
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3. Search for Role UIRAP001, and see whether any instances exist where the User Name is not SAP. If so,
this means that customized versions of the UTRAP001 launchpad exist, and these take precedence
over the standard launchpad instance delivered by SAP.

4. Delete all but the launchpad instance delivered by SAP.

4.2.6 Previous Releases to 1.0 SP5

This section is intended for existing SAP Customer Activity Repository or SAP Promotion Management for
Retail customers who have never configured or used SAP Assortment Planning for Retail and would like to
upgrade to SAP Assortment Planning for Retail 1.0 SP5.

A\ Caution

We do not recommend using SAP Assortment Planning for Retail application versions lower than SAP
Assortment Planning for Retail 1.0 FP1. If you would like to upgrade to SAP Assortment Planning for Retalil

1.0 FP1, see http://help.sap.com/apr# |+ SAP Assortment Planning for Retail 1.0 FP1 j Installation and
Upgrade Information » Upgrade Guide .

If you have an existing implementation of SAP Customer Activity Repository or SAP Promotion
Management for Retail, we recommend that you upgrade directly to the SAP Assortment Planning for
Retail 1.0 SP5 release. This requires you to upgrade your back-end system to the CAR RETATL APPL
BUNDLE 1.0 SPSé6 release and your front-end server to the SAP FIORI FOR SAP CARAB 2.0 SPS1
release.

426.1 Quick Guide

This section includes a checklist with all actions that you have to perform. The actions are in chronological
order, so that you can work through them like a checklist.

Checklist

Prerequisites
Mandatory Steps

[J Ensure that you have implemented the necessary SAP Notes listed in the SAP Notes for the Upgrade
section.

[J Ensure that your landscape meets the requirements outlined in the Prerequisites section.
Preparation
Mandatory Steps

[ Verify that you have all of the required SAP HANA users and privileges. See Verify SAP HANA Users and
Privileges [page 83].
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[J Configure AFL and OFL usage. See Enable Usage of PAL Functions [page 86] and Check the OFL
Installation [page 87].

Upgrade Process
Mandatory Steps
1 Upgrade your back-end system product version.

[0 Upgrade the application function libraries (UDFAFL INST 100, POSAFL INST 100).

I Although not recommended, if you were previously using an application version lower than SAP
Assortment Planning for Retail 1.0 FP1, clear back-end system tables.

[J Upgrade or install product-specific SAP Fiori Ul components on the front-end server.
Follow-Up Activities
Mandatory Steps

[] Create SAP ERP tables.

[ Carry out all of the post-installation steps listed in the Common Installation Guide under http://
help.sap.com/rapf|l» SAP Assortment Planning for Retail 1.0 FP2 » Installation and Upgrade Information »
Installation Guide » Common Installation Guide » Implementation Scenarios » SAP Assortment Planning
for Retail ¥ Post-Installation 3.

Optional Steps

L1 If required, troubleshoot front-end server upgrade.

4.2.6.2 Upgrade Process
42.6.21 Implement SAP Note 2298340

Use

Prior to upgrading the CAR RETAIL APPL BUNDLE 1.0 back-end product version from an older support
package stack (SPS) to a newer one, you need to verify the SAP NetWeaver 740 SPS in your system landscape.
Important corrections, relevant for Core Data Services (CDS) views, and required by the latest SPS of cAR
RETAIL APPL BUNDLE 1.0, areonly available as of SAP NetWeaver 740 SPS 15.

Procedure

1. Verify your SAP NetWeaver 740 support package stack.
If your landscape contains SAP NetWeaver 740 SPS 12, SPS13, or SPS14, you will need to implement SAP
Note 2298340/ to apply corrections relevant for CDS views.
If your landscape has been upgraded to SAP NetWeaver 740 SPS 15, you do not need to implement SAP
Note 2298340#% , and you can go to the next procedure.
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2. Read and implement SAP Note 2298340#% prior to upgrading the back-end system product version.

More Information

http://help.sap.com/hana_platform# |l Development and Modeling i SAP HANA Modeling Guide (For SAP
HANA Studio) 3

4.26.2.2 Upgrade SAP Customer Activity Repository Retail
Applications Bundle

Use

This procedure describes how to upgrade the CAR RETATIL APPL BUNDLE 1.0 back-end product version
from an older support package stack to a newer one.

Procedure

1. Check your upgrade scenario:
1. Navigate to the Product Availability Matrix (PAM) at http:/support.sap.com/pam#.
2. Forinformation about the available support package stacks (SPS), search for the CAR RETAIL APPL
BUNDLE 1.0 product version, and choose Support Package Stacks.
3. Forinformation about the supported upgrade paths, choose Related Product Versions.
4. For information about the software components in the SPS, choose Technical Release Information and
consult the subsections, such as Database Systems.
5. To navigate directly to the download area for the SPS, choose [+ SAP Software Download Center » CAR
RETAIL APPL BUNDLE 1.0 - Support Packages & Patches 3.
Alternatively, you can get there from the SAP Support Portal by choosing http://support.sap.com/
swdc# |+ Support Packages and Patches » Software Downloads j» SUPPORT PACKAGES & PATCHES »
By Alphabetical Index (A-Z) » C » CAR RETAIL APPLICATIONS BUNDLE » CAR RETAIL APPL BUNDLE
103
2. Patch the support package stack using the Support Package Manager tool (transaction spam).
For more information about this tool, see SAP Help Portal at http://help.sap.com/spmanager

|» Application Help 7, as well as SAP Note 1803986 .

To finalize the upgrade of the back-end product version, you must additionally do some manual steps. Continue
with the next section.

Download and Install the Application Function Libraries (AFLs)
There are two components that you cannot upgrade using Support Package Manager.
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e Unified Demand Forecast application function library (UDF AFL, software component version
UDFAFL_INST 100, provides the demand modeling and forecasting services in SAP Customer Activity
Repository, runs directly in the SAP HANA database)

e On-Shelf Availability application function library (POS AFL, software component version POSAFL_INST
100, provides the On-Shelf Availability services in SAP Customer Activity Repository, runs directly in the
SAP HANA database)

You need to download one UDF AFL revision and one POS AFL revision manually and install them together in
your SAP HANA database.

Where to Download
Both AFLs are provided as part of the CAR RETAIL APPL BUNDLE 1.0 product version onthe SAP Support
Portal under http://support.sap.com/swdcr|» Support Packages and Patches j» Software Downloads »

SUPPORT PACKAGES & PATCHES » By Alphabetical Index (A-Z) # C » CAR RETAIL APPLICATIONS BUNDLE »
CAR RETAIL APPL BUNDLE 1.0 » Entry by Component » Analytics AFL 3.

For a successful upgrade, you need to be aware of the following dependencies.
Dependencies Between the AFLs and the SAP HANA Database

The AFLs are released independently of the releases of SAP Customer Activity Repository retail applications
bundle. This is because the AFLs follow the release cycle of the SAP HANA database. The releases are called
“revisions”. Whenever a new revision of the SAP HANA database is released, a new revision of each AFL is

released. As a result, multiple revisions of each AFL are available on the SAP Support Portal at any one time.

A Caution

For each revision of an AFL, there is only one compatible revision of the SAP HANA database. For example,
you can only use revision 112.20 of the UDF AFL with revision 112.02 of the SAP HANA database. Whenever
you upgrade an AFL, you must also upgrade the database and any other AFLs to the compatible revisions.
Reversely, whenever you upgrade the database, you must upgrade the AFLs.

Note that this dependency applies not only to the UDF AFL and the POS AFL but also to the generic SAP
HANA AFL. Both the SAP HANA AFL and the SAP HANA database are components of the SAP HANA
Platform (see Prerequisites [page 16]).

When you download an AFL revision from the SAP Support Portal, the compatible revision of the SAP
HANA database is indicated.

Nomenclature

The following table explains how you can see the dependencies by looking at the release numbers:

Release of ... Released as ... Example Guideline

SAP HANA Platform <Support Package Stack> SAP HANA Platform SPS 11 The number of the support
package stack determines
the first digits of the revi-
sions.
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Release of ... Released as ... Example Guideline

SAP HANA Database <Revision>.<Patch> SAP HANA Database 112.02  All 11x.xx database revisions

belong to the SPS 11 plat-
form stack.

The patch number deter-
mines the first digit of the

AFL patch.
UDF AFL <Revision>.<Patch> UDF AFL112. 20
POS AFL POS AFL112. 20
SAP HANA AFL SAP HANA AFL112. 20

- Recommendation

We recommend that you upgrade all the AFLs at the same time. This means:

UDF AFL and POS AFL, which you must both install for a successful upgrade of SAP Customer Activity
Repository retail applications bundle

SAP HANA AFL, which is one of the mandatory prerequisites
if applicable, other AFLs provided with SAP HANA that might be relevant for your scenario

Focus on the AFL that provides the most important functionality for your scenario (for example, demand
forecasting with the UDF AFL). Select the best revision of that AFL for your scenario. This in turn will give
you the compatible revision of the SAP HANA database and the compatible revisions of the other AFLs.
Then install all the AFLs together.

Download and Install the UDF AFL (Focus: Demand Forecasting)

1

Select an AFL revision.
Multiple revisions are available on the SAP Support Portal. For guidance on selecting the best revision for
your Unified Demand Forecast scenario, see the following:

o

Prerequisites [page 16]: Indicates the minimum revision of the AFL and the SAP HANA Platform for
this release.

SAP Note 2088924 #% : Release Information Note (RIN) for SAP Customer Activity Repository retail
applications bundle 1.0.

SAP Note 2050229# : Gives you an overview of all UDF AFL revisions as of revision 82 and provides
instructions for downloading, installing, and upgrading the UDF AFL.
SAP-HANA-related information:

o Release and maintenance strategy of the SAP HANA Platform at http://support.sap.com/swdc#
|» Support Packages and Patches # Software Downloads » SUPPORT PACKAGES & PATCHES ¥ By
Alphabetical Index (A-Z) » H » SAP HANA Platform Edition j Info 3

o SAP Note 2021789#% : SAP HANA Revision and Maintenance Strategy

o SAP Note 2227464 : SAP HANA Platform SPS 11 Release Note

o SAP Note 1948334+t : SAP HANA Database Update Paths for Maintenance Revisions

o SAP Note 1914052#% : Dependencies between SAP NetWeaver and the SAP HANA Database
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2. Download and install your AFL revision (together with the other AFLs) as described in SAP Note 2050229
i

i Note

To use the UDF functionality in your implementation scenario, you must additionally do some post-
installation steps. For more information, see Configure Unified Demand Forecast (Optional) [page 64].

Download and Install the POS AFL (Focus: On-Shelf Availability)

1. Select an AFL revision.
Multiple revisions are available on the SAP Support Portal. For guidance on selecting the best revision for
your On-Shelf Availability scenario, see the following:

o Prerequisites [page 16]: Indicates the minimum revision of the AFL and the SAP HANA Platform for
this release.

o SAP Note 2088924 : Release Information Note (RIN) for SAP Customer Activity Repository retail
applications bundle 1.0.

o SAP Note 2056102#: Gives you an overview of all POS AFL revisions as of revision 82 and provides
instructions for downloading, installing, and upgrading the POS AFL.
o  SAP-HANA-related information:

o Release and maintenance strategy of the SAP HANA Platform at http://support.sap.com/swdc#
|» Support Packages and Patches j Software Downloads » SUPPORT PACKAGES & PATCHES ¥ By
Alphabetical Index (A-Z) » H » SAP HANA Platform Edition » Info J

o SAP Note 2021789#% : SAP HANA Revision and Maintenance Strategy

o SAP Note 2227464 : SAP HANA Platform SPS 11 Release Note

o SAP Note 1948334+t : SAP HANA Database Update Paths for Maintenance Revisions

o SAP Note 1914052#% : Dependencies between SAP NetWeaver and the SAP HANA Database

2. Download and install your AFL revision (together with the other AFLs) as described in SAP Note 2056102
i

i Note

To use the On-Shelf Availability functionality in your implementation scenario, you must additionally do
some post-installation steps. For more information, see Configure On-Shelf Availability (Optional) [page
53].

Result

You have successfully upgraded the CAR RETAIL APPL BUNDLE 1.0 back-end product version to the current
SPS. Continue with the next section.
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4.2.6.2.3 Clear Back-End System Tables

Use

Although not recommended, if you were previously using an application version lower than SAP Assortment
Planning for Retail 1.0 FP1, you need to purge all data created by previous application versions following the
upgrade. Due to data model incompatibilities of the FP1 version and previously shipped versions, you cannot
use previously created data following an upgrade to SAP Assortment Planning for Retail 1.0 FP2.

Procedure

1. Log on to your back-end system.
2. Read SAP Note 2189353#, create and run the report described in the note.

4.26.2.4 Upgrade Product-Specific SAP Fiori Ul
Component

Use

This procedure describes how to upgrade the SAP FIORI FOR SAP CARAB front-end product version from an
older support package stack to a newer one.

The ABAP front-end server contains the complete Ul layer, which consists of the SAP Gateway, the central SAP
Fiori Ul component, and the product-specific SAP Fiori Ul component. The product-specific SAP Fiori Ul
component contains all the SAP Fiori user interfaces for the applications provided for the SAP Customer
Activity Repository retail applications bundle.

Procedure

1. Identify the support package stack on the SAP Support Portal at http:/support.sap.com#|p Software
Downloads # Support Packages and Patches  Software Downloads j» By Alphabetical Index (A-Z) » F »
SAP FIORI » SAP FIORI FOR SUITE » SAP FIORI FOR SAP CARAB » SAP FIORI FOR SAP CARAB 2.0
SPS01 3.

For more information on support package stacks, see http://support.sap.com/sp-stacks .
2. Patch the support package stack using the Support Package Manager tool (transaction spam).

For more information, see SAP Help Portal at http://help.sap.com/spmanager# | Application Help 3, as
well as SAP Note 1803986 # .
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A\ Caution

As of the FP3 release, software components UTSCARO1 and UTRAP0OO1 have been merged into one,
UICAR0O01, software component.

3. If you are using SAP Assortment Planning for Retail, consult SAP Note 2077357 #%, which lists the SAP
Notes relevant for your release.

4.2.6.3 Follow-Up Activities
4.2.6.3.1 Create SAP ERP Tables

A\ Caution

Following an upgrade, it is important to remember to create any additional tables required by the new
release.

Tables required to be created as of the SAP Assortment Planning for Retail are listed in SAP Note 2263205#% .
Ensure that all tables listed in this note have been created.

4.2.6.3.2 Complete Post-Installation

Carry out all of the post-installation steps listed in the Common Installation Guide under http://
help.sap.com/rap#| <Your Release> ¥ Installation and Upgrade Information ¥ Installation Guide » Common

Installation Guide ¥ Implementation Scenarios » SAP Assortment Planning for Retail ¥ Post-Installation 3.

A\ Caution

Following the software upgrade, you must carry out the post-installation steps to complete the application
upgrade.

4.2.6.3.3 Troubleshoot Front-End Server Upgrade

Use

Following the upgrade of the product version on the front-end server, you may not be able to see some of the
SAP Assortment Planing for Retail 1.0 FP3 SAP Fiori tiles in your launchpad. This section outlines how to
troubleshoot these issues, should you experience them.

These steps are also listed in the Troubleshooting section of the SAP Assortment Planing for Retail
Administrator's Guide available on the SAP Help Portal at http://help.sap.com/rapf|p <Your Release>

System Administration and Maintenance Information » Administrator's Guide .

Common Upgrade Guide for SAP Customer Activity Repository retail applications bundle 1.0
SPS7
212 PUBLIC Upgrade Scenarios


http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/2077357
http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/2263205
http://help.sap.com/disclaimer?site=http%3A%2F%2Fhelp.sap.com%2Frap
http://help.sap.com/disclaimer?site=http%3A%2F%2Fhelp.sap.com%2Frap
http://help.sap.com/disclaimer?site=http%3A%2F%2Fhelp.sap.com%2Frap

Process

Do the following:

1. Check that all of the required BSP applications are listed in the UIRAP001 package.

Launch the Object Navigator (transaction SE80).
In the Repository Browser, open package UTRAP0O1.

o~ W

Verify that the following BSP Applications are listed:

Package

|uRAPOO1 = lse]
[ L= Li[=]a]) =] )5

Object Name
~ 5 UIRAPOOL
~ [ Subpackages
+ ] CONTENT_RAP_COMMON
~ [ CONTENT_RAP_TRANS

Log on to your front-end system (your SAP Gateway system).

Expand all of the embedded packages of embedded package CONTENT RAP TRANS.

Description
Structure package for UIRAP

Main package for common obejcts for RAP
Main package for transactional for RAP

~ [ Subpackages
~ [ RETAIL_DDF
~ [ BSP Lbrary
~ [ BSP Applications
» CIATTRIBUGMT_V2
» [71DDFREUSE_V2
» [I1L0CCLSTS_ V2
» [IMODULEMGMT_v2
~ [ RETAIL_RAP_AP
~ [ BSP Library
= [ BSP Applications
» [71ASSORTMODULE V2
» [ ASSORTPLAN_V2
» 1 OPTIONPLAN_V2
» [CIPHPMATCH_V2

Package for DDF

Manage Product Attriubtes: Fiori ID FOB29A |
Fiori Reuse Components for DDF: Fiori ID FO854A
Location Clustering: Fiori ID FO550A

Module Management: Fiori ID F1682A

Package for RAP AP

Assortment Module: Fiori ID F1567A
Assortment Plan: Fiori ID FO551A
Option Plan: Fiori ID FOB30A

PHP Matching: Fiori ID FO831A

BSP Applications
6. If you do not see one or more of the BSP applications listed above, right-click on each of the

RETATL DDF and RETATL RAP AP packages, and select | Other Functions » Rebuild Object List 3.
A Caution

Do not rebuild objects on a higher package level.

2. Ensure that you have activated all of the ICF services listed in the Activate SAP Assortment Planning for
Retail ICF Services section of the Common Installation Guide under http://help.sap.com/rapf| <Your
Release> ¥ Installation and Upgrade Information ¥ Installation Guide ¥ Common Installation Guide

Implementation Scenarios » SAP Assortment Planning for Retail » Post-Installation 4.
A Caution

Following an upgrade, it is important to remember to activate any new SAP Fiori apps made available in
the release.

3. Clean the cache.
1. Logon to your front-end system (your SAP Gateway system).

2. In Customizing (transaction SPRO), navigate to | SAP NetWeaver » Ul Technologies ¥ SAP Fiori »
Data Administration ¥ Invalidate Caches 3.
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This activity launches the /UI2/INVALIDATE GLOBAL CACHES report. This report invalidates all
server-side caches in SAP NetWeaver user interface services, which can become out-of-date following
an upgrade.
3. If necessary, implement instructions listed in SAP Note 2147669 # .
4. Remove any previously customized versions of the UIRAP001 launchpad.
1. Log on to your front-end system (your SAP Gateway system).
2. Launch the Overview for Launchpads (transaction LPD_CUST).

3. Search for Role UIRAP001, and see whether any instances exist where the User Name is not SAP. If so,
this means that customized versions of the UTRAP001 launchpad exist, and these take precedence
over the standard launchpad instance delivered by SAP.

4. Delete all but the launchpad instance delivered by SAP.

4.3 SAP Promotion Management for Retail

4.3.1 SAP Promotion Management for Retail Upgrade and
Migration

Prerequisites

® You have upgraded to SAP Customer Activity Repository 2.0.

Procedure

The Promotions server (component RTLPROMO) contains all necessary ABAP classes and libraries required for
the promotions processing required by SAP Promotion Management for Retail. You can use the SAP Add-on
Installation Tool (transaction SAINT) to install the component.

i Note

For complete information on SAINT see: [ SAP Service Marketplace » SAP Support Portal # Release &
Upgrade Info ¥ Installation and Upgrade Guides ¥ Industry Solutions ¥ Add-On Components » SAINT

Documentation 3

To upgrade from SAP Promotion Management for Retail 8.0 on SAP Customer Activity Repository 1.0 to SAP
Promotion Management for Retail 8.1 on SAP Customer Activity Repository 2.0 you must:

1. Log on to your ABAP system.
2. Upgrade from RTLPROMO 801 to component RTLPROMO 810 using transaction SAINT as described in SAP
Note 2026580 7% .
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4.4 SAP Merchandise Planning for Retail Upgrade

SAP Merchandise Planning for Retail 1.0 SP4 has no functional updates for this version.

If you did not load inventory history in the previous version you can use an ABAP report to load inventory
history. Use the ABAP report Bl Interface for Historical Inventory Time Series. To execute the report, use
transaction code SE38. To view the documentation, enter the report name /DMF/BI_IF INV_HIST inthe
Program input field and select the radio button Documentation. Select the Display button. To execute the report
use the execute button.

A Caution

You must complete upgrade steps for SAP Customer Activity Repository.
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Important Disclaimers and Legal Information

Hyperlinks

Some links are classified by an icon and/or a mouseover text. These links provide additional information.
About the icons:

o Links with the icon o : You are entering a Web site that is not hosted by SAP. By using such links, you agree (unless expressly stated otherwise in your
agreements with SAP) to this:

e The content of the linked-to site is not SAP documentation. You may not infer any product claims against SAP based on this information.
e SAP does not agree or disagree with the content on the linked-to site, nor does SAP warrant the availability and correctness. SAP shall not be liable for any
damages caused by the use of such content unless damages have been caused by SAP's gross negligence or willful misconduct.

e Links with the icon &: You are leaving the documentation for that particular SAP product or service and are entering a SAP-hosted Web site. By using such
links, you agree that (unless expressly stated otherwise in your agreements with SAP) you may not infer any product claims against SAP based on this
information.

Beta and Other Experimental Features

Experimental features are not part of the officially delivered scope that SAP guarantees for future releases. This means that experimental features may be changed by
SAP at any time for any reason without notice. Experimental features are not for productive use. You may not demonstrate, test, examine, evaluate or otherwise use
the experimental features in a live operating environment or with data that has not been sufficiently backed up.

The purpose of experimental features is to get feedback early on, allowing customers and partners to influence the future product accordingly. By providing your
feedback (e.g. in the SAP Community), you accept that intellectual property rights of the contributions or derivative works shall remain the exclusive property of SAP.

Example Code

Any software coding and/or code snippets are examples. They are not for productive use. The example code is only intended to better explain and visualize the syntax
and phrasing rules. SAP does not warrant the correctness and completeness of the example code. SAP shall not be liable for errors or damages caused by the use of
example code unless damages have been caused by SAP's gross negligence or willful misconduct.

Gender-Related Language

We try not to use gender-specific word forms and formulations. As appropriate for context and readability, SAP may use masculine word forms to refer to all genders.
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